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1 Preface 
The AccuVision® AV6010 Long-Range Camera System Manual from 
Accu-Sort Systems, Inc. includes the information you need to effectively 
integrate the AV6010 Camera System with your application.  

It contains detailed information about the following: 

 Product features, capabilities, specifications and accessories 

 Safety information 

 Installation guidelines and procedures  

 Configuring the camera system for your application  

 Maintenance and Troubleshooting 

This preface explains how this user manual is organized and introduces 
other sources of information that you will find useful. 

 

Intended Audience 

You should have a basic understanding of bar code scanning. Equipment 
installers must be familiar with standard wiring techniques and terminology. 
Because most Accu-Sort software applications run in the Microsoft® 

Windows® and internet browser environments, you should know how to use 
a mouse, choose commands, and work with windows and dialog boxes. 

 

Thank You 

Thank you for using the AccuVision AV6010 Camera System and this 
manual.  

We value your comments and feedback. Feel free to let us know what you 
like or dislike about the AV6010 (or this manual) by e-mailing us at 
info.automation.us@datalogic.com.  

You can also mail your comments to our corporate headquarters address or 
call us directly at 1-800-BAR-CODE™ or (215) 723-0981. 

 

 

NOTE: There may be additional material that was not available when this 
product manual was produced. To learn if there is a documentation update, 
go to our web site’s corresponding product page at www.datalogic.com. 

 

Other Sources of Information 

You can choose from many information sources, including documentation, 
training, and support services, to increase your knowledge and 
understanding of the AV6010. If this manual refers you to other 
documentation, use only the latest versions unless otherwise specified. 
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Conventions 

 

WARNINGS or CAUTIONS: This symbol identifies a hazard or 
procedure that, if incorrectly performed, could cause personal injury or 
result in equipment damage. It is also used to bring the user’s attention to 
details that are considered IMPORTANT.  

 

HIGH VOLTAGE CAUTION: This symbol alerts the user they are about 
to perform an action involving, either a dangerous level of voltage, or to 
warn against an action that could result in damage to devices or electrical 
shock. 

 

LASER/LED CAUTION: This symbol alerts the user they are about to 
perform an action involving possible exposure to laser/LED light radiation.  
 

 

ESD CAUTION: This symbol identifies a procedure that requires you take 
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist 
strap. Circuit boards are most at risk. Please follow ESD procedures. 

 

NOTES: This symbol draws attention to important details or procedures 
that may be useful in improving, maintaining, or enhancing the performance 
of the hardware or software being discussed. 

 NOTE REGARDING DIMENSIONAL REFERENCES: This manual 
provides all dimensional references in inches. Metric references are 
provided in millimeters and enclosed in brackets. For example: 10 inches 
[254 mm]. 

 

Customer Service 

Training 
Accu-Sort Systems offers a complete set of training courses to help you and 
your staff get the most out of your investment. We can help you develop a 
training plan that provides thorough training for both your project team and 
your end users. We will work with you to organize courses appropriate to 
your job or area of responsibility. Training professionals can show you how 
to plan your training throughout the implementation process so that the right 
amount of information is delivered to key people when they need it the most. 
You can attend courses at our training center, or you can arrange for our 
trainers to teach at your facility. In addition, we can tailor standard courses or 
develop custom courses to meet your needs. 

Support 
From on-site support to central support, our team of experienced 
professionals provides the help and information you need to keep your 
equipment working for you. This team includes your Account Manager and 
Accu-Sort’s large staff of support specialists with expertise in your business 
area and managing your hardware and software environment. 
 

 

NOTE: If you have any problems or questions that require Accu-Sort's 
assistance, direct your calls to Customer Service at 1-800-BAR-CODE™  
or (215) 723-0981. 
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1 Introduction 
 

This section presents a detailed description of the AccuVision® AV6010 
Long-Range Camera Systems. It begins with a product overview. The 
system’s features are described in detail.  

� System Overview 
� User Interface 
� Ordering Options and Accessories 

 

Product Overview 

The AccuVision AV6010 Long-Range Camera System includes: 
n AV6010 Camera with integrated: 
� Camera Head Module 

� Illumination Module 

� DCM (Distributed Computing Module) 

� Power Supplies 

o    Adjustable Folding Mirror  
p AV6010 RangeFinder (with power supply) 
q Tachometer 
r VisionCapture / Image Depot Server (optional) 
 

 
Figure 1-1: AccuVision AV6010 Long-Range Camera System  

n

o

p

q 

r 
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Camera Module 

The camera module includes the following key components:   

� LED Illumination 

� Camera Head 

� Distributed Computing Module (DCM)  
 

 
Figure 1-2: AccuVision AV6010 Camera Module 
 

The LED illumination floods the scanning area with light as packages are 
conveyed past the AV6010 camera(s). There are several models equipped 
with either a 30-inch [762 mm] or 42-inch [1066 mm] illumination module.  

The AV6010’s camera head acquires and transfers image data to the DCM 
for decoding and processing. The decoded results are then sent to a host 
device via Ethernet and/or serial interface.  
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Distributed Computing Module (DCM) 

The DCM includes the main processor, up to three COM Express (COM-e) 
modules (one standard, used for bar code decoding), and all the 
Ethernet/serial and parallel communications interfaces required by the 
system.  

The decoder (COM-e module 1) helps optimize your material handling 
system and improve your bottom line by: 

� utilizing proprietary decoding software that all but eliminate no-reads 
regardless of orientation 

� enabling easy setup, modification, and diagnostics of the most important 
application parameters and functionality 

� provides a choice of serial or Ethernet communications with your host 
computer / network. 

The optional COM-e modules are typically used for: 

� Dimensioning / Certified Dimensioning applications  
(COM-e module 2) 

� Raw Image Export (RIE) for Optical Character Recognition (OCR) 
applications (COM-e module 3)  

 

The DCM also includes the following software:  

� Lynx OS  
(real-time operating system for the main processor) 

� Linux Operating System  
(on COM-e modules for decoding, dimensioning, RIE/OCR) 

� AV6010 User Interface (HTML browser-based setup and diagnostics) 

� AV6010 Install Wizard for auto-calibration (download to a computer) 

� Proprietary decode software 
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RangeFinder Module 

The RangeFinder module includes the following:   

� RangeFinder Module 

� RangeFinder Power Supply  

� Mounting and adjustment brackets 

 
 
Figure 1-3: RangeFinder for AV6010 Camera Systems 
 
The RangeFinder is used to detect the presence of products as they enter 
the scanning area as well as report the package positions/heights and 
sequence number to all cameras in the system. RangeFinders used in 
dimensioning are calibrated to have an accuracy of 0.1, 0.2 or 0.5-inch.  
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AV6010 User Interface 

The AV6010 uses a browser-based application that lets you configure the 
system through a series of intuitive, user-friendly menus, tools and dialog 
boxes. Context sensitive help is available to assist with use of the 
application. 

 

 
Figure 1-4:  AV6010 User Interface (Symbologies Screen shown) 
 

With the AV6010 user interface, you can: 

� select or modify 1D and 2D symbologies to be decoded 

� configure trigger and tracking parameters 

� define communications and outputs 

� monitor system performance 

� diagnose and troubleshoot operating conditions 

 

The user interface also includes a downloadable Auto-Calibration Wizard 
that enables static and dynamic setup of the RangeFinder and all cameras in 
the AV6010 system. 

 

 

IMPORTANT: The user interface enables you to easily configure the 
AV6010 to  your application’s specifications. Making changes to certain 
parameters may adversely affect system performance. Observe the caution 
statements in this manual and do not make changes to those parameters 
unless instructed to do so by Accu-Sort Technical Support or your systems 
administrator. 
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Typical AccuVision AV6010 Long-Range Camera Applications 

Use the AV6010 in the following AccuVision Long-Range Camera System 
applications:  

� single-camera applications   

� multiple-camera scanning arrays (3-sided) 

� Complete camera scanning tunnels (up to 6 sides) 

� quadrant scanning tunnels 

 

 
Figure 1-5: Top-read Single-camera Application 
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A three-sided scanning array is used to read bar codes on the top and sides 
of packages. When three or more cameras are used, a Power Distribution 
Box (PDB) is typically designed into the system. 

 

 
 

Figure 1-6: Scanning Tunnel – 3-Sided Application 
 
 

 

A 5-sided or 6-sided scanning tunnel is used to read bar codes on most or all 
sides of the products passing through the tunnel, including the bottom of 
packages. (See Figures 1-7 and 1-8.) 
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Figure 1-7: Scanning Tunnel – 5-Sided Application 
 

 
Figure 1-8: Tunnel Option – Bottom Read Application 
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Quadrant scanning is used to assure high read rates on higher-density bar 
codes when packages passing through the tunnel are significantly skewed. 

 

 
 
Figure 1-9: Quadrant Scanning Tunnel Application 
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Dimensioning Applications 

Any AV6010 camera system with a top-read camera can be configured for 
the optional product dimensioning application. The DCM is equipped with a 
second COM-e module to enable the in-camera dimensioning functionality. 
The RangeFinder used in dimensioning applications is calibrated for an 
accuracy of 0.1”, 0.2” or 0.5” (2.54, 5.08 or 12.7 mm).  

 
AV6010 with In-Camera Dimensioning Functional Overview 

The AV6010 Camera System is designed to scan objects moving on a 
transport, decode bar code information and then present and transmit that 
information to another system (typically a sortation controller or inventory 
control system). The AV6010 Camera System includes all the hardware and 
software components needed to perform its function without requiring 
information or signals from external systems.  

 
Figure 1-10: AV6010 Camera System Functional Diagram 
 
An AV6010 Top-Read Camera and RangeFinder (shown in Figure 1-10) are 
needed for in-camera dimensioning. Objects are conveyed through the 
RangeFinder field. The RangeFinder detects the presence of an object and 
determines the range and extents of the object and transmits that information 
to the Camera Module. The AV6010 uses the signal from the tachometer to 
track the motion of the object through the field of view of the Main Imaging 
Sensor (commanding the Focus Servo as necessary to focus the Main 
Imaging Sensor). The AV6010 processes the resulting video data stream to 
locate and decode any bar code symbols present and then transmits that 
information to an external system when the object reaches a predetermined 
point (transmit point) along the conveyor system. When in-camera 
dimensioning is included in this system, the dimensioning data is also 
transmitted with the bar code data. 

 
See Appendix G for further information on dimensioning. 
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RIE / OCR Applications 

Any AV6010 camera system can be equipped with an additional COM-e 
module in the DCM to enable the optional RIE (Raw Image Export) for use in 
OCR (Optical Character Recognition) applications.  

 

 

Side-by-Side Package Detection Applications 

An AV6010 camera system can be registered to use the side-by-side 
package detection option. When enabled, the system uses a multi-
dimensional approach to detect whether or not the packages passing 
through the scanning area are two or more items side-by-side, significantly 
reducing the potential for mis-sorts, mis-ships as well as package or 
transport damage. Side-by-side package detection works on both tilt-tray and 
belt conveyors. 

 

 

Options and Accessories 

Contact your sales representative for assistance in determining which 
options and accessories will be applicable to your application. 

If you know which items are needed, contact: 
 
Accu-Sort Systems, Inc. 
Customer Service Department  
(Ask for the Spare Parts Coordinator)  
Hours: 8 AM and 4:30PM (EST) Monday through Friday 

1-800-BAR-CODE™ 
(1-800-227-2633)  
(Fax: 215-723-1515)  
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Notes: 
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2 Safety 
Please follow the safety precautions and warnings found in this manual when 
installing, setting up, operating, maintaining, troubleshooting or replacing any 
Accu-Sort products, parts, or related equipment. Following these precautions 
will prevent personal injury or damage to the unit. Failure to follow these 
precautions may also void your warranty. 

 

Symbols 

Throughout this manual, special safety alerts are indicated by the following 
symbols: 

 

WARNINGS or CAUTIONS: This symbol identifies a hazard or 
procedure that, if incorrectly performed, could cause personal injury or 
result in equipment damage.  

 

HIGH VOLTAGE CAUTION: This symbol alerts the user they are about 
to perform an action involving, either a dangerous level of voltage, or to 
warn against an action that could result in damage to devices or electrical 
shock. 

 

ESD CAUTION: This symbol identifies a procedure that requires you take 
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist 
strap. Circuit boards are most at risk. Please follow ESD procedures. 

 

Alerts help you to: 

 Identify a hazard and its consequences 

 Avoid a hazard by taking adequate safety precautions 

 Get the most out of your bar code solution 

 

General Precautions 

Installation and Service by Qualified Service Technician Only 

 

WARNING: Because of possible exposure to high voltage, a trained 
technician must perform all procedures involving exposure to the inside of 
the AV6010 Camera. There are no user-serviceable parts inside. Do not 
attempt to open the unit or perform any installation/service procedures 
unless you are a trained technician! 

Refer all servicing and advanced troubleshooting to a qualified service 
technician. Technical training is available from Accu-Sort Systems. 

Furthermore, even trained technicians should always reference the specific 
product service documentation for more detailed service procedures that are 
not described in the AV6010 Long-Range Camera System Manual. 
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Unpacking, Mounting and Installation Recommendations 

 

CAUTION: Firmly fasten mounting structures in place before installing the 
equipment to any mounting structure.  Avoid using freestanding mounting 
structures. If your application requires a freestanding mounting structure, 
avoid making the structure top-heavy. 

 Follow all procedures regarding electrical safety, laser safety, and 
electrostatic discharge safety (ESD) as outlined in this manual. 

 Save all packing material in case you have to transport your AV6010. 

 Use steel or aluminum as a mounting structure. An Accu-Sort mounting 
structure is recommended for optimum system performance.  

 Check mounting hardware periodically for tightness and stability. 

 Do not use sheet rock, plaster board, wood, or other unstable mounting 
surfaces. 

 Do not use mounting surfaces that are subject to high vibrations. 

 Do not create any obstructions of airflow around the equipment. Keep 
the area around the equipment clean to provide for cooling. (Refer to 
specific product manuals for minimum clearances.) 

 Avoid dropping the unit(s) during unpacking and installation. 

 Do not touch the window glass of the RangeFinder, camera or mirror. 

 

Compliance Requirements 

 

FCC NOTICE: The AV6010 Camera has been tested and found to comply 
with the limits for a Class A digital device, pursuant to Title 47, Part 15 of the 
FCC Rules. These limits are designed to provide a reasonable protection 
against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction 
manuals, may cause harmful interference to radio communications. Operation 
of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at their expense. 

 

WARNING: These are Class A products. In a domestic environment, these 
products can cause radio interference, in which case the user may be required 
to take adequate measures. (Ref. CISPR 22 = EN 55 022:1995.) 

 

IMPORTANT: Follow the guidelines below to maintain Electromagnetic 
Compatibility (EMC) Compliance: 

 Interconnecting cables must be twisted pair cables.  

 All shielded I/O cables shall have the shield terminated to the chassis. 

 NOTE: DRAIN WIRE SHIELDING IS NOT ADEQUATE. 
 Do not remove the shielding covers.  
 Refer to the details on making custom cables as provided in the specific 

technical manual for the component. 
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Electrical Safety 

AV6010 Camera must be installed in accordance with Canadian Electrical 
Code, Part I, CSA C22.1; CSA C22.2 No. 0; and the National Electrical Code, 
NFPA 70.  For complete requirements, National Electrical Code, ANSI/NFPA 
70, Canadian Electrical Code, Part I, C22.1, or other national standard must 
be consulted. 

 For PERMANENTLY CONNECTED EQUIPMENT/RACK MOUNTED, 
incorporate a readily accessible disconnect device in the fixed 
wiring. 

 For PLUGGABLE EQUIPMENT/RACK MOUNTED, install the socket-
outlet near the equipment so it is easily accessible. 

 Make sure that all personnel who work with the equipment know where 
the disconnect switches or circuit breakers are located. 

 Before performing any type of maintenance, turn off power to the unit and 
disconnect the power cord. 

 Be certain your hands and the floor of your work area are dry before 
touching electrical equipment or connecting cords. 

 Routinely check all power cords, plugs, wiring, and cable connections for 
any signs of exposed wire or deteriorating insulation. If you notice any 
damage, make arrangements with service personnel to repair or replace 
the damaged item immediately. 

 

Electrical Grounding Requirements 

Before applying power to any device, ALL components MUST be electrically 
grounded. Follow these precautions: 

 Ensure all AC power outlets have a properly grounded receptacle. 

 ALL components MUST be properly cabled and grounded with three-
conductor AC power cords. 

 Use the correct power cord for your country.  

 Reference specific grounding instructions for each component. 

 Do not use a two-prong adapter. 

 Do not cut/remove the round grounding prong from any plug. 

 Do not use an extension cord to defeat any ground. 
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Electrostatic Discharge 

 

 

ESD CAUTION: Measures must be taken to prevent Electrostatic 
Discharge (ESD) at all times when handling any product, equipment, unit or 
part (e.g. use a grounded ESD wrist strap). It should be noted that circuit 
boards are at greatest risk to damage from ESD. Please follow standard 
ESD precautions! 

 

Electrostatic discharge (ESD), the transfer of static electricity from one object 
to another, is an often-unnoticeable hazard to electronic components. 
Boards and other devices with integrated circuits are particularly sensitive to 
ESD damage. Product failures may not occur until days or weeks after the 
component was damaged. 

Static damage to units can take the form of upset failures or catastrophic 
failures (direct and latent). 

An upset failure occurs when an electrostatic discharge is not significant 
enough to cause total failure, but may result in intermittent gate leakage, 
causing loss of software or incorrect storage of information. 

Direct catastrophic failures occur when a unit is damaged to the point where 
it is permanently damaged. 

 

Basic Rules for ESD Control 

Below are some keys to effectively control unnecessary ESD damage when 
working with ESD-sensitive devices: 

 Define an ESD protective area and work on the ESD-sensitive devices in 
this area only. 

 Define static sensitivity of devices to be handled in ESD protective area. 

 Establish suitable static control program that limits static generation to 
less than the damage threshold of the most sensitive device in the 
environment, and provides a safe, defined path for static charge 
dissipation. 

 Prevent contamination of the protective area by unnecessary non-static 
controlled materials. 

 Audit the ESD protective area regularly to ensure that static control is 
maintained. Document the findings for future reference. 

 Refer to the specific electrostatic discharge precautions for each 
component. 
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Laser/LED Safety 

The AV6010 Camera Module uses visible red LEDs to create an “area flood 
pattern.” Do not stare into the camera’s exit window at the LED light. Avoid 
direct eye exposure. The LED light level does not constitute a health hazard, 
however staring at the LED light for prolonged periods could result in eye 
damage. 

 
The AV6010 RangeFinder Module uses visible red lasers emitting from the 
left and right apertures to create a unique pattern used in detecting the 
presence of a product in the scanning area and for measuring the width of 
products. 

 

 

WARNING: Use of controls, adjustments, or procedures other than those 
specified in this document may result in hazardous laser light exposure. 
The AV6010 RangeFinder Module is rated as a Class 2 Laser Product by 
the International Electrotechnical Commission.  
 
Compliances are as follows: Class 2 Laser Product (IEC/EN 60825-1):2001, 
Class II Laser Product (21CFR1040) <1.0 mW peak/cw power at 
wavelength 630-700nm.  

 

Safety Labels and Locations 

Refer to the following figures for specific label locations and warnings. When 
operating, repairing, or replacing any AV6010 Camera Module or 
RangeFinder Module field replaceable units, note all label content on the 
unit. These labels provide special precautions for operation, usage 
specifications, product identification, and service information. 

 

AV6010 Camera Module Safety Label Locations 
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AV6010 RangeFinder Module Safety Label Locations 
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3   Mechanical Installation 
 

 

IMPORTANT: The AV6010 contains electronics that may be affected by 
electrostatic discharge (ESD). To prevent personal injury or damage to the 
unit, please follow the safety precautions and warnings found in Chapter 2. 
Failure to follow these precautions may void your warranty. 

 

Preparing for Mechanical Install 

 

IMPORTANT: Application-specific drawings and documents provided by 
Accu-Sort supersede any contradictory content in this manual. 

 

Before mounting any components, please do the following: 

 Read all instructions before beginning your installation.   

 Define and confirm the accuracy of your application’s requirements and 
structure position, especially the height of the conveyor from the floor.  

 Review all installation-specific drawings provided with your equipment.  

 Review and plan the mechanical installation of all devices used in your 
application. Be sure to allow adequate clearance for maintenance. 

 Review and plan the power requirements for your application. 

 Check the contents of the shipping cartons against the packing list.  

 Record all product serial numbers. 

 

 

IMPORTANT: The camera system requires a consistent transport speed 
and precisely timed triggering events in order to function properly. All 
packages must enter and exit the scanning area at constant transport speed. 
Variations in speed during scanning / processing will adversely affect the 
system’s read rate performance and may also result in 
inconsistent communications with the host computer.  

 

 

Unpacking Instructions 

 

IMPORTANT: The AV6010 Camera and RangeFinder packaging is 
designed to protect the unit(s) during shipment. Do not throw it away. Save 
all packing material in case you need to transport your unit(s).  
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Installation Sequence 

 

NOTE: Everything should be MECHANICALLY INSTALLED before 
performing any ELECTRICAL INSTALLATION. See Chapter 4 for electrical 
installation details. 

 

Installing a Single Camera System 
To install a single camera system, follow this sequence of steps: 

 Complete mechanical installation. 
 Review the details of your application’s requirements. 

 Determine and mark the mounting location.  
If an Accu-Sort structure is used, mounting locations are pre-marked. 

 Erect mounting structure or other supporting frame. 

 Mount AV6010 Camera and mirror in its position on the structure. 

 Mount AV6010 RangeFinder in its position on the structure. 

 Mount / position any optional devices included with your system. 

 VisionCapture Image Capture System including network switch, 
monitor/keyboard with trackball and mounting arm, UPS 

 Complete electrical installation.  (See Chapter 4.) 

 Setup your AV6010. (See Chapter 5.) 

 Check operations.  (See Chapter 6.) 
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Installing a Multiple Camera Tunnel 
To install a multiple camera system, follow this sequence of steps: 

 Complete mechanical installation. 
 Review the details of your application’s requirements. 

 Determine and mark the mounting location.  
If an Accu-Sort structure is used, mounting locations are pre-marked. 

 Erect mounting structure or other supporting frame. 

 Mount AV6010 Cameras/mirrors in their positions on the structure. 

 Front/Top/Back cameras 

 Side cameras 

 Bottom camera (if applicable) 

 Mount AV6010 RangeFinder in its position on the structure. 

 Mount Power Distribution Box to the structure. 

 Mount / position any optional devices included with your system. 

 VisionCapture Image Capture System including network switch, 
monitor/keyboard with trackball and mounting arm, UPS 

 Complete electrical installation.  (See Chapter 4.) 

 Setup your AV6010. (See Chapter 5.) 

 Check operations.  (See Chapter 6.) 
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General Mounting Guidelines 

As you plan the installation of the AV6010 Camera(s) and RangeFinder, be 
sure to keep the following guidelines in mind: 

 Determine the proper AV6010 orientation and position as it relates to the 
scanning area and transport direction.  

 With the exception of lifting the AV6010 camera(s) into position on the 
mounting structure, all mounting structure assembly and equipment 
installation can be performed by one installer. 

 Applications using an Accu-Sort mounting structure define the AV6010 
location on the application-specific drawings provided with your system 
and are pre-marked on the structure. 

 Plan your mechanical installation based on the application’s electrical 
requirements. See Electrical Installation Guidelines in Chapter 4. 

It is important that you follow all safety precautions when installing, setting 
up, operating, maintaining, troubleshooting or replacing any Accu-Sort 
products, parts or related equipment. See Chapter 2, Safety. 

 

 Dimensions and Clearances 
The mechanical specifications, dimensions and mounting footprint for the 
AV6010 Camera and RangeFinder are provided in Appendix A. 

 

NOTE: For installation, wiring, maintenance and service reasons, allow for 
proper clearance. Ease-of-access should also be considered when locating 
the mounting position.  Clearances recommended (approximate):  
 

 Camera & RangeFinder  
Connector Panel  

6 inches [152 mm] 

 Camera Cover / Access Panel 8-12 inches [203-305 mm] 

 Power Distribution Box (PDB) 
(used with multi-camera systems) 

42 inches [1066 mm] deep 

30 inches [762 mm] wide 

78 inches [1981 mm] headroom 

  

Physical Support Requirements 
For details on the weight of the AV6010 Camera and RangeFinder, see 
Appendix A. Multiple-camera systems and scanning tunnels may include 
further details on the physical support requirements with any application-
specific documentation provided.  

 

Vibration Limitations 
The AV6010 Camera and RangeFinder are designed and tested to withstand 
continuous sine wave vibrations between 10 and 500 hertz (limited to a 
displacement of 0.0157 inches [0.40 mm] for frequencies between 10 and 50 
Hz and limited to 2 G acceleration for frequencies between 50 and 500 Hz). 
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Mounting Structure Assembly 
When a mounting structure is supplied by Accu-Sort, a set of drawings is 
provided that supplies details specific to the applications. Accu-Sort 
mounting structures are designed to support from one to six cameras in a 
tunnel configuration.  These structures can be assembled by a single 
installer. 

 

Prerequisites:   

 Receipt, inventory and staging of structure materials 

 Conveyor location prepared for structure installation 

You will need the following: 
 Application’s specifications defining proper location of structure 

 Custom mounting structure drawings (if a standard is not used) 

 

Tools Required:  

 Socket Driver (1/2”)   (battery powered, recommended) 

 Tape Measure   (verify drawing to application, recommended) 

 

To assemble the mounting structure:  
1. Prepare the conveyor location for the structure. 

2. Inventory and stage the structure components. 

3. Position pre-assembled back columns. 

4. Position pre-assembled front columns. 

5. Install lower side rails. 

6. Install upper side rails. 

7. Install bottom cross members. 

8. Install middle cross members. 

9. Install top cross members. 

10. Install left and right side corner braces. 

11. Install front and back corner braces. 

12. Install inner side rails (if applicable). 
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      Column Type 1 (qty. 2) 
          Right back / Left front  
 

 
         Column Type 2 (qty. 2)  
             Left back / Right front  
 

 
Side Rails (qty. 4) – Long, unmarked Cross Members (qty. 6) – Short, pre-marked 

 
Inner Side Rails (qty. 2 or 4) – Long, pre-marked (optional) 
 
 
Mounting Structure Components 
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Flat Camera Sleds (qty. 1 per camera)  
       

 

 Mirror Sleds  (qty. 1 per camera)  
      (Use with all cameras that have a flat sled.) 

 

  
45-degree Camera Sleds  

(optional, used in place of flat sled and mirror/sled) 
 
 

 
Corner Braces (24-inch & 36-inch) (qty. 4 each) 

 
(enlarged view) 

 
T-Stud and Flanged Nut  

        (pre-assembled, bulk quantity, large bag) 

 
 
 
 
Note: Applications using optional equipment (e.g., power distribution box, VisionCapture™ Image Depot Server, monitor and keyboard) will have 
additional mounting structure components. Review your installation drawings to confirm the options used in your application. 
 
 
 
 
Mounting Structure Components (continued) 
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Assembly of side rails and cross members to columns  
Reference drawing 110425 for details on the mounting base (foot)) 

 

Installation of corner braces 
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Equipment Mounting 
Complete camera system equipment installation: 

 Camera Module(s)     (up to 6) 

 Focus Mirror(s)     (up to 6)  

 RangeFinder Module 

 Tachometer 

 Power Distribution Box 

 Others (Options) 

 

 

NOTE: If your application uses an Accu-Sort mounting structure, the 
positions of the RangeFinder, camera sleds and mirror sleds are pre-marked 
to simplify installation. 

 

Prerequisites:  

 Structure installation completed 

 Structure drawings (standard or custom) showing proper positioning of 
equipment on the structure 

 Application’s specifications 

 

Tools Required:  

 Socket Driver (1/2”)   (battery powered, recommended) 

 Allen Wrench (5/32”) 

 Tape Measure (minimum 12 to 25-feet [3.65 to 7.62 meter]) 
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Camera Installation 

Prerequisites:  

 A flat surface (preferably the conveyor belt)  

 Application specifications and mounting structure drawings 

 Determine camera position and reading direction  

Tools Required:  

 Socket driver (1/2”) battery powered (recommended)  

 Tools (optional): Tape measure 

 

To install a Front/Top/Back camera:  
1. Place the camera on the sled, aligning the camera mounting feet with the 

alignment marks. 

2. Attach with front-loading hardware. Do not over-tighten, which allows for 
adjustment during setup (if necessary), but assure the camera will not 
slide in the sled’s channel when it is lifted into position. 

3. Assure camera is positioned with illumination side facing in the correct 
direction before lifting into position. 

4. Use two people to lift the camera/sled assembly into position as marked 
on the structure side rails. 

5. Attach with front-loading hardware. Do not over-tighten. 

 

IMPORTANT: For safety reasons, it is recommended that two people lift 
the camera into position on the mounting structure. 
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To install a Side/Quadrant camera:  

 

IMPORTANT: Depending on the application, the side-read camera may be 
installed on the inside of the mounting structure rather than the outside. 
Check your application structure drawings before mounting the side-read 
camera or mirror. 
 
1. Place the camera on the sled, aligning the camera mounting feet with the 

alignment marks. 

2. Attach with front-loading hardware. Do not over-tighten, which allows for 
adjustment during setup (if necessary), but assure the camera will not 
slide in the sled’s channel when it is lifted into position. 

3. Assure camera is positioned with illumination side facing in the correct 
direction before lifting into position. 

4. Use two people to lift the camera into position as marked on the 
structure side rails. Insert the tabs of the sled’s upper bracket into the 
structure channel, and then slowly rest the lower bracket into position.  

5. Attach with front-loading hardware, beginning with the sled’s upper 
bracket. Do not over-tighten. 

 

 

IMPORTANT: For safety reasons, it is recommended that two people lift 
the camera into position on the mounting structure. 
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To install a Bottom-read camera:  
1. Underneath the conveyor, place the camera on the sled, aligning the 

camera mounting feet with the alignment marks. 

2. Attach with front-loading hardware. Do not over-tighten, which allows for 
adjustment during setup (if necessary), but assure the camera will not 
slide in the sled’s channel when it is lifted into position. 

3. Assure camera is positioned with illumination side facing in the correct 
direction before lifting into position. 

4. Use two people to lift the camera/sled assembly into position as marked 
on the structure side rails. 

5. Attach with front-loading hardware. Do not over-tighten. 

 

 

IMPORTANT: For safety reasons, it is recommended that two people lift 
the camera into position on the mounting structure. 
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 Mirror Installation 

Prerequisites:  

 A flat surface (preferably the conveyor belt)  

 Application specifications and mounting structure drawings 

 Determine mirror position as it relates to the camera and reading 
direction  

 Remember: Mirrors must be angled toward the conveyor.  
(Mirror adjustment to the correct angle is covered in Chapter 5.) 

 

Tools Required:  

 Socket driver (1/2”) battery powered (recommended)  

 Tools (optional): Tape measure 
 

The mirror assembly ships pre-assembled. If not, attach the brackets to both 
sides of mirrors before proceeding to the next step. 
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To install a mirror for a Front/Top/Back camera:  
1. Place the mirror assembly onto the mirror sled in the position marked. 

(Some mirror sleds are the same length as the mirror assembly, in which 
case there will be no marks.)  

2. Attach with front-loading hardware. Assure the mirror will not slide in the 
sled’s channel when moved into position on the structure. Do not over-
tighten, which allows for adjustment during setup, if necessary. 

3. Assure mirror is positioned facing in the correct direction. 

4. Lift mirror into position as marked on the mounting structure. 

5. Attach with front-loading hardware (do not over-tighten). 

 

IMPORTANT: Do not remove the protective film from the mirror’s surface 
until system setup and calibration. (See Chapter 5.)  
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To install a mirror for a Side/Quadrant camera:  

 

IMPORTANT: Depending on the application, the side-read camera may be 
installed on the inside of the mounting structure rather than the outside. 
Check your application structure drawings before mounting the side-read 
camera or mirror. 
 
1. Place the mirror assembly onto the mirror sled in the position marked. 

(Some mirror sleds are the same length as the mirror assembly, in which 
case there will be no marks.)  

2. Attach with front-loading hardware. Assure the mirror will not slide in the 
sled’s channel when moved into position on the structure. Do not over-
tighten, which allows for adjustment during setup, if necessary. 

3. Assure mirror is positioned facing in the correct direction. 

4. Insert the tabs of the sled’s upper bracket into the structure channel, and 
then slowly rest the lower bracket into position. 

5. Attach with front-loading hardware, beginning with the sled’s upper 
bracket. Do not over-tighten. 

 

IMPORTANT: Do not remove the protective film from the mirror’s surface 
until system setup and calibration. (See Chapter 5.)  
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To install a mirror for a Bottom read camera: 
1. Place the mirror assembly onto the mirror sled in the position marked. 

(Some mirror sleds are the same length as the mirror assembly, in which 
case there will be no marks.)  

2. Attach with front-loading hardware. Assure the mirror will not slide in the 
sled’s channel when moved into position on the structure. Do not over-
tighten, which allows for adjustment during setup, if necessary. 

3. Assure mirror is positioned facing in the correct direction and at the 
correct angle to the break in the conveyor belt. 

4. Lift mirror into position as marked on the bottom-read mounting 
structure. 

5. Attach with front-loading hardware (do not over-tighten). 

 

IMPORTANT: Do not remove the protective film from the mirror’s surface 
until system setup and calibration. (See Chapter 5.)  
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RangeFinder Installation 

Prerequisites: None. 

 
Tools Required:  

 Socket driver (1/2”) 

 Allen wrench (5/32”) 
 

1. Attach mounting brackets to both sides of RangeFinder (if not already 
installed).  

2. Assure RangeFinder is positioned facing in the correct direction. 

3. Lift RangeFinder into position as marked on the mounting structure. 

4. Attach with front-loading hardware (do not over-tighten). 

5. Tie-wrap the power supply to the structure, making sure the power cable 
can be connected. 

6. For RangeFinders used in applications with conveyors under 40-inches 
[1016 mm] wide, follow the procedure outlined in Chapter 5.  
 

 

 
 

 

 

NOTE: Additional procedures related to RangeFinder installation are 
provided in Chapter 5 including RangeFinder leveling and blocking 
codewords for narrow belts.  

Direction  
of Travel
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Mounting the Tachometer 
The tachometer (tach) option outputs a set number of pulses for each wheel 
rotation. This tells the AV6010 the precise conveyor speed, allowing it to 
determine the exact package position. Tracking allows for multiple boxes to 
be in the scanning area at the same time. Bar codes on each box are 
decoded and assigned to the correct box. Follow the guidelines below: 
 
 Mount the anti-static brush to the tachometer as shown in the drawing 

provided with the tach. The anti-static brush provided with the tach must 
be installed to assure proper operation. 

 Mount the tach on the conveyor section where scanning is performed. 
 Mount the tach on the underside of the conveyor, away from areas 

where the conveyor bows downward. A good place to mount the tach is 
on one end of the conveyor, underneath the drive shaft. 

 Make sure the tach assembly angles in the same direction that the 
underside of the conveyor travels. 

 The tach must make good contact with the conveyor.  
 Use the general mounting kit provided with your system to make 

tachometer mounting and setup easier.  
 

 
 

Tachometer Mounting (anti-static brush not shown) 

 

 
Tachometer with Anti-Static Brush Installed 
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Mounting the Trigger Photoeye 
The standard photoeye works by bouncing a light beam off a reflector and 
detecting when something breaks the path of light. In order for photoeyes to 
work properly, make sure the following things are done when mounting the 
trigger photoeye option:  
 
 Mount trigger and reflector so the reader’s scan beam does not strike 

either of them. 
 Mount a reflector directly opposite the photoeye on the other side of the 

conveyor.  
 Install the reflector within the operating range of the trigger photoeye. 
 The photoeye must be mounted so the light exit window is perpendicular 

to the conveyor, facing the reflector. 
 The reflector must be mounted perpendicular to the conveyor, facing the 

photoeye. 
 Secure the photoeye and reflector to the mounting brackets with the 

hardware provided. 
 

 

IMPORTANT: The trigger photoeye’s beam (between photoeye and 
reflector) must be blocked by a package before the bar code is in position 
for scanning.  The trigger signal should remain active while the symbol is 
being scanned. This does NOT apply to tracking applications. 
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Mounting the Light Curtain 
For installations that use the light curtain option, see the application-specific 
drawing for mounting details. See also the documentation provided with the 
light curtain.  See wiring information in Chapter 4. 

 

 

Mounting the Photoeye/Tach Generator Box 
For installations that use the Photoeye/Tach Generator Box option (e.g., tilt-
tray applications), see the application-specific drawing for mounting details. 
See also the documentation provided with the Photoeye/Tach Generator 
Box. See wiring information in Chapter 4.  

 

 

Mounting the Uninterruptable Power Supply (UPS) 
For installations that use the UPS option (e.g., for applications that 
experience frequent ‘brown-outs’), see the application-specific drawing for 
mounting details. The mounting structure includes a bracket that supports 
the UPS. See also the documentation provided with the UPS. See wiring 
information in Chapter 4. 
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  4  Electrical Installation 
 

 

WARNING: Electrical installation by qualified service technicians 
only! A trained technician must perform any procedures involving potential 
exposure to high voltage electricity. Do not attempt to perform any electrical 
installation procedures unless you are a trained technician. 

 

IMPORTANT: The AV6010 contains electronics that may be affected by 
electrostatic discharge (ESD). To prevent personal injury or damage to the 
unit, please follow the safety precautions and warnings found in Chapter 2. 
Failure to follow these precautions may void your warranty. 

 

Preparing for Electrical Installation 
Before performing any electrical installation, please do the following: 

 Read all instructions before beginning your installation.  

 Observe all electrical safety requirements. (See Chapter 2.) 

 Complete mechanical installation.  (See Chapter 3.) 

 Review all installation-specific drawings.  

 Compare any installation-specific information to the standard 
Interconnection and Pinout drawings in Appendix I. 
Note the differences (if any). 

 Define and confirm the accuracy of your application’s requirements.  

 Plan the power requirements for your application. 

 Define the communications requirements for your application. 

 

 

IMPORTANT: AV6010 cameras ship with all the necessary cabling 
required to electrically install the system. If your system requires custom-
length cables or other special wiring, your shipment includes documentation 
specific to these requirements. Customer-specific documentation provided 
by Accu-Sort supersedes any contradictory content in this manual. 

Before proceeding with any installation procedures, be sure to review ALL 
documentation, especially any containing details specific to your installation. 

 

 

Installation Sequence(s) 

 

NOTE: Everything should be MECHANICALLY INSTALLED before 
performing any ELECTRICAL INSTALLATION. See Chapter 3 for 
mechanical installation details. 
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Installing a Single Camera System 

 
 

Prerequisites:  

 Complete preparations for electrical installation (see page 47) 

 Cabling (supplied with equipment)  

 Channel locks (for holding cables inside structure channels)  
(supplied with structure)  

 Single-camera system interconnect drawing 112754 in Appendix I  
(or installation-specific interconnect drawing, if provided) 
 

Tools Required:  

 None (basic tools may be needed to make mechanical adjustments) 

 

To electrically install an AV6010 single camera system: 

1. Ground the mounting structure to protective earth (PE) ground.  

2. Connect RangeFinder to its power supply.  

3. Connect the RangeFinder power supply to its power source. 

4. Connect the AV6010 Camera to its power source. 
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5. Connect one of the RangeFinder’s SYNC ports to the camera’s SYNC 
IN. 

6. Connect the other RangeFinder SYNC port to the camera’s SYNC OUT. 

7. Connect the tachometer to the camera’s TACH port (if required). 
(Do NOT connect the tachometer to the RangeFinder’s TACH port.) 

8. Connect the photoeye to the TRIG port (if required). 

9. Connect AV6010 HOST communications, as needed  
(e.g., HOST serial port or HOST Ethernet network). 

10. Connect the VisionCapture / IDS Server’s LAN connection to the 
camera’s IMAGE port (if required). 

11. Connect the optional FAST Monitor Server’s LAN connection to the 
camera’s HOST network port (if required). 

12. Complete any additional connections shown on the installation-specific 
drawings (if provided). 

 

NEXT STEP: Setup / check AV6010 operations. (See Chapter 5.) 
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Installing a Multiple Camera Tunnel 

 
 

Prerequisites:  

 Complete preparations for electrical installation (see page 47) 

 Cabling (supplied with equipment, may be color coded)  

 Channel locks (for holding cables inside structure channels)  
(supplied with structure) 

 Multiple-camera system interconnect drawing 112753 in Appendix I  
(or installation-specific interconnect drawing, if provided) 
 

Tools Required:  

 Wire cutters / strippers 

 Screwdriver 

 Basic tools may be needed to make mechanical adjustments. 

 

To electrically install an AV6010 multiple camera system: 

1. Ground the mounting structure to protective earth (PE) ground.  

2. Connect RangeFinder to its power supply.  

3. Connect the tachometer to the Controller camera’s TACH port (if 
required). (Do NOT connect the tachometer to the RangeFinder’s TACH 
port.) 
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4. Connect the photoeye to the designated camera’s TRIG port (if 
required). 

5. AC power: Connect the RangeFinder, cameras and all other devices to 
the AC power source. Typically an Accu-Sort Power Distribution Box 
(PDB) is used. (See page 55.) 

6. SYNC network: Determine which is the Controller camera and/or 
dimensioning camera. Connect the RangeFinder and all cameras 
completing a ‘ring’ network. (See page 58.) 

7. IMAGE network: Connect the camera’s IMAGE ports to the 
VIsionCapture / IDS Server’s network switch (if required). (See page 59.) 

8. Connect the optional FAST Monitor Server’s LAN connection to the 
camera’s HOST network port (if required). (See page 59.) 

9. Connect AV6010 HOST communications, as needed  
(e.g., HOST serial port or HOST Ethernet network). 

10. Complete any additional connections shown on the installation-specific 
drawings (if provided). 

 

NEXT STEP: Setup / check AV6010 operations. (See Chapter 5.) 
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General Electrical Installation Guidelines and Precautions 
It is important that you follow these general precautions when installing, 
setting up, operating, maintaining, troubleshooting or replacing any Accu-
Sort products, parts or related equipment.  

As you plan and install your AV6010, be sure to keep the following guidelines 
in mind: 

 Determine the AV6010 is in the proper location as outlined in Chapter 3. 

 Leave adequate clearances (approximately 8-12 inches [203-305mm]) 
for wiring. 

 Route wires carefully to reduce or minimize electrical noise.  

 When power and communication wiring must cross, make their 
intersection perpendicular. Avoid running power and data wiring parallel 
to each other. If possible, maintain one of the following separations 
between the power and data wiring: 

 12 inch [300 mm] gap 

 use steel conduit and 1 inch [25 mm] gap 

 0.25 inch [6.5 mm] of aluminum. 

 

 

IMPORTANT: When planning your installation wiring, remember all power 
connections must be quick-disconnect. For PERMANENTLY CONNECTED 
EQUIPMENT a readily accessible disconnect device must be incorporated 
in the building installation wiring. For PLUGGABLE EQUIPMENT the 
socket-outlet must be installed near the equipment and must be easily 
accessible.  

The IEC power connectors of the AV6010 cameras and RangeFinder 
provide the necessary quick-disconnect. 

 

 

WARNING: To assure no ESD damage will occur, be sure to observe the 
precautions outlined in Chapter 2, Safety. 

 
 IMPORTANT: Ground the mounting structure to safety ground (protective 

earth ground (PE)). See wiring recommendations for safety ground.  
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Wiring the AV6010 
After completing mechanical installation, use this section to properly wire 
your AV6010 for optimal performance in your application. All wiring 
connections to the AV6010 are made to the connector panel. 

Determine the wiring connections needed for your application. All 
connections are made to the AV6010 interface/connector panel using the 
cables shipped with your equipment. 

Drawing Description  
112754 AV6010 Single Camera Interconnections  
111515 AV6010 Connector Pin-outs 
Multiple Camera Systems 
112753 AV6010 Multiple Camera System Interconnections 
111062 Power Distribution Box Wiring Diagram (standard) 
111912 Power Distribution Box with Disconnect Wiring Diagram (larger box) 
NOTE: See the standard drawings provided in Appendix I. 
 Application-specific drawings supersedes those listed here. 

 
AV6010 Camera – Interface / Connector Panel   

 
AV6010 RangeFinder – Interface / Connector Panel 

The cables are color coded: 

 SYNC cables are BLUE. 

 IMAGE cables are YELLOW (for optional image capture system). 

Avoiding Electromagnetic Interference Using Ferrites and Shielding   
To avoid electromagnetic interference, snap-on ferrites or shielded cable 
should be used as described below. 

Connection Type  
HOST (SERIAL) Use 2 snap-on ferrites positioned on the serial host cable as 

shown on Ethernet cables below 
FOCUS (SERIAL) Use 2 snap-on ferrites positioned on the serial focus cable as 

shown on Ethernet cables below 
HOST (NET) Shielded cable or 2 snap-on ferrites placed as shown below 
IMAGE (NET) Shielded cable or 2 snap-on ferrites placed as shown below 
SYNC (NET) Shielded cable 
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Placement of Snap-On Ferrites on Cables 
To Attach the Ferrites: 

Snap two ferrites to each Ethernet or serial cable like those shown in the 
image on page 1. Place the ferrites approximately the distance shown 
from the end of the cable (close to the AV6010). 

Wiring Routing 
Route wiring to the AV6010’s connector panel through the wiring channels 
on the Accu-Sort mounting structure. 

                        
 Wiring Channels on Mounting Structure 

Power Requirements 

 

IMPORTANT: When planning your installation wiring, remember all power 
connections must be quick-disconnect.  

See the Power Consumption Estimates table in Appendix A to determine the 
needs for your installation. The table provides details for single-camera and 
multiple-camera applications. 

Power Supply Connections 

 

CAUTION: While performing the following wiring connection procedures, 
be sure to follow all safety procedures regarding high-voltage as outlined in 
Chapter 2, Safety.  No power should be applied to any device until all wiring 
is completed and checked for accuracy. 

 

REMEMBER: The socket-outlet must be installed near the AV6010’s power 
supply. The outlet must be a readily accessible disconnect device. The IEC 
connector of the AV6010’s power supply provides the necessary quick-
disconnect. 

Ethernet Cable Snap-On Ferrite 
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Power Distribution Box for Multi-Camera Systems 
Applications using two or more cameras will use the Power Distribution Box 
(PDB, 111063) to handle power for the RangeFinder, up to six cameras and 
the optional VisionCapture/Image Depot Server (IDS).  

 

 
Power Distribution Box Connections 

POWER INLET  
(4-Wire Grounded)  
30 AMP 125/250 VAC  
NEMA L14-30P 

CIRCUIT 
BREAKERS  
CB1 – CB7 
(10A) 

POWER 
MONITORING 
CIRCUITS 
K1 – K7 

TB1 (HOT) NEUTRAL GROUND 
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RangeFinder Power Supply Connection 

 
RangeFinder power supply connection procedure:  

1. Connect the power supply DC input 
connector into the RangeFinder’s 
PWR IN (DC input). 

2. Plug the AC power cord into the 
power supply. 

3. Plug the AC power cord into the 
power source.  

4. For multi-camera systems: If a 
Power Distribution Box (PDB) is 
used, it can be plugged into the 
outlet box on the right side of the 
PDB. 

 

RangeFinder PWR IN

 

Insert AC 
Power Cord 

Connect to 
RangeFinder 
PWR IN 
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AV6010 SYNC Network 
 

 

The AV6010 Camera System uses Ethernet communications for a dedicated 
SYNC network. Only AV6010 cameras and the RangeFinder may be 
connected to the SYNC network. See the interconnect drawings for a single-
camera (112754) and multi-camera system (112753) in Appendix I.  
 

Connecting RangeFinder to Camera: 

1. Connect the BLUE network cable to one of the SYNC ports on the 
AV6010 RangeFinder.  

2. Insert the cable into the wiring channels of the mounting structure.  
(See illustration on page 54.) 

3. Connect the other end of the network cable to the AV6010 Camera’s 
SYNC IN port.  

4. Connect a second network cable from the camera’s SYNC OUT port to 
the ‘open’ SYNC connection on the RangeFinder. 

 

  
 AV6010 RangeFinder AV6010 Camera 

Camera to RangeFinder Connection 
 
 

 

 

NOTE: In applications where there are two or more cameras, the SYNC 
OUT from the last camera should be connected to the ‘open’ SYNC 
connection on the RangeFinder. (See Connecting Camera to Camera.) 
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Connecting Camera to Camera: 

In applications where there are two or more cameras, the SYNC network 
forms a ‘ring network’ that starts and ends with the RangeFinder. (See 
drawing 112753 in Appendix I.)  

Connections between cameras should be made as follows: 

1. Connect from the SYNC OUT of Camera 1 to the SYNC IN of Camera 2. 

2. Insert the cable into the wiring channels of the mounting structure. 
(See illustration on page 54.) 

3. Continue making the camera network connections for all cameras in the 
tunnel. The SYNC OUT from the last camera should be connected to the 
‘open’ SYNC connection on the RangeFinder. 

 

IMPORTANT: The two most important cameras in a multi-camera system 
should be connected to the RangeFinder. For example: Both the camera 
acting as the DHCP server  (i.e., that is most accessible, handles the tach 
connection to the system and/or will be reading the highest percentage of 
codes) and the top read / dimensioning camera should be connected to the 
RangeFinder. In some application, these functions are all handled by the 
same camera. 

 

 
 AV6010 Camera 1 AV6010 Camera 2 

Camera to Camera Connection 
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Ethernet Communications Connections 
The AV6010 uses Ethernet for LAN (local area network) communications.  
Ethernet communications cabling can be run up to 330 feet [100 meters].  

See interconnection drawings 112753 and 112754 in Appendix I. 

 

  

HOST Network IMAGE Network 
 

Connecting a Host or Image Network: 

1. Connect one end of the cable to the HOST   or IMAGE network 
connection on a camera. 

2. Insert the cable into the wiring channels of the camera sled and 
mounting structure. (See illustration on page 54.) 

3. Connect the cable’s other end to the HOST or IMAGE network device.  

4. Continue making the network connections from each camera in the 
system to the HOST or IMAGE network device until all the devices are 
connected as required by the application. 

 

 
 See drawing 112753 in Appendix I:  

 Sheet 3 for the multi-camera IMAGE network connections  

 Sheet 4 for the multi-camera FAST Monitor network connections 
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RS232/422 Serial Communications Connections 
The AV6010 provides two standard RS232/422 serial ports identified as 
HOST and FOCUS. Use RS232 for a direct connection to a controller, 
personal computer, or other device.  

 

  
HOST (Serial Port) FOCUS (Serial Port) 

 
 RS232 provides point-to-point communications at distances up to  

50 feet [15.2 meters].  

 RS422 provides point-to-point communications at distances up to  
1000 feet [300 meters]. RS422 communications require the use of an 
RS232-to-RS422 converter. 

 

 

NOTE:  See the serial port pin-outs drawing 111515 in Appendix I. Your 
application interconnections may vary from those defined here. Be sure to 
review any application-specific information provided with your equipment.  

 

 

 

In AV6010 dimensioning applications, the 2-line by 20-character remote 
display option is connected to the FOCUS port of the top-read 
(dimensioning-enabled) camera.  
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TACHOMETER and TRIGGER Connections 
If your system includes the TACH or TRIG options, be sure to use the 
provided cables to make the necessary connections.  

In multi-camera networks, these connections are made to only one camera. 
That camera is considered to be the ‘controller’ (also called the DHCP 
server).  

Applications using a tachometer (TACH) should have the provided ferrite 
installed on the cable to help eliminate ‘noise’. 

In applications with a bottom read camera, the trigger (TRIG) may be 
connected it. 

 

  
TACH TRIG 

 

 

NOTE:  In systems that involve application-specific requirements, it is 
possible that light curtains and / or an Accu-Sort Photoeye/Tach Generator 
may be used instead of the standard devices. See any application-specific 
drawing(s) for details on installing and wiring these devices. 

 

 

 

In-camera Dimensioning Connections 
If your system includes the in-camera dimensioning option, the 2-line by 20-
character remote display option is connected to the FOCUS port of the top-
read (dimensioning-enabled) camera. (See also Appendix G.)  

 

 

Raw Image Export (RIE) Connections 
If your system includes the raw image export option, the destination device 
that will be receiving the raw images from the camera needs to be connected 
to the RIE output of the RIE-enabled camera(s). (See also Appendix H.) 
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Check AV6010 Installation 
After completing the installation of your AV6010: 

 Confirm that the AV6010 has been properly installed mechanically and 
electrically. Use the Installation Sequence at the beginning of this 
chapter and your application specifications to check your installation. 

 All interconnections should match the drawing that is applicable to your 
system’s application. (These drawings are superseded by any customer-
specific documentation provided by Accu-Sort.) 

 The AV6010 is pre-configured for your application at the factory. If 
necessary, you can change the configuration of the AV6010’s 
parameters to meet the needs of your application.  
(See Chapter 5 for details.)  

 An initial startup checklist and operations checklist is provided in 
Chapter 5. 
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5 Setup 
 
This chapter provides details on how set up the AV6010 Long-Range 
Camera System for your application. It outlines how to: 

 Auto calibrate the system to your application 

 Define the symbologies your system will decode 

 Configure the communications between the system and host 

After configuring your system using the browser-based AV6010 User 
Interface and AV6010 Install Wizard, use the operations checklist in 
Chapter 6 to verify normal operations. 

 

Prerequisites: 

 Complete the camera system installation for your application 
requirements. (See Chapters 3 and 4.) 

 Know your application specifications (e.g., symbologies, 
communications, etc.). 

 Assure your computer meets the system requirements and the 
required privileges for changing the IP address of your computer. 
 

Tools Required: 

 Flathead Screwdriver 

 Allen Wrench (5/32”) 

 Socket Driver (1/2”) 

 AV6010 Setup & Calibration Kit (10000456001) 
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Setup System Requirements 

The laptop computer you use to setup the AV6010 Camera System should 
meet the following requirements: 

 
Category Description 
Basic Configuration 
for using Install Wizard  

Windows XP Operating System  
Ethernet port/NIC Card 
Microsoft .NET framework   (see page 94) 

Internet Browser 
for using AV6010 Interface 

Microsoft® Internet Explorer 6.0 or later 
Mozilla Firefox 2.0 or later 

Screen Resolution (Optimal) 1024 x 768 

 

 
To gain access to an AV6010 Camera: 

1. Because AV6010 is web-based, you will need to obtain the correct 
IP address, netmask and gateway that will be used within the 
building from the system administrator. This will be used to 
establish a HOST network later. 

2. For the initial AV6010 setup, you will connect via the SYNC 
network.   
(Use the special SYNC network adapter cable that is included with 
the AV6010 Setup & Calibration Kit.) 

3. Using Internet Explorer or Mozilla Firefox, open a browser window. 

4. Enter the camera’s IP address in the Address entry field. 

5. Save the IP address as a Favorite or Bookmark in your browser for 
quick and easy access. 

6. After first time setup, you may need to obtain the password from the 
system administrator.  

7. When a connection is established, the AV6010 User Interface 
should appear. 

For details, see page 74. 

 

 

 

 

IMPORTANT: After an Accu-Sort trained and authorized technician 
configures your AV6010 camera system, they will verify normal operations 
and make calibration adjustments as necessary. The information in this 
chapter is for reference purposes only. 

For further information on training, contact us at 1-800-BAR-CODE. 
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First-Time Setup Checklist 

Basic Setup 

 1. Confirm that all equipment is mechanically and electrically installed  
  properly. (See Chapters 3 and 4.) 

 2. Unlock camera head and align the mirror.  
   (In multi-camera tunnels, confirm the power switch is ON.) 

 3. Level RangeFinder and block codewords if the application is using  
  a narrow belt (under 40-inches). 

 4. Follow the first-time startup procedure.  

 5. Establish a connection and login to the system. 

 6.  System Configuration  
   Assign system name and positions of each camera in the system. 

 7. Tach Configuration 
   Confirm that the tachometer settings are correct. 

 8. Focus and Package Info 
  Specify how the system is configured. 

 9. Mounting (RangeFinder and Camera(s)) 
  For first-time setup, use the AV6010 Install Wizard to auto calibrate  
  the system. Use these windows to make adjustments as necessary. 

 10. Serial Port Setup 

 11. Networking Setup 

 Image network (VisionCapture/IDS, optional) 

 Host network 

 12. Symbologies and Messages  

 13. Special Tools  (Diagnostics > Tools) (Chapter 8) 

 Download Install Wizard (for system calibration) 

 Set password  

System Calibration 

 14. Install Wizard > RangeFinder Wizard 

 15. Install Wizard > Camera Wizards  
Based on the application, this may involve performing the Static Focus 
Calibration for up to six cameras positioned in a scanning array or 
tunnel.  

 16. Dynamic Focus Calibration of all cameras using Image Viewer 

 17. Dimensioning Calibration (option) 

 18. Side-by-Side Package Detection Calibration (option) 

 

 



66 Setup AccuVision® AV6010 Long-Range Camera System Manual 
 

Accu-Sort Systems, Inc. 05-AV6010_Setup_R10.doc 

 Unlock the AV6010 Camera Head 

1. Locate the shipping screw on the camera. 

2. Using a flat head screwdriver, turn the camera head shipping lock to the 
unlocked position. Only turn 1/4 turn counter-clockwise. Do not force the 
shipping screw beyond the 1/4 turn. You will feel it ‘click’ into position. 

3. For multi-camera tunnels, also confirm the power switch is in the ON 
position for every camera in the system. 

 

 

 

 

 

 

 

 
                 Close-Up of Shipping Lock Location 

 

Location of Camera Head Shipping Lock 
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 Mirror Alignment 
Before using any of the camera calibration wizards, you will need to: 
 

         Install the folding mirrors 
         Determine proper mirror angles 
 Confirm proper mirror alignment for the camera position. 
 Remove the protective film from the mirror surface. 

 
 
Prerequisites: Before you begin, you will need: 
 
 Mirror alignment tools (8, 15, and 45-degrees) 
 5/32” Allen Wrench  

 
The standard mirror angles are as follows: 
 
   Camera Position        Mirror Orientation (standards) 
 Front / Back  45-degrees 
 Top Read  15-degrees * 
 Side Read  15-degrees * 
 Bottom Read  15-degrees * 
 Quadrant  45-degrees  

 

 

* NOTE:  In some applications the top read, side read and bottom read 
camera mirror may be set for 8-degrees.The mounting structure drawings 
provided with your application will identify which angle is to be used. 

 
 

 
Front / Top / Back Read  
Orientation of Mirror to Camera  

 
       Side Read / Quadrant   
       Orientation of Mirror to Camera 

 
AV6010 Camera and Mirror Alignment 
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To align a mirror for Front, Top or Back applications:  
 
1. Confirm mirror is properly mounted to the mirror sled (as shown). 

The flanged edge of the mirror mounting brackets should face the 
camera and the mirror angle will be almost parallel with the flange.  
 

2. Confirm the mirror assembly is mounted in the correct position on the 
mounting structure. (Mirror positions are pre-marked on the mounting 
structure. You can also check these positions on any mounting structure 
drawings provided with your system.) 
 

3. Use the proper mirror alignment tool to set the mirror position. 
 

4. Tighten the mirror mounting screws that fix the mirror position in place. 
 
5. After tightening the hardware, re-check the mirror angle with the 

alignment tool. 
 

6. Remove the protective film from the mirror surface before attempting 
calibration. 

 

 
 

Mirror Alignment for Front, Top and Back Cameras 
 

 

IMPORTANT:  Mirrors for front, top and back read applications must be 
aligned parallel with the flanged edge of the mounting bracket using the 
inside edge of the alignment tool. Mark the bracket and write down the 
angle in case the mirror ever needs to be replaced. 

 

Adjust mirror 
angle until the 
mirror is flush 
with the 
alignment tool. 

Flanged edge of 
bracket must 
face the camera.



AccuVision® AV6010 Long-Range Camera System Manual Chapter 5 69 
  

05-AV6010_Setup_R10.doc Accu-Sort Systems, Inc. 

To align a mirror for Side Read applications:  
 
1. Confirm mirror is properly mounted to the mirror sled (as shown). 

The flanged edge of the mirror mounting brackets should face the 
camera and the mirror angle will be almost perpendicular with the flange.  
 

2. Confirm the mirror assembly is mounted in the correct position on the 
mounting structure. (Mirror positions are pre-marked on the mounting 
structure. You can also check these positions on any mounting structure 
drawings provided with your system.) 
 

3. Use the proper mirror alignment tool to set the mirror position. 
 

4. Tighten the mirror mounting screws that fix the mirror position in place. 
 

5. After tightening the hardware, re-check the mirror angle with the 
alignment tool. 

 
6. Remove the protective film from the mirror surface before attempting 

calibration. 
 

 
 
Mirror Alignment for Side Read Cameras 
 

 

IMPORTANT:  Mirrors for side-read or quadrant applications must be 
aligned perpendicular with the flanged edge of the mounting bracket using 
the outside edge of the alignment tool. Mark the bracket and write down 
the angle in case the mirror ever needs to be replaced. 

Adjust mirror 
angle until the 
mirror is flush 
with the 
alignment tool. 

Flanged edge of 
bracket must 
face the camera.
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Leveling the RangeFinder 

Before beginning normal operations, the RangeFinder must be level with the 
conveyor surface. This is especially important to dimensioning applications.  

 

WARNING: The RangeFinder uses visible red lasers and is rated as a 
Class 2 Laser Product. Do not look directly into the beam. Observe all 
safety precautions outlined in Chapter 2. 

 

Prerequisites:  

 RangeFinder software revision 6.0 (or greater) 

 RangeFinder power must be ON during this procedure. 

 Confirm correct mounting location (install drawings, Chapter 3) 

 

Tools Required:  

 Socket Driver (1/2”) 

 5/32 Allen wrench 

 

To level the RangeFinder: 

1. Assure the mounting hardware is only finger-tight (4 places). 

2. Check the five leveling LEDs on the RangeFinder. The lit LED is like the 
bubble on a standard level. If the center LED is lit, no adjustment is 
needed. 

3. If one of the LEDs is lit to the left or right of center, make adjustments to 
the top and bottom adjustment screws on both sides of the RangeFinder 
until the center LED is lit. 

4. Once level, tighten the mounting hardware. 

 

 

 

 

 

 

 

 

Leveling LEDs on the RangeFinder 

 

 

 

Top adjustment screw 

Bottom 
adjustment 
screw 
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Blocking RangeFinder Codewords on Narrow Belts 

In applications where the conveyor is less than 40-inches wide, it is 
necessary to block the RangeFinder laser pattern (also called codewords) 
that is projected beyond the edges of the conveyor. 

 

WARNING: The RangeFinder uses visible red lasers and is rated as a 
Class 2 Laser Product. Do not look directly into the beam. Observe all 
safety precautions outlined in Chapter 2. 

Prerequisites:  

 Know the package flow (i.e., justified, non-justified) and usable belt width  
      (i.e., width of conveyor in which packages appear in the scanning area) 

 Remember: The RangeFinder cannot measure any further left and right  
       than where the codewords end. Allow at least one inch (25.4 mm) of  
       additional codewords to extend beyond the usable belt width. 

 RangeFinder power must be ON to see the laser pattern on the belt. 

 RangeFinder must be level. 

 

Tools Required:  

 Beam Blocker Kit (PN 1000067401, ships with RangeFinder) 

 Socket Driver (1/2”) 

 

Install and adjust the beam blockers: 

1. Mount the beam blockers to the structure. 

2. Attach loosely with the hardware provided. Do not tighten. 

3. While viewing the codewords on the belt, adjust the beam blockers to 
within one inch (25.4 mm) of the usable belt width on both sides by 
sliding them in the structure channel. 

4. Once the correct amount of codewords are blocked, tighten hardware. 
 

 
Beam blocker shown mounted to structure  
(Tape shown to make beam exit visible. Do not use tape.) 

Close-up of the RangeFinder’s scan line pattern 
(codewords) along edge of conveyor 

Left edge 
of usable 
belt width 

Block codewords to within 
one-inch [25.4 mm] 
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 First-time Startup: Single Camera 

1. Make sure all AV6010 system components are connected to the correct 
power source.  

2. To start the AV6010 camera(s), apply power using the power switch. 
 

 
 

3. On initial power-up, the AV6010 performs an initialization sequence.  

4. The PWR LED flashes and turns a steady green, followed by TRIG 
(green) and TACH (amber). At the same time, the AV6010 illumination 
will turn on and remain on for approximately 30 seconds, then turn off. 

5. The AV6010 automatically starts all application programs required during 
operations.  

6. After a few minutes, the illumination flashes ON then OFF.  
(The system is ready for operation in approximately five minutes.) 

The STAT LED is solid green to indicate normal operation.  
 

 
 
 

 

NOTE: During the startup sequence, you may proceed with First-Time 
Setup and establishing a connection to the AV6010 camera. Do not 
attempt a camera connection until the startup sequence is complete. 

Status Indicator LEDs 
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  First-time Startup: Camera Tunnel using Power Distribution Box 

Multi-camera applications, such as scanning arrays and tunnels, use the 
Power Distribution Box (PDB). The RangeFinder and all cameras are 
electrically wired to the PDB.  

1. Assure the PDB AC power cord is properly wired to the power source.  

2. Make sure all AV6010 system components are connected to the PDB.  

3. Connect the PDB AC power cord to the PDB. 

4. After connecting power to the PDB, the AV6010 cameras perform an 
initialization sequence as described on page 69.  
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First-time Setup 

The AV6010 browser-based user interface is the tool you will use to setup,  
change parameters, monitor operations, and diagnose problems.  
 

To establish a connection and login: 

1. Connect an Ethernet cable to your computer’s Ethernet port and to the 
AV6010 camera SYNC network (either IN or OUT)  
 

 

 

NOTE: You may need to disconnect a cable 
from one of these ports if an open one is not 
available. If you do so, remember to reconnect 
the SYNC camera network cable when you are 
finished with system setup. 

 

WARNING: Only connect to the SYNC network during static calibration. 
Having a non-camera system connection to the SYNC network during 
normal operations may cause tracking problems. 
 

2. Apply power to the AV6010 camera system. 
Wait approximately 4-6 minutes until the startup process is complete. 

3. Using Internet Explorer, type the following address in the address box: 
 
http://xx.xx.xx.xx 

where xx.xx.xx.xx is the IP address of the AV6010.  
 

 

NOTE: All AV6010 units ship as DHCP clients without any IP address. 
When proper startup is complete and a camera connection is established 
via the SYNC network, the DHCP controller camera will assume a static IP 
address of 192.168.0.50.  Use this IP address for first-time setup. You will 
need to obtain the correct IP address that will be used within the building 
from the system administrator. This will be used to establish a HOST 
network later. 

In a multiple-camera system, the camera with TACH wired to it assumes 
the 192.168.0.50 IP, becomes a DHCP server and assigns IP addresses 
to the other cameras. The RangeFinder remains a static IP (192.168.0.40). 

4. The user interface Login screen is displayed.  
If your computer is set up for DCHP, it will obtain an IP from the AV6010 
automatically. (See “How to confirm your computer is setup for DCHP”.) 

5. Select the User ID Setup from the drop-down menu in order to define 
the system parameters. (The Monitor User ID is used only to view and 
monitor systems operations.)  

6. Enter the default Password (‘setup’ or ‘monitor’) in lowercase.  
The user interface Home page is displayed. 

 

To change the password, see “How to set new passwords” under  
Diagnostics > Tools in Chapter 8. 
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How to confirm your computer is set up for DHCP: 

1. Under Windows, go to the Start menu.  

2. Select Control Panel > Network Connections and click Network 
Connections.   

3. Click Local Area Connection. 

4. Click Internet Protocol. 

5. Click Properties. 

6. Veirfy the window appears as shown below.  
'Obtain an IP address automatically' should be selected. 

7. Click OK. 

 

 
 

 

NOTE: There may be times when you need to use a 'static IP' setting in 
this window, for example, upgrading AV6010 system software. For details 
on setting a static IP, see “How to use a static IP address”. 
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AV6010 User Interface 

System Configuration 

Use the System Configuration page to check that a connection is established 
with all AV6010 components in your system, assign a name to the system, 
and confirm (or set) the positions for each device. 

 

Prerequisites: None. 

 

To set the Name for the system and all camera positions: 

1. Select System Configuration from the menu tree.  

2. Enter a Name for your system. 

3. Click the Blink button to confirm the camera connection and position. 
This will cause the illumination to flash on then off again.  
(If your application uses multiple cameras, each camera detected by the 
system will appear on the screen.)   

4. Confirm the Position is properly set for the camera that is flashing it’s 
illumination. Change the position using the drop-down menu, if 
necessary. 

5. Perform Step 4 for every component in the system. 

6. Click Update to save any changes. 

7. Click Reset to return all parameters to the last values saved. 

 

 

See also: System Configuration in Appendix B. 
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Tachometer 

Use the Tachometer window to set key parameters that help define the 
camera system’s timing during normal operations. 

 

Prerequisites: You must know whether your system is using an external 
tachometer or will be requiring an internal tachometer setting for a specific 
number of feet per minute. 

 

To set the system to use an External tachometer: 

1. Select Setup > Tachometer from the menu tree. The Tachometer 
window is displayed. 

2. Confirm the tachometer Source is set correctly for External tach.  
Change it using the drop-down list, if necessary. 

3. When using an external tachometer, be sure to: 

a. Enter a Resolution in the field in tach pulses per inch.  
Typically set for either 16 or 20. (Resolution must be set to 20 if 
using dimensioning.) 

b. Enter a Scale Factor.  No change required. Leave set as 1. 
(Change may be required in dimensioning applications.) 

4. Click Update to save any changes. 

5. Click Reset to return all parameters to the last values saved. 

 

To set the system to use an Internal tachometer:  

1. Select Setup > Tachometer from the menu tree. The Tachometer 
window is displayed. 

2. Confirm the tachometer Source is set correctly for Internal tach. Change 
it using the drop-down list, if necessary. 

3. Set an internal tach Belt Speed in feet per minute. 

4. Click Update to save any changes. 

5. Click Reset to return all parameters to the last values saved. 

 

 

See also: Setup > Tachometer in Appendix B. 
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Focus and Detection 

Use this window to set the key focusing and package detection requirements 
for your application. 

 

Prerequisites: You must know your application requirements for:  

 minimum/maximum package sizes (length, width and height),  

 package spacing,  

 conveyor width (automatically set by the AV6010 Install Wizard),  

 focus source and  

 package detection trigger source. 

 

 

NOTE: It is recommended that the Focus and Detection parameters be 
set before running the AV6010 Install Wizard (also called the AutoCal 
Wizard). 

 

To set the Focus and Detection configuration: 

1. Select Setup > Focus and Detection from the menu tree.  
The Focus and Detection window is displayed. 

2. Enter the Minimum Package Size dimensions (length, width and 
height).  

3. Enter the Maximum Package Size dimensions (length, width and 
height).  

4. Enter the Minimum Package Spacing (i.e., the minimum distance 
between packages being conveyed through the scanning area). 

5. Confirm the Conveyor Width.  
(There is no need to enter the width here since it is automatically entered 
by the AV6010 Install Wizard.) 

6. Confirm the Focus Source used by your system. Typically, this should 
be set for RangeFinder. Change, if necessary, to match your application.  
 
If you change the Focus Source, click Update first before selecting the 
Package Detection Trigger Source. 

7. Select the Package Detection Trigger Source. 

8. Click Update to save any changes. 

9. Click Reset to return all parameters to the last values saved. 

 

 

See also: Setup > Focus and Detection in Appendix B. 
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RangeFinder Mounting 

Use the RangeFinder Mounting window to make adjustments the orientation, 
mounting position and front/back box tracking extensions.  
 

 

NOTE: It is recommended that the AV6010 Install Wizard be used to set 
these parameters the first time. Through a series of setup wizards, you 
can ‘teach’ the system key parameters which results in auto calibration. 
The RangeFinder Mounting window can be used to adjust the dimensions 
as necessary to improve system performance. 

 

Prerequisites:  

 The AV6010 Install Wizard should be downloaded and installed on your 
computer.  

 Use the RangeFinder Wizard to auto-calibrate these configuration 
settings. 

 

To set the RangeFinder Mounting configuration: 

1. Select Setup > Mounting > RangeFinder from the menu tree. Select 
the camera position that you want to configure (e.g., front, top, back, 
etc.). The window for the selected camera position is displayed. 

2. Enter the Mounting Angles (roll, pitch and yaw). 

3. Enter the Mounting Position (along belt, across belt and height). 

4. Enter the RangeFinder Ignore Limits (left and right). 

5. Enter the RangeFinder Settings as required by the application. 

6. Click Update to save any changes. 

7. Click Reset to return all parameters to the last values saved. 

 

See also: Setup > Mounting > RangeFinder in Appendix B. 
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Camera Mounting 

Use the Camera Mounting window to make adjustments to the orientation, 
mounting position and front/back box tracking extensions.  
 

 

NOTE: It is recommended that the AV6010 Install Wizard be used to set 
these parameters the first time. Through a series of setup wizards, you 
can ‘teach’ the system key parameters which results in auto calibration. 
The Camera Mounting window can be used to adjust the dimensions as 
necessary to improve system performance. 

 

Prerequisites:  

 The AV6010 Install Wizard should be downloaded and installed on your 
computer.  

 Use the Camera Install Wizard to auto-calibrate these configuration 
settings.  

 

 

To set the Camera Mounting configuration: 

1. Select Setup > Mounting from the menu tree. Select the camera 
position that you want to configure (e.g., front, top, back, etc.). The 
window for the selected camera position is displayed. 
 

 

NOTE: Only the camera positions applicable to your system and assigned 
in the System Configuration window will have a Camera Mounting 
window selectable from the menu tree. The position selected will appear at 
the top of the active screen area in ( ) brackets. 

2. Enter the Camera Pitch Angle. 

3. Enter the Camera Yaw (0 or 180). 

4. Enter the Distance from Trigger (X). 

5. Enter the Camera Offset (Y). 

6. Enter the Mounting Height (Z). 

7. Confirm the Far Working Distance.  

8. Enter the length for the front and back Tracking Box Extensions. 

9. Click Update to save any changes. 

10. Click Reset to return all parameters to the last values saved. 

 

See also: Mounting > Camera Mounting in Appendix B. 
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Symbologies 

Use the Setup > Symbologies window to add, modify or delete any of the 
symbologies that the camera system must decode. A unique name may also 
be assigned to each symbology on the Active Symbologies list. 

 

Prerequisites: You will need to know the symbologies to be scanned and 
decoded by your system including: 

 All symbology types to be ‘found’ by the system 

 Any symbology-specific requirements 

 Minimum/maximum code lengths 

 Filtering required 

 Minimum/maximum quantity of each code to be ‘found’ 

 

 

NOTE: The calibration boxes supplied with the system include Code 39 
bar codes. For first time setup, you can add Code 39 to the list to confirm 
the camera reads the codes on the calibration boxes. 

 

Adding a symbology: 

1. Assign a unique name for the symbology, if required.  
(If no entry is made, this defaults to the code type.) 

2. Select a symbology from the Code Type drop-down list. 

3. Assign a minimum code length. 

4. Enter a maximum code length. 

5. Enter a Match Filter, if necessary. 

6. Enter a minimum quantity. 

7. Enter a maximum quantity. 

8. Click Add.  
The new code will appear in the Enabled Symbologies list. 

9. Click Update. 
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Deleting a symbology: 

1. Click on the option button to the left of the symbology to be deleted. 

2. Click Remove.  
The selected symbology disappears from the Enabled Symbologies list. 

3. Click Update.  

 

Modifying a symbology in the Selected Symbologies list: 

1. Position cursor in any data entry fields to be modified and double-click. 

2. Enter the change. 

3. Repeat for other fields requiring changes. 

4. Click Update.  

 

See also: Setup > Symbologies in Appendix B. 
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Communications Transmit Point 

Use this window to set the transmit point for your application. In multiple 
camera / tunnel applications, each camera may have a unique transmit point 
setting. 

 

Prerequisites: You will need to know the serial communications details: 

 Baud rate, stop bits, parity, data bits, flow control, 

 transmit message type and 

 keep alive message. 

 

 

NOTE: In applications using the VisionCapture / Image Depot Server 
(IDS), the transmit points for all cameras need to be greater than the 
Image Transfer transmit point. 

 

The transmit point is always measured from the RangeFinder, even in 
applications that also include a photoeye. 

 

To set the Transmit Point: 

1. Select Setup > Communications > (Camera) > Transmit Point from 
the menu tree.  
The Transmit Point window is displayed. 

2. Select a Tracking Mode. 

a. Trailing Edge 

b. Leading Edge 

3. Set the Distance to Transmit Point (in inches). 

4. Click Update to save any changes. 

5. Click Reset to return all parameters to the last values saved. 

 

See also: Setup > Serial Communications in Appendix B. 
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Serial Communications 

Use this window to set the serial communications requirements for your 
application. In multiple camera / tunnel applications, each camera may have 
unique serial communication settings, if needed. At the very least, the 
Transmit Point settings will be different. 

 

Prerequisites: You will need to know the serial communications details: 

 Baud rate, stop bits, parity, data bits, flow control, 

 transmit message type and 

 keep alive message. 

 

To set the serial communications: 

1. Select Setup > Serial Communications from the menu tree.  
The Serial Communications window is displayed. 

2. Select a Baud Rate. 

3. Select a Stop Bits. 

4. Select a Parity. 

5. Select a Data Bits. 

6. Select a Flow Control. 

7. Select a Transmit Message Type from the drop-down list. 

8. Enter a Keep Alive Time (sec). 

9. Enter a Keep Alive Message.  
This message is sent when the Keep Alive time expires. 

10. Click Update to save any changes. 

11. Click Reset to return all parameters to the last values saved. 

 

See also: Setup > Serial Communications in Appendix B. 
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Host Network 

Use this window to set the host network requirements for your application. 

 

Prerequisites: You will need to know the host network communications 
details: 

 IP address, gateway and netmask 

 Connection type 

 Message format 

 

To set the Host Network: 

1. Select Setup > Communications > (Camera) > Host Network from the 
menu tree. The Host Network window is displayed. 

2. IP Address Assignment 
3. Host Network Port 1 

a. Connection Type 

b. Message Format 

c. Port Number 

d. Keep Alive / Keep Alive Message 

4. Repeat Step 3 for Host Network Ports 2 – 4 as required by your 
application. 

5. Click Update to save any changes. 

6. Click Reset to return all parameters to the last values saved. 

 
See also: Setup > Communications > (Camera) > Host Network in Appendix B. 

 

 . 
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Image Network 

Some applications use the optional AccuVision® VisionCapture™ Image 
Capture System to gather and store images. If your application utilizes the 
this system with an Image Depot Server (IDS), you will need to setup the 
Image Network screen. 

Prerequisites: You will need to know the following: 

 Imaging system networking requirements 

 Transfer criteria 

 Destination IP  (Standard ASI IDS IP 10.0.40.19) 

 Image Transmit Point 
 

 

NOTE:  While each camera may have separate transmit points, the 
Image Transfer transmit point is globally used by all cameras in the 
system.  

It is recommended that the Image Transfer transmit point be set at least  
5-inches [12.7 cm] shorter than the longest camera transmit point. 

 

To set the Image Network: 

1. Select Setup > Communications > (Camera) > Image Network from 
the menu tree. The Image Network window is displayed. 

2. IP Address Assignment 
a. Choose between Static IP and Dynamic IP. 

3. Static Network Settings  
a. Set IP Address. In multi-camera systems, each camera has a unique 

IP. The VisionCapture/IDS IP assignments for AV6010 are as follows: 
 

Camera Position IP Address Camera Position IP Address 

Top Read 10.0.40.21 Front Read  10.0.40.24 

Left-Side Read 10.0.40.22 Back Read 10.0.40.25 

Right-Side Read 10.0.40.23 Bottom Read 10.0.40.26 

NOTE: No settings required for Dynamic IP Address Assignment 

4. Image Transfer (Global to all cameras) 

a. Image Transfer Criteria 

b. Image Destination IP 

c. Maximum Transmit Point  

d. Image Cropping 

e. Downsampling 

f. Save Every xx image(s) 

5. Click Update to save any changes or Reset to return all parameters to 
the last values saved. 
 
See also: Setup > Communications > (Camera) > Image Network, Appendix B. 
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Advanced > Imaging (Camera) 

 

 

CAUTION: Modifying any of these advanced parameters may adversely 
affect the operation of your camera system. Changes to these parameters 
should not be made unless recommended by an authorized Accu-Sort 
customer support technician. 

 

 

Prerequisites: You will need to know the following: 

 DPI at the far reading distance.   
(Automatically entered by the AV6010 Install Wizard.) 

 

 

To set the advanced imaging functions: 

1. Select Setup > Advanced > Imaging > (Camera Position) from the 
menu tree. The Imaging window is displayed for the camera selected. 

2. LPI (Lines Per Inch) 
(The AV6010 Install Wizard takes the DPI at the far reading distance and 
enters it as the LPI to assure images do not appear elongated.) 

3. Gain 
The options are Normal or Fixed. Normal allows the camera to change 
the gain dynamically for variations in package sizes. Fixed applies a 
fixed gain regardless of where in the DOF the package appears. 

4. Digital Zoom 
When selected, Digital Zoom maintains the same DPI throughout the 
whole DOF. If not selected, the DPI is determined by the height of the 
package passing through the DOF. 
 

5. Image Mod 
HW Correction (default is enabled) 

Binarization – (Not available at time of publication.) 

Digital Gain –This option digitally adds gain to the image to make the 
white area look brighter.   

Image Enhance – This option causes greater contrast in images (i.e., 
blacks appear darker and whites appear brighter) which improves the 
camera's ability to decode symbologies.  

 

See also: Setup > Advanced > Imaging (Camera) in Appendix B. 
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Advanced > Decoder Options 

 

 

CAUTION: Modifying the advanced parameters may adversely affect the 
operation of your camera system. Changes to these parameters should not 
be made unless recommended by an authorized Accu-Sort customer 
support technician. 

 

Use this screen to define any advanced decoder options for the bar code 
symbologies the AV6010 is expected to read. 
 

Prerequisites: You will need to know the following: 

 Symbologies to be decoded 

 Advanced decoder options required for the symbologies 

 

To set the advanced decoder options: 

1. Select Setup > Advanced > Decoder Options from the menu tree.  
The Decoder Options window is displayed. 

2. Set the desired bar code options as needed for the symbologies defined 
in Setup > Symbologies. 

3. In order to utilize these options you must have an advanced knowledge 
of the bar code symbologies to be read by the camera(s). Contact an 
Accu-Sort technical support for further assistance. 

 

See also: Setup > Advanced > Decoder Options in Appendix B. 
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Dimensioning Setup and Calibration  

Some applications use the optional AV6010 dimensioning module for 
dimension-weighing-scaling and / or revenue recovery applications. 

 

Prerequisites: You will need the following: 

 Top-read camera must include a DCM with the dimensioning module 

 All wizard calibrations must be completed (system “tracked in”) 

 Dimensioning calibration box or calibration test patterns 

 Laptop with Install Wizard connected to camera system 

 

To set the dimensioning functions: 

You need to make settings/adjustments in the following AV6010 user 
interface windows: 

 Symbologies 

 Tachometer 

 Camera Mounting (Top only) 

 Imaging (Top only) 

 Dimensioning 

 

Tachometer Settings for Dimensioning 

1. Select Setup > Tachometer from the menu tree.  
The Tachometer window is displayed. 

2. Confirm the External Tachometer Resolution is set for 20.00 
pulses/inch. 

3. Set the Scale Factor to 1.00.   
 

 

NOTE: This is the setting that compensates for length of the package.  As 
the Scale Factor is reduced the package is reported longer. For example: 
If a package is dimensioned shorter than it actually is, decrease the Scale 
Factor by very small amounts until the system reports the actual box size.  
Start by adjust the thousandths value. 
 

4. Click Update. 
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Top Camera Mounting Settings for Dimensioning 

1. Select Setup > Mounting > Top from the menu tree.  
The Camera Mounting (Top) window is displayed. 

2. Set the Camera Pitch Angle to 8.0 degrees.   
 

 

NOTE: The top-read camera’s mirror must be set for an angle of   
8-degrees (± 1). If it is not set for an 8-degree angle, perform the mirror 
alignment procedure and then re-run the install wizard before continuing 
with the dimensioning setup. 
 

3. Click Update. 

 

 

Symbologies Settings for Dimensioning 

1. Select Setup > Symbologies from the menu tree.  
The Symbologies window is displayed. 

2. Select ASI Diagnostics from the Code Type drop-down list.  
ASI_Diagnostics will appear as a Symbology under Enable Symbologies. 

3. Enter a name in the Name field for ASI Diagnostics (e.g., ASIDIAG). 

4. Click Add. 

5. Select Dimensions from the Code Type drop-down list. 
Dimensions will appear as a Symbology under Enable Symbologies. 

6. Enter a name in the Name field for Dimensions (e.g., ASIDIM). 

7. Click Add. 

8. Click Update. 

 

 

 

Top Camera Imaging Settings for Dimensioning 

1. Select Setup > Advanced > Imaging > Top from the menu tree.  
The Imaging (Top) window is displayed. 

2. Set the LPI to the same value as the DPI of the top-read camera at the 
far reading distance.   

3. Enable the Digital Zoom Mode (check in checkbox). 

4. Click Update. 
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Dimensioning Settings 

1. Select Setup > Options > Dimensioning from the menu tree. The 
Dimensioning window is displayed. 

2. Set the Package Height Options:  
a. Variation Threshold to 0.2   

b. Accuracy to 0.2 inch. 

3. Set the Package Length/Width Options:  
a. Confidence Threshold to 50 

b. Accuracy to 0.2 inch 

4. Set the Certified Package Size Options for Minimum Package Size 
(Length, Width and Height). 
 

 

NOTE: The minimums cannot be set less than 12 times the accuracy or  
4-inches, whichever is greater. 
 

5. Set the Certified Package Size Options for Maximum Package Size 
(Length, Width and Height).  
 

 

NOTE: The maximum length allowed is 72-inches [1828.8 mm].  
The maximum width or height allowed is 36-inches [914.4 mm]. 
 

6. Advanced Options > Length Determined by… 

7. Click Update. 
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Calibrating the Dimensioning System 

1. Start the conveyor belt. Allow it to run for a few minutes until the 
RangeFinder has had time to SYNC with the cameras. 

2. Select Diagnostics > System Status and confirm that all the cameras 
and RangeFinder are reporting OK. If not, click on the specific device to 
determine the problem and resolve it. 

3. Run the dimensioning calibration box down the center of the belt with as 
little skew as possible where the 36” side is aligned with the belt.   

4. The remote display should have read either Calibration Success or 
Calibration Failure. 

5. If Calibration Success is displayed, continue with Setting the Cert 
Mode. 

6. If Calibration Failure is displayed, go to Diagnostics > Top Camera > 
Logging and look for the reason why the failure occurred.  
 
For example: If a line in the log indicates that the DPI factor failed then 
manually adjust the DPI Scale Factor on the Dimensioning screen and 
repeat the dimensioning calibration procedure. 

 

 

IMPORTANT: The dimensioning auto calibration limits the magnitude of 
changes it will make to any parameter in order to assure improper changes 
are not made due to using the wrong calibration box, etc. 
 

 

Setting the Cert Mode 

1. Select Setup > Advanced > Dimensioning from the menu tree. The 
Dimensioning window is displayed. 

2. Set the Cert Mode to Cert On – English. 

3. Click Update. 
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 AV6010 Install Wizard 

Use the AV6010 Install Wizard application as a simplified method of 
determining the mounting information needed in the AV6010 user interface 
under the Mounting > Ranger and Mounting > Camera setup screens. 

Based on your application, there can be several auto calibration wizards 
made available through the AV6010 Install Wizard application including the 
RangeFinder and one for each camera in the system. 

 

Prerequisites: You will need to establish a connection with an AV6010 
camera before you can download the install wizard. 

 

To download the AV6010 Install Wizard: 

1. In the AV6010 user interface, select Diagnostics > Tools. 

2. Under Downloads, select InstallWizard.zip. 

3. In the File Download dialog box, click Save. 

4. Define the location on the C: drive where the wizard will be saved. 
It is recommended that you create an Accu-Sort folder in the Program 
Files folder on your C: drive (e.g., C:\Program Files\Accu-Sort). 

5. Click Save. The ZIP file will take several seconds to download. 

6. Click Close when Download Complete appears. 

7. Go to the C:\Program Files\Accu-Sort location and open the 
InstallWizard.zip file. 

8. Double-click AV6010Setup_1.1.3.msi file. 

9. The AV6010 Calibration Software Setup Wizard will open in a new 
window. 

 

NOTE: If you have previously installed the software, the wizard will offer 
the choice to Repair or Remove the software version it found on your 
computer.  
 

10. Follow the wizard’s instructions to install the AV6010 Calibration 
Software. 

11. Once installation is finished, the AV6010 Install Wizard icon should 
appear on your desktop. 
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NOTE: If your computer does not have the Microsoft's .NET framework 
installed, this error will display when you launch the AV6010 Install Wizard: 
 

 
 

 

To download the Microsoft .NET framework: 
 

1. To find and install the Microsoft .NET framework needed in order to run  
     the AV6010 Install Wizard go to: 
 
http://search.microsoft.com/results.aspx?mkt=en-US&setlang=en-
US&q=.NET+framework 
 
2. Find the following Windows Support File utilities: 
 

 Windows Installer 3.0 Redistributable   
(WindowsInstaller-KB884016-v2-x86.exe) 
http://www.microsoft.com/downloads/details.aspx?familyid=5FBC5470-
B259-4733-A914-A956122E08E8&displaylang=en 

 
 Microsoft .NET Framework Version 2.0 Redistributable Package (x86) 

(dotnetfx.exe) 
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EAC
B-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en   

 
 Microsoft's .NET utilities for Visual C++ 2005 Redistributable Package 

(x86) (vcredist_x86.exe) 
http://www.microsoft.com/downloads/details.aspx?FamilyID=32BC1BE
E-A3F9-4C13-9C99-220B62A191EE&displaylang=en 
 

 
3. Save the files to your computer.  
 
4. Install the files in the order listed above. 
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To open the AV6010 Install Wizard: 

1. Locate the icon on your desktop. 
 

 
 

2. Double-click the icon to open the wizard. 

3. The AV6010 Install Wizard screen is displayed. 
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RangeFinder Wizard 
 

 

This wizard is used to learn the RangeFinder’s position over the conveyor, 
including the usable conveyor (region of interest) and height above the 
conveyor surface. 

 

Prerequisites:  

 Calibration box 

 Tape measure 

 Confirm the RangeFinder is centered over the scanning area 

 Confirm the RangeFinder is level and that excess codewords are 
blocked if the application is using a narrow belt (under 40-inches) 

 Laptop with Install Wizard connected to camera system 

 

To auto-calibrate the RangeFinder: 

1. Click the RangeFinder Wizard button. 

2. Set the Mount Selector and click Next. (Normally left as Standard.) 

3. Confirm the RangeFinder scan line is perpendicular to the conveyor’s 
direction of travel using a calibration box.  

4. Learn the Region of Interest.  
a. Measure the conveyor width used by the application. 

b. Measure the usable conveyor from: 

i. Left edge to the left-side RangeFinder spot. 

ii. Right edge to the right-side RangeFinder spot. 

c. Enter the three measurements in the wizard and click Next. 

5. Confirm Height Above Conveyor Surface using a calibration box. 

6. Use the Summary to review the position information that will be sent to 
the camera system. 

7. Click Finish to save the RangeFinder position information to the camera 
system. 

8. Continue with the Camera wizard. 

 

 

NOTE:  It is recommended that these numbers not be changed. 
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RangeFinder’s scan line on conveyor,  
edges of usable belt shown 

Close-up of the RangeFinder’s 
scan line pattern (code words) 

RangeFinder Scan Line 
 
 

 
Measuring from edge of conveyor  
to the alignment dot 

Close-up of measuring  
to the alignment dot 

Measuring to determine the Region of Interest 

Left side  
of conveyor 

Right side  
of conveyor 

Direction of 
Travel 
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Photoeye Wizard 
 

 

This wizard is used to setup a photoeye as the package detection / trigger 
source for the camera system. 

 

Prerequisites:  

 Photoeye must be installed at the correct location a minimum of 6.0 
inches [152 mm] upstream from the RangeFinder or light curtain. 
(See the installation drawings provided with the system.) 

 Photoeye must be set as the package detection trigger on the Focus 
and Detection page of the AV6010 User Interface 

 Tape measure 

 Laptop with Install Wizard connected to camera system 

 

To setup the photoeye: 

1. Click the Photoeye Wizard button. 

2. Measure the distance from the photoeye to the scan line of the focus 
source (either RangeFinder or light curtain). Enter this measurement in 
the ‘D: Photoeye to Focus Source Distance’ field. 
 

 
3. Enter the Photoeye Debounce Distance.  

This distance should always be a positive value and less than the 
distance to scan line (D). It is recommended that the difference between 
these two distances be at least 5.0 inches. 

4. Set the Photoeye Active Level either Low or High depending on the 
photoeye used. (The default is preset to Active Low for the Accu-Sort 
photoeye.) 

5. Click Next. 

6. Click Finish to save the photoeye position information to the camera 
system. Wait until the System Parameters Update is completed. 

7. Continue with the Camera wizard(s). 

 

 

NOTE:  It is recommended that these numbers not be changed. 
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Light Curtain Wizard 
 

 

This wizard is used to setup a light curtain as the trigger source. 
 

Prerequisites:  

 Light curtain must be installed at the correct location 
(reference the installation drawings provided with the system) 

 Light curtain must be set as both the focus and the package detection 
trigger on the Focus and Detection page of the AV6010 User Interface 

 Tape measure 

 Laptop with Install Wizard connected to camera system 

 

 

To setup the light curtain: 

1. Click the Light Curtain Wizard button. 

2. Measure the offset between the light curtain’s zero height reference point 
and the conveyor’s surface. Enter this measurement in the Light 
Curtain Height Offset field. The height offset is a positive value when 
the light curtain’s zero height reference point is located above the 
conveyor surface. 
 

 
3. Click Next. 

4. Click Finish to save the light curtain position information to the camera 
system. Wait until the System Parameters Update is completed. 

5. Continue with the Camera wizard(s). 

 

 

NOTE:  It is recommended that these numbers not be changed. 
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Top Camera Wizard 
 

 

This wizard is used to learn the Top camera’s position.  
Setup for Top, Top-Front or Top-Back cameras is similar. 
The icon will appear different based on the camera orientation. 

 
Prerequisites:  Know the top camera angle required by the system.  
It will be one of the following:  
 
 15-degrees (positive angle) 
 15-degrees (negative angle) 
 8-degrees (positive angle, used in dimensioning systems) 
 RangeFinder must already be calibrated 
 Mirror must already be aligned 

 
Tools Required:  
 Small calibration box 
 Camera Scan Line Target 
 Static Focus Target 
 Tape measure 
 Laptop with Install Wizard connected to camera system 

 

 

NOTE:  The Small Calibration Box and targets are provided in the 
AV6010 Setup & Calibration Kit (part number 111456001). The targets 
are also available from the AV6010 user interface. Go to: Diagnostics > 
Tools and click the Utilities and Documentation link. 

 

To auto-calibrate the Top Camera: 

Follow the camera wizard’s instructions to perform the static auto-calibration. 

1. Click the Top Read Wizard button. 

2. Set the Top Camera Angle Orientation Selector for either Top-Front or 
Top-Back. Camera angle facing upstream is negative (Top-Front). 
Camera angle facing downstream is positive (Top-Back). 

3. Use the Camera Scan Line Target to determine the distance from the 
camera to the focus source (RangeFinder). Enter this measurement as 
the X Scan Offset. 

4. Use the small calibration box and Camera Scan Line Target to determine 
the X Distance. 

5. The system uses the previously entered information to compute the 
camera’s read angle. Do not change unless otherwise instructed. 

6. Use the Static Focus Target to determine the camera’s far working 
distance.  

7. Review the Calibration Results Summary for the camera. 
 

 

NOTE:  The wizards for other camera orientations function in a similar 
manner. Follow the camera wizard’s step-by-step instructions to complete 
the auto-calibration for a multi-camera system. 
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Dimensioning Wizard 
 

 

This wizard is used to verify the AV6010 auto calibration for dimensioning. 
 

    

 Prerequisites: You will need the following: 

 All previous wizard calibrations must be completed 

 Need the ASIDIM and ASICAL boxes 

 Laptop with Install Wizard connected to camera system 

 

To run the Dimensioning wizard: 

1. Click the Dimensioning Wizard button. 

2. Turn on the conveyor. 

3. Run the ASIDIM box through the system. 

4. If the ASIDIM box is properly dimensioned by the system, calibration is 
not needed. 

5. If the ASIDIM box is not properly measured, the system changes to a 
‘NOT READY’ mode.  

6. In order to correct this, the ASICAL box must be run to calibrate the 
system. 

 

 

See also: Dimensioning Setup and Calibration and Appendix G. 
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Dynamic Focus Calibration 

Before beginning normal operations, the cameras need to be dynamically 
focused.  
 

 Prerequisites:  

 All cameras have been setup using the AV6010 Install Wizard 

 Laptop must be connected to a camera’s IMAGE port 
      (see Connecting to the IMAGE Network) 

 AV6010 User Interface and Camera Image Viewer  
      should both be open on the laptop’s desktop 

 

Tools Required:  

 Camera Image Viewer   (AV6010_Realtime_Viewer.exe icon) 
      (Available as a download on the Diagnostics > Tools page) 

 Dynamic Focus Target attached to a calibration box 
      (Available as a download on the Diagnostics > Tools page)  

 AV6010 User Interface 

 
 

 

 

 

 

IMPORTANT: Dynamic camera setup should be performed by a trained 
and authorized Accu-Sort technician. They will verify normal operations and 
make calibration adjustments as necessary. This procedure is for reference 
purposes only. 

For further information on training, contact us at 1-800-BAR-CODE. 
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To dynamically focus a camera: 

1. Open the Camera Image Viewer. 

2. In the View Menu, enable Show Extra Info, Plot FocusRange and 
Package Corner. 

3. In the IDS Menu, be sure it is Enabled.  

4. Also enable Delete Image After Display. When the box is run through 
the system again, the new image automatically replaces the previous 
image.  

5. Select the Camera IP for the unit to be dynamically focused.  
Click Enable. 

6. Start the conveyor. 

7. In the AV6010 User Interface, go to Diagnostics > System Status. 
Confirm the Device Status is OK and the Belt Speed is shown in FPM. 

8. Make sure the Dynamic Focus Target is on the side of the calibration 
box that faces the camera to be focused. Run the box past the camera.  

9. On Diagnostics > System Status, confirm the Package Count is 
incremented by one.  

10. Go to Diagnostics > Images.  
Confirm that there is an image displayed. 

11. Go to the Camera Image Viewer to view the captured image of the box.  
(Reference the examples of both ‘good’ and ‘bad’ focus.) Depending on 
your results, adjustments may be required.  

12. Confirm and adjust the Distance to Trigger, if needed. 

13. Confirm and adjust the Camera Pitch Angle, if needed. 

14. Adjust the Image Gain, if needed. 

15. Adjust the LPI, if needed. 

16. Adjust the Focus Mounting Height as needed. 

17. Check the Camera Yaw. 

18. Check the Camera Offset. 
19. Repeat this process for each camera in the system. 

 
 

  
Good Focus Bad Focus 
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Side-by-Side Package Detection Setup 
 

Prerequisites: 
 Top Camera (mounted at +15 degrees or less) 
 Software versions (AV6010 Camera v6.0 and RangeFinder v8.0) 
 System has been properly setup with Install Wizard 
 Confirm all application parameters are correctly entered in the AV6010 

user interface (e.g., min and max box sizes)  
 Image cropping lines properly set during initial camera setup 

 
Tools and Materials Required: 
 Connection to a camera in the system using SBS 
 Camera Image Viewer (version 6.0 or newer) 
 Sample packages to create side-by-side conditions 

  

 
Getting Started 

1. Establish a connection with the top camera and open the AV6010 user 
interface. (In a multi-camera system, this connection can be established with 
any camera via the IMAGE network. See Connecting to the IMAGE 
Network.) 

 

 

IMPORTANT: Do NOT connect to the SYNC network. 
 

2. Select Setup > Options > Side-by-Side > Settings from the menu tree.  
The Side-by-Side window is displayed. 
 

3.  Under Side-by-Side Licensing, set Side-by-Side Camera to Top. 
(Currently, only the top-read camera can be licensed for SBS.) 
 

 

IMPORTANT: The system can be licensed before or after setup and 
calibration is complete. A license key must be obtained, entered and 
verified before SBS can be used for normal operations. An Accu-Sort 
trained and authorized technician must obtain the key and register an 
AV6010 for SBS. For additional information, contact Accu-Sort at 1-800-
BAR-CODE. 
 

4. To calibrate the system prior to licensing, use the Test Mode. (This mode is 
limited to 500 triggers.) This can be selected from the Side-by-Side Enabled 
drop-down list.  
 

5. Click Update.  
 

6. Go to Setup > Options > Side-by-Side > Ignore Codes in the menu tree. 
 

7. Define any ‘match codes’ that the system should ignore even if a side-by-
side (SBS) condition is identified. 

 
8. Click Update. 

 
 
 
 



AccuVision® AV6010 Long-Range Camera System Manual Chapter 5 105 
  

05-AV6010_Setup_R10.doc Accu-Sort Systems, Inc. 

Setup Camera Image Viewer 
1. Launch the Camera Image Viewer.  

(To perform SBS setup, version 6.0 is required.) 
 

2. In the View drop-down menu, select both Show Extra Information and 
View SBS Information. 
 

3. Set the Cam IP to match the IMAGE port IP address of the top-read 
AV6010 camera. 
 

4. Set the IDS IP to match the IP address of your laptop. 
 

5. In the IDS drop-down menu, confirm that Enabled is checked and that 
Delete Image After Viewing is NOT checked. This allows images to be 
saved to the laptop. 

 
6. Click the Enable VisionCapture button at the top right-hand of the 

viewer. 
 

7. Go to the Tools drop-down menu and enable Side-by-Side Detection. 
 
8. Confirm Down Sample is set to 16. 

 
9. On the viewer’s Side-by-Side Setup tab, click the Read Parameters 

from Camera button. This gets the current parameters from the camera. 
 

10.  Select the transport type. (See Setup for Transport Type.) 
 

11. Confirm that the following are enabled (checked): 
 

 Post Process Displayed Images 
 Crop Images to Image Valid 

 
12. Continue SBS setup with Capture Images. 
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Setup for Transport Type 

 
To set SBS to work with Belt Conveyors: 

1. Select the Setup tab in the Image Viewer. 

2. Select Black Conveyor Belt from the drop-down menu. 

3. Select the Calibration tab. 

4. Confirm Use Step-by-Step Tutorial checked. 

5. Click the Enable Calibration button. 

6. Follow the tutorial steps provided in the Image Viewer to set the Image 
Left/Right Limits:  

 Set Maximum Left Pixels. 

 Set Maximum Right Pixels. 

7. After setting the transport type, continue with Capture Images.  
 

 
To set SBS to work with Tilt-Tray Conveyors: 

1. Select the Setup tab in the Image Viewer. 

2. Select Light Colored Tilt-Tray from the drop-down menu. 

3. Select the Calibration tab. 

4. Confirm Use Step-by-Step Tutorial checked. 

5. Click the Enable Calibration button. 

6. Follow the tutorial steps provided in the Image Viewer to set the 
following:  

 Image Left/Right Limits  
 Tray Dimensions 
 Tray Bolt Filter 
 Misc Object Filter 

7. After setting the transport type, continue with Capture Images.  



AccuVision® AV6010 Long-Range Camera System Manual Chapter 5 107 
  

05-AV6010_Setup_R10.doc Accu-Sort Systems, Inc. 

Capture Images 
 

 

IMPORTANT: The objective is to collect images for a representative 
sample of the live freight running through the system. This sampling should 
include a full variety of packages representing typical product flow. Be sure 
this includes collecting images of SBS conditions. If enough of these occur 
during normal operation, that should be sufficient. If not, it may be 
necessary to create some artificial conditions and save the images. 
 

1. Run at least 200 singulated boxes through the system.  
 

2. As images are captured, they appear as a list of filenames below the 
three tab-sections on the left-hand side of the Viewer.   
 

3. If there are known SBS conditions that occur, assure they’ll occur during 
the test run or create some sample SBS test conditions. 
 

4. Run the sample SBS test conditions through the system, if any. 
  

5. Once enough packages have run through the system, click Disable 
VisionCapture to disable the image capture mode. 
 

6. Continue with Evaluate Images. 
 

Evaluate Images 
  

1. Go to the Image Viewer’s SBS Detection tab. 
 

2. Confirm the first image filename listed in the viewer is selected. 
 

3. Click Label Images (AUTO Mode) button. 
 

4. In the Label Image pop-up dialog box select either Single Object or 
Multiple Objects based on what is shown in the captured image. After 
reviewing an image, it is labeled as either: 
 
 MARKED: SINGLE PKG 
 MARKED: MULTI PKG 

 
5. Repeat the Label Image process for all captured images. 

(Use the Previous Image button to go back one image and change the 
label, if needed.) 

 
NOTE: Use Label Current Image button to correct any mis-labeled images, 
one at a time. 
 
6. Click the Process Image and Calc Results button. 

 
7. The calculated results are displayed in the SBS Rate dialog box. 

(See Understanding the SBS Rate in Appendix B.) 
 

8. Continue with Optimize SBS Calibration. 
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Optimize SBS Calibration 
 

1. On the Detection tab, use the SBS Detection Sensitivity slider bar to 
adjust sensitivity higher by one. (Default is 3.) 
 

2. Click Process Images and Calculate Results.  
 

3. The SBS Rate dialog box appears. Make a note of the percentages. 
 

4. Adjust the slider again, only this time, lowering the sensitivity.  
 

5. Perform this procedure several times, raising and lowering the sensitivity 
while making a note of the SBS Rate percentages. 
 

6. Compare the SBS Rate of each adjustment and determine the sensitivity 
setting that is best for the application’s conditions (i.e., the highest possible 
percentage for the SBS Rate).  
 

7. Once the highest SBS Rate is set, click the Process Images and Set 
Parameters button.  
 

8. A Time Warning dialog box is displayed. This takes about three-seconds per 
image. Click Yes to allow the system to process images.  
 

9. A progress monitor is displayed. A Best Settings dialog box is displayed 
when the process is complete.   
 

10. Click the Save Parameters to Camera button.   
 

11. Setup is complete and the system is ready for normal operations.   
 

12. During normal operations, monitor the number of ‘false negatives’ and ‘false 
positives’ that occur. Depending on the application’s requirements and how 
SBS conditions are handled, it may be necessary to make adjustments to 
reduce the number of false negatives and false positives. 

 

 

NOTE:  In the AV6010 user interface, go to Diagnostics > System Status 
to view the SBS results.  
 
Perform this procedure seasonally if package flow and variations of 
package types vary. 
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Connecting to the IMAGE Network 

Before attempting to connect to a camera’s IMAGE port, you need to set the 
laptop computer’s static IP address as shown here. 

 

How to use a static IP address: 

1. Under Windows, go to the Start menu.  

2. Select Control Panel > Network Connections and click Network 
Connections.   

3. Click Local Area Connection. 

4. Click Internet Protocol. 

5. Click Properties. 

6. Verify the window appears as shown below.  
'Use the following IP address' should be selected. 

7. Enter the following: 
IP address: 10.0.40.19            (default IP for IMAGE network) 
Subnet mask: 255.255.255.0 

8. Click OK. 

9. Connect the laptop to the IMAGE port of a camera. 

 

 
Setting a Static IP address to access IMAGE network 
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Download Camera Image Viewer 
To download and install the Camera Image Viewer: 
 
1. Establish a connection with the AV6010 user interface. 

 
2. Go to Diagnostics > Tools in the menu tree.  

The Tools screen is displayed. 
 

3.  Under Downloads, click the Utilities and Documentation link. 
 

4. Select the ImageViewer.zip. 
 

5. Open the zip file and copy the Image Viewer into a separate folder. 
 

 

IMPORTANT: To perform side-by-side package detection setup with the 
Image Viewer, version 6.0 or newer is required. 
 

View / Load Parameter Files 

Use this diagnostics tool to: 

 View the XML parameter file 

 Load an XML parameter file to the camera system from a laptop 
computer 

 Save a backup copy of the XML parameter file to a laptop computer.  
 

 
 

 

 

S
Set Passwords 

As part of the initial system setup, it is recommended that you change the 
Setup and Monitor passwords from the Accu-Sort defaults.  

For details, see Diagnostics > Tools in Chapter 8. 

 

Update Software 

If it becomes necessary to update your AV6010 software, this can be done 
using the Load Image or Load Patch functions.  
 

 

CAUTION: Do not use the update software functions unless it is 
recommended to do so by Accu-Sort technical support. 

For details, see Diagnostics > Tools in Chapter 8. 

 

 

 

NOTE: After completing the initial system setup, it is recommended that a 
copy of the XML parameters file be saved for future reference. This is 
especially useful for single camera installations. 

For details, see Diagnostics > Tools in Chapter 8. 
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6 Operations 
 
This chapter provides details on how the AV6010 Long-Range Camera 
System functions during normal operation. It also outlines how you can verify 
optimal performance through several methods: 

 Become more familiar with your application 

 Step-by-step start-up operations checklist 

 Status Indicator LEDs 

 AV6010 Camera 

 RangeFinder 

 Diagnostics / monitoring to confirm normal operations 

After configuring your system using the AV6010 setup wizard and browser-
based setup application, use the operations checklist to verify normal 
operations. 
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AV6010 Startup 

1. To start the AV6010, make sure it is connected to the power source and 
apply power using the power switch. In multi-camera applications, power 
may be controlled through the Power Distribution Box (PDB). 

2. On initial power-up, the AV6010 performs an initialization sequence.  

3. The PWR LED flashes and turns a steady green, followed by TRIG 
(green) and TACH (amber). At the same time, the AV6010 illumination 
will turn on and remain on for approximately 30 seconds, then turn off. 

4. The AV6010 automatically starts all application programs required during 
operations.  

5. After a few minutes, the illumination flashes ON then OFF.  
The entire system is ready for operation in approximately five minutes. 

6. The STAT LED is solid green to indicate normal operation.  

 

 
 
 

 

NOTE: All programs are automatically started when AV6010 is started or 
rebooted. To ensure everything is properly loaded and executed, the best 
way is to reboot your system. 
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To quickly check the operation of an AV6010 system: 

1. Confirm properly completed installation as outlined in Chapters 3 and 4. 

2. Apply power to the AV6010 and follow the startup procedure. 

3. Connect a computer to your camera system. 

4. Use the Monitor user ID and password to enter the AV6010 user 
interface. 

5. Run product through the scanning area. 

6. Use Diagnostics > System Status to check the operation of your 
system. 

7. Use the links in the Device column to individually check the 
RangeFinder and cameras (identified by position). 

 

 
 

 

NOTE: See Chapter 5 of the manual for details on setup.  
Details on the Diagnostics are provided in Chapter 8.  
A list of the error codes is provided in Appendix F. 
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AV6010 Camera Status Indicators 

Several status indicators are located on the DCM interface panel. 

  
 

Status Indicators – Normal Operations 
Indicator Description 

STAT Solid Green - System okay 
Solid Red - Error 
Blinking Red - Recoverable error (e.g., not all cameras responding) 

  

TRIG Indicates the camera system is receiving the TRIGGER signal.  This 
is regardless of trigger mode (i.e., not just tied to a photoeye input). It 
is active when the camera is acquiring images. 

  

TACH Blinks when tachometer is active.   
Rate is sub-sampled from actual tach (every 2000 pulses). 

  

HOST Indicates TX and RX communications activity on HOST serial port. 
 

  

FOCUS Indicates TX and RX communications activity. 
(Used in Light Curtain mode.) 

  

PWR Power –   Lights and stays lit after power-up and application startup.  
 

  
 
NOTE: See Chapter 8 and Appendix F for details on fault conditions 
indicated by these LEDs. 
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LAN Communications Status Indicators 
 
 

 
 
                          1 Gigabit 
 
 

 
LAN LED Status Indicators (1 Gigabit) 

LED Color LED State Description 
Off LAN link is not established. Left Green 
On  LAN link is established. 

Right Orange On Modulates with data. 
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AV6010 Camera Control Panel Buttons 

Three buttons are located on the DCM interface panel. 

 
 

Button Description 

 

Upload 
 

 

Download 
 

 

Default – Push and hold "Up" and "Down" buttons 
simultaneously.  STAT LED will start blinking rapidly while the 
buttons are being held.  When it STOPS blinking (about 5 
seconds), release the buttons and the AV6010 will set its 
parameters to default.  
IMPORTANT: Before you default the unit, save a copy of the 
current XML parameters file.  
 

 

Retrieve – Press and hold for a few seconds.  STAT LED will 
start blinking rapidly while the button is being held.  When it 
stops blinking (about 3 seconds), release the button and the 
AV6010 will attempt to retrieve parameters from the other 
cameras.  
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AV6010 RangeFinder Status Indicators 

Several status indicators are located on the RangeFinder interface panel. 

 

  
 
RangeFinder Status Indicators – Normal Operations 

Indicator Description 

 

Check Status of RangeFinder.  
System Ok             (Green LED solid ‘ON’) 
System Standby    (Green LED blinking) 
 
Standby condition indicates the conveyor has stopped or 
there is no tach input. 

  

 

Fault Status of RangeFinder.  
Warning    (Red LED blinking = recoverable fault) 

Error          (Red LED solid ‘ON = non-recoverable fault) 
 

  

During normal operation (tach input with conveyor running), 
these LEDs will ALL illuminate when a package is present under 
the RangeFinder. 
 
During installation (with no tach input) these LEDs function as a 
leveling indicator. When the center LED is on, the RangeFinder 
is level. 
 

  
 
NOTE: See Chapter 8 and Appendix F for details on fault conditions 
indicated by these LEDs. 
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Checking Operations 

AV6010’s browser-based interface enables you to evaluate the operational 
performance of your AV6010 long-range camera system by providing vital 
statistics via status indicators, real-time read quality monitoring, and 
additional information. Outgoing and incoming messages are also monitored.  

 

 
Diagnostics Menu Tree of AV6010 Browser-based Application 
 

 
Diagnostics > Camera Status Screen 
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Dimensioning Operations 

During normal operations, if your AV6010 Camera System is also equipped 
to perform dimensioning, there are several functions that can be useful to 
monitor system status and check dimensioning data, including:  

 Daily verification 

 Viewing measurement data 

 Dimensioning status 

 Viewing long term storage 

 

 

To verify the dimensioning system is calibrated: 

It is recommended to perform dimensioning verification once per day (or 
once per shift). This requires a box of known dimensions and the 
Dimensioning Wizard. (See Dimensioning Wizard procedure in Chapter 5.) 

 

 

To view measurement data: 

1. Login as a Monitor user.  

2. Go to Diagnostics > System Status. 

3. The measurement data is shown in the scrollable part of the screen. 
(Reference the Bar Code or Dimensions (LxWxH) column.) 

4. This data can also be viewed in the Diagnostics > Camera Status and 
Diagnostics > Camera Image screens. 

 

 

To check the dimensioning status: 

1. Login as a Monitor user.  

2. Go to Diagnostics > Top > Camera Status. 

3. Under the Error Codes, you will see one of two message: 
 
a.    the 4026 code indicates that dimensioning is ready.  

b. 4025 Error: Dimensioning NOT Ready, is displayed, use the ‘verify 
dimensioning’ process to check the system. 

 

All the system error codes are listed in Appendix F. 
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To view the Audit Trail Log: 

1. Login as a Monitor user.  

2. Go to Diagnostics > Top > Logging. 

3. Select Audit Trail Log and AATM Options. 
Remember: Times are GMT. 

4. Click Get Updated Log File. 

5. Log file is displayed in the scrollable section of the screen. 

 

 

To view the Alibi Storage Log: 

6. Login as a Monitor user.  

7. Go to Diagnostics > Top > Logging. 

8. Select Alibi Storage Log and AATM Options. 
Remember: Times are GMT. 

9. Click Get Updated Log File. 

10. Log file is displayed in the scrollable section of the screen. 
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Side-by-Side Package Detection Operations 

Once the system is properly configured for SBS package detection, it can be 
monitored from the Diagnostics > System Monitor.  
Seasonal changes in product flow may require calibration of additional SBS 
conditions. See the procedures in Chapter 5 for details on capturing images 
and evaluating/optimizing new SBS conditions using the Camera Image 
Viewer. 
See also: Setup > Options > Side-by-Side and Camera Image Viewer in 
Appendix B. 
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Notes: 
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7 Maintenance 
 

This chapter provides instructions for maintaining optimum performance and 
life for your AV6010 Long-Range Camera System. It provides specific 
information on: 

 Maintenance Procedures 

 Exterior Cleaning 

 Mounting Hardware Checks 

 Wiring Connection Checks 

 

 

Maintenance Tools and Materials Needed 
 

Item Description 
Soft-bristle 
brush  

For removing accumulated dust/dirt from the camera’s exterior 

Clean soft 
cloths 

For more detailed cleaning of the camera’s exterior  
(used in combination with mild detergent cleaning solution) 

Mild detergent solution for cleaning the camera’s exterior. Cleaning 
solutions 

70% denatured alcohol, 30% de-ionized water solution for 
cleaning the camera’s illumination exit window 

Soft cotton 
swabs or lint-
free cloth 

Use to clean camera’s illumination exit window 

 

 

Recommended Maintenance Frequency 
The AV6010 Long-Range Camera System is designed for industrial 
environments. The recommended frequency for performing these 
maintenance tasks will depend on the application’s environment. In general, 
these procedures are recommended only if it is noticed that the environment 
is dirty enough that deposits are appearing on the equipment or when 
performance is degraded by accumulation of dust or dirt on the exit windows 
or mirrors. By monitoring normal operations and performing weekly visual 
checks, you can establish a maintenance schedule that fits your application. 
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Maintenance Tasks 

Perform the maintenance tasks on an “as needed” basis to assure proper 
operation of the camera.  

Task schedule frequency depends upon the application environment 
conditions. Harsh environments that expose the equipment to more heat, 
dust, and dirt will require these procedures be performed more frequently.  

It only requires a few minutes to complete each maintenance task. 
 

 

Exterior Cleaning 

 

WARNING: Shut down the AV6010 Camera System before performing 
this maintenance task.  

 

CAUTION: Do not use any chemical on the camera that is unsafe for 
plastics, such as benzene, acetone, or similar products. Do not use 
compressed air because it usually contains oil or water. 

 

The exterior cleaning procedure may be performed without removing the 
device from the mounting structure. 

1. Switch off the conveyor. 

2. Switch off the camera system. 

3. Clean the exterior with a clean, soft-bristle brush. 

4. Carefully remove any dirt or debris in or around the connector panel and 
cooling fans. 

5. Wipe the exterior with a clean, soft cloth dampened slightly with a mild 
detergent solution. 

 

 



AccuVision® AV6010 Long-Range Camera System Manual Chapter 7 125 
  

07-AV6010_Maintenance_R10.doc Accu-Sort Systems, Inc. 

Cleaning the Camera Window 

 

WARNING: Shut down the camera system before performing this 
maintenance task. Do not stare into the camera’s window at the LED light. 
Avoid direct eye exposure. The LED light level does not constitute a health 
hazard, however staring at the LED light for prolonged periods could result 
in eye damage. 

 

 

CAUTION: Never apply cleaning solution directly to the camera window. 
Always apply the solution to a cloth, and then the cloth to the window. Do 
not use any chemical on the camera that is unsafe for plastics, such as 
benzene, acetone, or similar products. 

 

This procedure is recommended only if it is noticed that the environment is 
dirty enough that deposits are appearing on the folding mirrors. The exit 
window cleaning procedure should be performed without removing the 
camera from the mounting structure. 

1. Switch off the conveyor. 

2. Switch off the camera system. 

3. Follow the exterior cleaning procedure before cleaning the exit window. 

4. Check the exit window surface for any dust, dirt, or smudges. If the 
window needs to be cleaned, proceed to Step 5. 

5. Make a solution of seven parts denatured alcohol and three parts water. 
(Many over-the-counter solutions will leave deposits/smudges that can 
affect performance.) 

6. Apply the cleaning solution to a lint-free cotton cloth. 

7. Apply the cloth with cleaning solution to the exit window. 

8. Remove any streaks or remaining moisture from the exit window with a 
dry, soft, lint-free cloth or lens paper. 

9. Verify camera operation. Follow the Operations Checklist procedure in 
Chapter 6. 
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Cleaning the Folding Mirror 

 

WARNING: Shut down the camera system before performing this 
maintenance task. Do not stare into the camera’s window at the LED light. 
Avoid direct eye exposure. The LED light level does not constitute a health 
hazard, however staring at the LED light for prolonged periods could result 
in eye damage. 

 

CAUTION: Use care when cleaning the mirror to assure that the 
alignment with the camera is not altered. Never apply cleaning solution 
directly to the mirror. Always apply the solution to a cloth, and then the cloth 
to the mirror. It is a good habit to pre-mark the mirror position, so if it does 
move it can be returned to the original position. 
 

This procedure is recommended only if it is noticed that the environment is 
dirty enough that deposits are appearing on the folding mirrors. The cleaning 
procedure should be performed without removing the mirror from the 
mounting structure. 

1. Switch off the conveyor. 

2. Switch off the camera system. 

3. Review the exterior cleaning procedure before cleaning the folding 
mirror. 

4. Check the folding mirror for any dust, dirt, or smudges.  
If the mirror needs to be cleaned, proceed to Step 5. 

5. Use a dry, soft, lint-free cloth to remove accumulated dust. 

6. If the mirror is particularly dirty or smudged, make a solution of seven 
parts denatured alcohol and three parts water. (Many over-the-counter 
solutions will leave deposits/smudges that can affect performance.) 

7. Apply the cleaning solution to a lint-free cloth. 

8. Apply the cloth with the cleaning solution to the folding mirror. 

9. Remove any streaks or remaining moisture from the folding mirror with a 
dry, soft, lint-free cloth or lens paper. 

10. Verify camera operation. Follow the Operations Checklist procedure in 
Chapter 6. 
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Cleaning the RangeFinder Windows 

 

WARNING: Shut down the camera system before performing this 
maintenance task. Do not stare into the RangeFinder’s laser exit windows. 
Avoid direct eye exposure. The laser light level does not constitute a health 
hazard, however staring at the laser light for prolonged periods could result 
in eye damage. 

 

CAUTION: Use care when cleaning the RangeFinder to assure the 
windows are not scratched or damaged in any way. Never apply cleaning 
solution directly to the windows. Always apply the solution to a cloth, and 
then the cloth to the windows.  

This procedure is recommended only if it is noticed that the environment is 
dirty enough that deposits are appearing on the RangeFinder windows. The 
cleaning procedure should be performed without removing the RangeFinder 
from the mounting structure. 

1. Switch off the conveyor. 

2. Switch off the camera system. 

3. Review the exterior cleaning procedure before cleaning the three 
windows. 

4. Check the windows for any dust, dirt, or smudges. If the window needs 
to be cleaned, proceed to Step 5.  

5. Use a dry, soft, lint-free cloth to remove accumulated dust. 

6. If the windows are particularly dirty or smudged, make a solution of 
seven parts denatured alcohol and three parts water. (Many over-the-
counter solutions will leave deposits/smudges that can affect 
performance.) 

7. Apply the cleaning solution to a cotton swab or lint-free cloth. 

8. Apply the cleaning solution to the windows. 

9. Remove any streaks or remaining moisture with a dry, soft, lint-free cloth 
or lens paper. 

10. Verify RangeFinder operation. Follow the Operations Checklist 
procedure in Chapter 6. 
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Tighten Mounting Hardware  

The front-loading mounting hardware used to assemble the mounting 
structure and mount the equipment should not become lose if properly 
tightened. This is a safety check recommended for harsh environments 
where vibration may be a problem.  

1. Check all structure, camera, mirror and RangeFinder mounting 
hardware. Tighten as necessary. Do not over-tighten. Be sure not to 
disturb the alignment of the RangeFinder or any mirrors also mounted to 
the same structure. 

2. Check the mounting hardware of other devices. Tighten as necessary. 
Do not over-tighten. 

 

Checking Connections 

All wiring connections to the AV6010 Camera(s) and RangeFinder are made 
through the connector panels. This is a safety check recommended for harsh 
environments where vibration may be a problem. (Reference Chapter 4, 
Electrical Installation.) 

1. Check all wiring connections to the camera. Tighten as necessary.  
Do not over-tighten. 

2. Check all cabling for signs of wear/damage. Repair/replace any 
damaged cable connections as necessary.  

3. Check all cabling used with optional devices (e.g, monitor, keyboard, 
etc.) to assure they will function properly when they are needed. 

 

Verify Operation 

Follow the procedure defined in Chapter 6, Operations Checklist. 
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8 Troubleshooting 
 

This chapter provides instructions for diagnosing, troubleshooting and 
correcting AV6010 performance issues. It provides specific information on: 

 Status Indicators 

 Diagnostics 

 Troubleshooting (Problem/Cause/Solution) 

 

Reference the content of this chapter for details on the diagnostics, tools and 
logs available for the system including: 

 System Monitor 

 RangeFinder Monitor 

 Camera Monitor (one per camera in system) 

 Tools – View/Load Parameter File, Downloads, Set Passwords,  
Update Software  

 Logs – Error, Debug, Audit Trail, Alibi Storage 

 

 

CAUTION: Because of the complexity of the AccuVision AV6010 Long-
Range Camera System, it is recommended that training from Accu-Sort be 
considered before attempting to diagnose problems without the assistance 
of Accu-Sort technical support. As part of the troubleshooting and FRU 
replacement training, technicians receive additional information including 
the AV6010 Troubleshooting Matrix. 
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Camera Status Indicators: Fault Detection 

 

 

 

 

 

 

 
 

LED Description 

STAT Status of camera system. (See Error Codes, Appendix F.) 
 Warning    (Status Red LED blinking, recoverable error) 

 Error         (Status Red LED solid ‘ON’) 
 

TRIG 
 

Trigger – No LED activity means system is not being triggered.  

TACH Tachometer – LED not blinking means the tachometer is not active. If 
the conveyor is running, the tach is either improperly connected or 
the tach has failed. 
 

HOST Host Serial Communications (TX and RX activity) 
No LED activity means there is no data communications. 
 

FOCUS Focus Serial Communications  (TX and RX activity) 
No LED activity means there is no data communications. 
 

PWR Power for Camera 
 
If this LED is not lit, check:  
1. Is power switch in the “on” position? 
2. Is the camera properly connected to the power source? 
3. Is power being supplied from the power source?  
4. Possible power supply failure. 
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RangeFinder Status Indicators: Fault Detection 

 

 
 

 

 

 

 

  
 

LED Description 

 

Status of RangeFinder. (See Error Codes, Appendix F.) 
 Info    (Green LED blinking) 

 

 

Status of RangeFinder. (See Error Codes, Appendix F.) 
 Warning    (Red LED blinking) 

 Error         (Red LED solid ‘ON’) 

 

When facing the RangeFinder (with the ACCU-SORT silk-
screen to the right): 

 Laser 1 / DOE 1 (Right)   (Left-side of conveyor) 

 Laser 2 / DOE 2 (Left)     (Right-side of conveyor) 
 

 

During operations (tach input present / conveyor on), these LEDs 
should ALL light when a package is under the RangeFinder. If 
they do not light during the presence of a package, troubleshoot 
the RangeFinder. 
 
During installation (no tach input / conveyor off), this is a level 
indicator. Any LED that is lit other than the center LED indicates 
the RangeFinder is NOT level. Leveling procedure is provided in 
Chapter 5. 
 
 

 

 

Laser 2 / DOE 2 Laser 1 / DOE 1 



132 Troubleshooting AccuVision® AV6010 Long-Range Camera System Manual 
 

Accu-Sort Systems, Inc. 08-AV6010_Troubleshooting_R10.doc 

Diagnostics 
A skilled technician can also use the AV6010 user interface application to 
perform specific diagnostics functions. 

Use the Diagnostics available from the user interface to check the following: 

 System Status 

 Images 

 RangeFinder Status 

 Camera Status 

 Tools 

A list of the error codes mentioned on the status screen is provided in 
Appendix F. 
 

System Status 
Use the System Status screen to view diagnostics information on the entire 
AV6010 camera system. Every device connected to the SYNC network 
appears on this monitor screen. Under the Device column, there are 
clickable links that open a status page specific to the device.  
 

Images 
Use the Images screen to view the images from each camera in the system. 
For example, if your AV6010 application uses three cameras to read the top 
and sides of products, three image thumbnails will be displayed on this 
screen.  

 
 

 

 

RangeFinder Status 
Use the RangeFinder Status screen to view diagnostics information related 
specifically to RangeFinder operations. This information will identify such 
things as the box index number, height, and left/right position on the 
conveyor. 

 

Camera Status 
Use the Camera Status screen to view diagnostics information related 
specifically to a single camera’s operations including the box index number 
and the bar codes that were read by the camera.  

In multiple-camera systems, there is a camera status screen for every 
camera connected to the SYNC network. 

 

NOTE:  To view individual camera images, go to the Diagnostics > 
(Camera Position) > Image screen for the AV6010 you wish to monitor. 
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Diagnostics Tools 

View/Load Parameter File 
 
 

T
o
 To view and save the parameter file of the camera: 

1. Login to the AV6010 user interface as a Setup user. 

2. Select Diagnostics > Tools in the menu tree. 

3. In the View/Load Parameter Files section of the screen, click View 
Parameters Files. 

4. The camera system’s XML file is displayed in a new window. 
In a multi-camera system, this XML file contains all of the parameters for 
the RangeFinder and ALL cameras in the system. They can be easily 
viewed by scrolling up and down, as needed. 

5. To save the XML file to your computer, use File > Save As. 
The original file is automatically named leapfrog_configuration.xml. 
The file can be renamed, if needed. For example: In applications where 
multiple systems are used, you could name the file to identify the location 
(e.g., Tunnel1_configuration.xml, Tunnel2_configuration.xml, etc.).  

 

To load a parameter file to a camera: 

 

CAUTION: Loading a parameter file to a camera will result in the camera 
using the most recently loaded file. Be certain the file you load is the file you 
want to use and that you have a backup copy of the previously used 
parameter file in case you need to return to using it. 

 
1. Login to the AV6010 user interface as a Setup user. 

2. Select Diagnostics > Tools in the menu tree. 

3. In the View/Load Parameter Files section of the screen, click Browse.  

4. Locate the *_configuration.xml file that you wish to load to the system. 

5. Click on the file name and then click Open. 

6. Click Load Parameter File. 

7. Once the file is loaded, a small dialog box indicates ‘File successfully 
loaded’.  

8. There is no need to restart. The system automatically uses the most 
recently loaded parameter file. 

 

 

NOTE: After completing system setup, it is recommended that a copy of 
the XML parameters file be saved for future reference. This is especially 
useful for single camera installations. 
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Downloads 
 

To download the AV6010 Install Wizard: 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Click InstallWizard.zip in the Downloads section. 

4. In the File Download dialog box, click Save.  

5. Browse to where you want to save the ZIP file and click Save. 

6. Click Close when Download Complete appears. 

7. Locate and open the InstallWizard.zip file. 

8. Double-click the AV6010Setup_1.1.3.msi file.  
(This filename may be different depending on the version on your 
system.) 

9. Follow the instructions of the AV6010 Calibration Software Setup 
Wizard to complete the installation. If a version of the Install Wizard has 
already been installed, you’ll be given the choice to Repair or Remove.  

10. Once completed successfully, the AV6010 Install Wizard icon appears 
on your computer desktop. 

(For more information, see AV6010 Install Wizard in Chapter 5, Setup.) 

 

To download and print the Camera Scan Line Target: 

Note: This is used with the Camera Install Wizards. 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Click CameraScanLineTarget.pdf. The PDF opens in a new window. 

4. To save a copy to your computer, use File > Save As. 

5. When printing the camera scan line target, make sure you set the scaling 
(page scaling) to None. 

(For more information, see AV6010 Install Wizard in Chapter 5, Setup.) 

 

To download and print the Static Focus Target:  

Note: This is used with the Camera Install Wizards. 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Click StaticFocusTarget.pdf. The PDF opens in a new window. 

4. To save a copy to your computer, use File > Save As. 

5. When printing the static focus target, make sure you set the scaling 
(page scaling) to None. 

(For more information, see AV6010 Install Wizard in Chapter 5, Setup.) 
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To download the Image Viewer: 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Click ImageViewer.zip. 

4. In the File Download dialog box, click Save.  

5. Browse to where you want to save the ZIP file and click Save. 

6. Click Close when Download Complete appears. 

7. Locate and open the ImageViewer.zip file. 

8. Double-click the AV6010_Realtime_Viewer.exe file to open the Image 
Viewer window. 

(For more information, see Image Viewer later in this chapter.) 

 

 

To download and print the Dynamic Focus Target:  

Note: This is used with the Camera Image Viewer. 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Click DynamicFocusTarget.pdf. The PDF opens in a new window. 

4. To save a copy to your computer, use File > Save As. 

5. When printing the dynamic focus target, make sure you set the scaling 
(page scaling) to None. 

(For more information, see Dynamic Focus Calibration in Chapter 5, Setup.) 

 

 

To download the Diagnostics Tools: 

1. Click DiagTools.zip. 

2. In the File Download dialog box, click Save.  

3. Browse to where you want to save the ZIP file and click Save. 

4. Click Close when Download Complete appears. 

5. Locate and open the DiagTools.zip file. 

6. Save the files from the zip folder so that you can locate the tools later 
when you need them. There are three tools: 

 Camera Image Viewer (Camera OScope) 

 Codeword Viewer 

 Ranger OScope 

7. Double-click any of the *.exe files to open any of the tools. 

(For more information on the Diagnostics Tools, see the details provided 
later in this chapter.) 
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Set Passwords 
To set new passwords: 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Under the Set Passwords section of the screen, enter a new Setup 
Password and Monitor Password. 

4. Click Set Passwords. The new passwords will be required at the next 
login. 

 

Update Software 
 

 

IMPORTANT: This procedure is for all camera systems using software 
version 4.x or greater. If you need to download and older version of 
software, contact Accu-Sort Technical Support at 1-800-BAR-CODE. 

Software installation will take a few minutes. During installation, the 
camera’s STAT LED cycles through red, green, and amber and then off. Do 
NOT reboot or remove power from the camera. When installation is 
complete, the camera will reboot automatically. 

 

To load the complete software image: 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Under the Update Software section of the screen, click Load Image. 
(Accept the certificate, if prompted to do so.) 

4. In the Software Upload Utility, click Select File.  

5. Select the new AV6010 image file to upload (e.g., leapfrog_cflash.tar.gz). 
The file is sent (FTP) to the camera. A progress bar is displayed during 
the upload. 

6. The camera reboots automatically when the update is complete. 

 

To load a software update patch: 

1. Login to the AV6010 user interface. 

2. Select Diagnostics > Tools in the menu tree. 

3. Under the Update Software section of the screen, click Load Patch. 
(Accept the certificate, if prompted to do so.) 

4. In the Software Upload Utility, click Select File.  

5. Select the patch file to upload (e.g., leapfrog_update.tar.gz). The file is 
sent (FTP) to the camera. A progress bar is displayed during the upload. 

6. The camera reboots automatically when the update is complete. 
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AV6010 Image Viewer 
The AV6010 Image Viewer is a real-time application tool for viewing the 
camera sensor data. (Remember, AV6010 uses a high-speed linear sensor, 
it does not ‘take a picture’ like a typical camera.) This tool allows you to view 
what the sensor is currently seeing. It also displays any embedded data for 
diagnostic and set up purposes. 

 

CAUTION:  The AV6010 Image Viewer is for setup and diagnostic 
purposes only. It should not be allowed to remain running while a camera 
system is under normal operating conditions as it changes the line rate and 
turns on the illumination to capture the sensor data. 

 

 
 

 

NOTE: The AV6010 Image Viewer is not an image storage application. If 
image storage and retrieval are needed, the VisionCapture/IDS (Image 
Depot Server) System is an option available from Accu-Sort. 
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RangeFinder Codewords Viewer 

 
 
[ Details not available at time of publication. ] 
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RangerFinder O-Scope 

 
 
[ Details not available at time of publication. ] 
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Troubleshooting 

The PCS (problem/cause/solution) tables assist you in troubleshooting the 
more common events that may occur during operation. There are several 
error codes that are displayed in the Diagnostics > Status screens that can 
be used to determine possible problems. 

These tables provide examples of using the error codes listed in Appendix F 
for PCS troubleshooting. Technicians that complete the AV6010 
troubleshooting and field replaceable unit (FRU) replacement training 
program should also reference the AV6010 Troubleshooting Matrix. 

Reference Chapter 9 for the location of FRUs. A guide is sent with every 
FRU to make component replacement easy. 
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Error Code Problem Cause(s) Solution(s) 

    
Cannot establish connection to camera / user interface 

-- During initial setup, after 
connecting to the camera 
SYNC, IP address 192.168.0.50 
not shown. User interface Log 
In not displayed. 

TACH may not be properly 
connected. (POWER LED lit, 
STATUS LED not lit.) 

Confirm the TACH cable is properly 
connected. If the TACH connection 
was wired on site, confirm against 
drawing 111515 in Appendix H. 

    
Cooling Fan Failures 

3047 Error: Right side fan 
disconnected or failed 

Confirm connection of fan module 
to transition board. 

If connected but not running, 
replace right-hand fan module. 
 

3048 Error: Left side fan 
disconnected or failed 

Confirm connection of fan module 
to transition board.  

If connected but not running, 
replace left-hand fan module. 
 

    
    

LED Board Failure 
5016 Error: Failure of LED Board 1  Check LED Board. If all other LED 

board are lit, LED Board 1 has 
failed. 

Replace LED Board 1. 

    
Tachometer Failure 

5031 Belt or tachometer stopped If belt is running when this error 
code is present, check tach 
operations. Possible tach failure. 

Replace tachometer. 

    
Laser Failure in RangeFinder 

6032 Laser 1 is off or blocked  
(no codewords) 

Check Laser 1. If Laser 1 is off 
and Laser 2 is on, RangeFinder 
failure. 

Replace RangeFinder. 

6033 Laser 2 is off or blocked  
(no codewords) 

Check Laser 2. If Laser 2 is off 
and Laser 1 is on, RangeFinder 
failure. 

Replace RangeFinder. 
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9 Service 
 

The AV6010 Camera System incorporates a number of field-replaceable 
units (FRUs) in order to minimize downtime. In most cases, components 
should be replaced with a matching recommended spare part (RSP).  

 
Service procedures are divided into two skill levels: 

� Customer technicians (with some training from Accu-Sort) 

� Accu-Sort Trained and Authorized Service Technicians only 

All AV6010 Camera accessories and options are considered customer 
technician field-replaceable units (FRUs). 

 

 

Replacement Procedures 

 
 

CAUTION: This symbol indicates you are about to perform an action 
involving, either a dangerous level of voltage, or to warn against an action 
that could result in damage to devices or electrical shock. Please follow 
necessary procedures as outlined in Chapter 2, Safety.  

 

 
 

ESD CAUTION: This symbol identifies a procedure that requires you take 
measures to prevent Electrostatic Discharge (ESD) e.g., use an ESD wrist 
strap. Circuit boards are most at risk. Please follow ESD procedures as 
outlined in Chapter 2, Safety.  

 

External Devices 

To replace any external devices, reference the installation procedures 
provided in Chapter 3 and Chapter 4. 

 

Field Replaceable Units (FRUs) 

Replacement procedures for internal field-replaceable units (FRUs) that may 
be performed by customer technicians are provided with the replacement 
part.  
 

 

CAUTION: Although someone with basic electromechanical / technical 
skills may perform the removal and replacement of the field replaceable 
units (FRUs), Accu-Sort training is recommended, especially where the 
AV6010 is used in certified dimensioning applications. Contact Customer 
Service at 1-800-BAR-CODE to schedule training that fits your needs.   
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AV6010 Camera Module   (Camera Head Side) 
Spares Recommended   

FRU Guide 

 

Spare Part # 

 

Replacement Part Descriptions 
   # of Cameras    
              on Site  ► 1-10 11-30 31-50 

1000065953 AV6010 Exit Window  Short Illumination 30” [762.0 mm] model    n 
 

1000065769 

 1000065954 AV6010 Exit Window  Long Illumination 42” [1066.8 mm] model    

1000065956 Camera Head Module 69 MM, F/5.6  1 2 

1000068821 Camera Head Module 69 MM, F/8.0  1 2 

1000065957 Camera Head Module 90 MM, F/5.6  1 2 

1000065958 Camera Head Module 110 MM, F/5.6  1 2 

1000068228 Camera Head Module 110 MM, F/5.6 (short range)  1 2 

o 1000065770 

1000065959 Camera Head Module 140 MM, F/4.0  1 2 

p 1000065773 1000065964 Power Supply 28 VDC, for Illumination 1 1 1 

q 1000065776 1000065962 Power Supply 12 VDC, for DCM / Camera Head 1 1 1 

r 1000065780 1000065969 Fuse  5 5 5 

s 1000065981 1000065989 Transition Board     

1000068420 Distributed Computing 
Module (COM-e 1) 

DCM with Decoding 1 1 2 

1000069022 Distributed Computing 
Module (COM-e 1) 

DCM with Decoding 1 1 2 

1000065779 

1000068422 Distributed Computing 
Module (COM-e 1 & 2) 

Decoding and Dimensioning 1 1 2 

t 

 

NOTE: Other DCM FRUs are available that include the COM-e 3 module typically used for Raw Image Export (RIE) 
or PCI cards. These are customer-specific FRUs. The FRU part numbers for custom DCMs must be requested from 
your Accu-Sort Sales Representative or Customer Service. 

o p 

q 

n 

r 

t s 
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AV6010 Camera Module  (Exit Window Side) 
Spares Recommended  

FRU Guide Spare Part # Replacement Part Descriptions 
   # of Cameras  
              on Site  ► 1-10 11-30 31-50 

1000065965 Cooling Fan Left Module (with power switch) 1 1 2 u 1000065778 

1000065966 Cooling Fan Right Module 1 1 2 

v 1000065771 1000065960 Illumination Control Board Used in both 30 and 42-inch models 1 1 1 

1000065961 LED Illumination Board Short (use with 110 and 140mm lens)    w 1000065772 

1000065968 LED Illumination Board Tall  (use with 50, 69 and 90mm lens)    

 

 

 
NOTE: The AV6010 FRU Guides and “how to” videos are available. 

 
 

w

u 

v
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AV6010 RangeFinder Module    
Spares Recommended 

FRU Guide Spare Part # Replacement Part Descriptions 
# of RangeFinders  
               on Site  ► 1-10 11-20 21-30 

1000065774 1000065963 Power Supply For RangeFinder 1 2 3 

1000068394 RangeFinder 0.1” Accuracy for Dimensioning 1 2 3 

1000068395 RangeFinder 0.2” [5mm/10mm] Accuracy for Dimensioning 1 2 3 

1000068396 RangeFinder 0.5” [20 mm] Accuracy for Dimensioning 1 2 3 

1000065775 

1000068832 RangeFinder OIML Certified 5mm/10mm Accuracy for Dimensioning 1 2 3 

 

 

NOTE: Mounting brackets / power supply not included with RangeFinder FRUs. 

RangeFinders include an accuracy label to the right-side of the laser caution label.  
Be sure to match the RangeFinder accuracy for your application. 
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A Specifications 

 

AV6010 Camera System Technical Specifications 
                             Characteristic    Description 

Name AccuVision®  AV6010 Long Range Camera System 

Resolution 250 DPI 

Transport Speed (max.) Belt: 620 FPM [3.2 MPS] 

Size: Camera (w/Short Illum) H 11.15” [283 mm] x W 32.75” [832 mm] x L 15.31” [389 mm] 

Camera (w/Long Illum) H 11.15” [283 mm] x W 44.75” [1137 mm] x L 15.31” [389 mm] 

RangeFinder H 5.42“ [138 mm]  x W 3.25” [83 mm] x L 36.0” [915 mm] 

Weight 
Camera - Short Illum: 68.08 lbs [30.8 kg]          Long Illum 81.79 [37.1 kg] 
RangeFinder: 18.0 lbs [8.2 kg] 

Enclosure 
Camera: Rigid cast aluminum chassis with powder-coated aluminum access covers 
RangeFinder: Powder-coated extruded aluminum 

Temperature 
Operating: +32° to +122° F  [0° to +50° C] 
Storage: -4° to +158° F  [-20° to +70° C] 

Relative Humidity 10% - 90% non-condensing 

Illumination (Light Source) Camera: High intensity red LEDs (635 nm) 

 RangeFinder: Two visible red lasers (650 nm) 

Power Requirements 115/230 VAC, 50/60 Hz, 85-110% 

Power Consumption 450 VA max. for standard configuration; 800 VA max. with all options 

Visual Indicators (6 LEDs) Camera: STAT, TRIG, TACH, HOST, L/C, PWR     RangeFinder: 7 status LEDs 

Bar Code Types All standard 1D and 2D symbologies 

Connections Gigabit Ethernet TCP/IP (RJ45), Serial RS232/422 (9-pin ‘D’) 

Distributed Computing 
Module LynxOS on main processor, Linux OS on up to 3 Com Express modules 

Options 
Dimensioning, Raw Image Export (RIE) for OCR,  
Monitor and Keyboard with trackball 
VisionCapture (Image Depot Server / IDS), FAST Monitor 

Vibration Limit Camera and RangeFinder: 2G (10-500 Hz continuous) maximum 

Reliability > 75,000 hours MTBF @ 50° C 

Service Options Installation assistance and on-site training 

Warranty 1-year limited, parts and labor; available Blue Ribbon Extended Service (BRES) 

Compliances 
UL, cUL, CE, FCC (Class A), IEC-60825-1, 21CFR1040 
Certified Dimensioning Approvals: NCWM/NTEP, Measurement Canada,  
OIML R129  (see Appendix G) 

 
* Actual performance may vary with configuration and application. 
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Power Consumption Estimates 

 3-Camera Tunnel 4-Camera Tunnel 5-Camera Tunnel 6-Camera Tunnel 

Device Volt-amps 
Each Unit Qty. 

Extended
Volt-amps Qty. 

Extended
Volt-amps Qty. 

Extended 
Volt-amps Qty. 

Extended
Volt-amps 

AV6010 Camera System 
      42" [107 cm] 405 3 1215 4 1620  5 2025  6 2430  

AV6010 RangeFinder   23 1 23 1 23 1 23  1 23 

Network Switch   23  0   0  1 23   1 23  

VisionCapture / IDS 288  0   0  1 288  1 288 

LCD Monitor   87  0  0  1 87   1 87  

FAST Monitor 175  0  0   0  0 
 

Total Power Consumption (Volt-amperes)  1238  1643  2446  2851 
 

Single-phase current                  115 VAC  10.8  14.3  21.3  24.8 

                                                      230 VAC  5.4  7.1  10.6  12.4 

NOTE: Inrush current is approximately 15 times the running current.  

 

RangeFinder Dimensions 
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AV6010 Camera Dimensions 

 
 

Dimensions for the 30-inch camera shown. 

 

The differences for the 42-inch camera are 
shown below: 

Overall Length 45.25  [1149.4] 

Mounting Footprint 40.44  [1027.2] 
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Read Charts 

 

110 mm, F/5.6, 42", 0-15 deg
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110 mm, F/5.6, 42", 45 deg
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All customer applications are reviewed by Accu-Sort applications engineers to assure the best camera solution is specified for 
the application’s unique requirements including transport speed and symbologies being read. Above is a sample read chart for 
the 110 lens version of the camera. This read chart is intended for use as an example only. 
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Certifications 
 
UL Listing

 

 
UL Listed 
 
UL Listed to Canadian safety standards 
 
Standard to which conformity is declared:  
 
EN60950: Test Spec: IEC 60950 3RD Edition / (2000)  (Information 
Technology Equipment (I.T.E.), Including Electrical Business Equipment 
 

 

 

 
Standards to which conformity is declared:  
 
FCC  47 CFR, Part 15, subpart B, “Unintentional Radiators” 
 
AV6010 Camera:                                   AV6010 RangeFinder:  
CLASS A Radiated Emissions               CLASS A Radiated Emissions 
CLASS A Conducted Emissions            CLASS B Conducted Emissions 
 

 

   

 
Standards to which conformity is declared:  
 
1   Emissions 
 
EN 61000-6-4: 2001  
     CISPR 11:1999    Radiated Emissions – Class A 
     CISPR 11:1999    Conducted Emissions – Class A 
 
2   Immunity 
 
EN 61000-6-2: 2001   Electromagnetic Compatibility - Generic Standards - 
Immunity for industrial environments 
 
EN 61000-4-2:1995, Electromagnetic compatibility (EMC), Electrostatic 
discharge immunity test 
 
EN 61000-4-3: 2001, (EMC), Part 4 - Section 3: Radiated, radio-frequency 
electromagnetic field test  
 
EN 61000-4-4:2004, (EMC), Electrical fast transient/burst immunity test 
 
EN 61000-4-5:1995, (EMC), Part 4 - Section 5 Surge immunity test 
 
EN 61000-4-6:2003, (EMC), Part 4 - Section 6 Immunity to conducted 
disturbances, induced by radio-frequencies  
 
IEC 61000-4-11: 2003, (EMC), Part 4 - Section 11 Voltage dips, short 
interruptions & variations immunity  
 
IEC 61000-3-2 A14, 3/2000 and 61000-3-3: Harmonic current emissions 
Fluctuating and Steady State Harmonics) 
 

 
Certified 
Dimensioning 
 
 

 
The specifications and links to the certificates of conformity for AV6010 
Dimensioning Systems are provided at the end of Appendix G. 
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B AV6010 User Interface 
 

This appendix provides tables of parameter definitions and descriptions for 
each screen provided in the AV6010 User Interface. 

 

 
AV6010 User Interface Login Screen (current version 6.0) 
 

 
AV6010 User Interface Homepage 
 

 

IMPORTANT: Step-by-step procedures are provided in Chapter 5. 
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System Configuration 

 
Example from a single camera system with RangeFinder (software version 5.0) 

 

 
Example AV6010 Components Not Detected, Action drop-down list 
 

 
Example from a  multi-camera system (software version 3.x) 
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System Configuration Descriptions  
Selection Definition 

System Name – User definable name for system 
Number of Cameras – Identifies number of camera 
connections found 
RangeFinder included in System – Indicates whether or not 
a RangeFinder connection is found 
Measurement Units – English or Metric 

System Setup 

Software Upgrade Options –  
 
Enable Tunnel Upgrade – This will cause a software 
update to be 'propagated' to all cameras in a tunnel.  In 
other words, the user loads the software to one camera, and 
the other cameras will then detect the upgrade, retrieve the 
software from the upgraded camera, and upgrade 
themselves.  Unchecking this box, disables this feature.  
This is not normally desirable, but it can be if you just want 
to test new software on one camera.  It is also necessary if 
you are loading an older software version - which, by the 
way, must be done by loading the software to each camera. 
 
Only Allow Same Software ID – The software names now 
consist of two parts: a software ID (such as ASISTD) and 
the version number.  This checkbox tells the cameras to only 
retrieve software (or a newer revision) from another camera 
if the ID is the same.  This should normally be enabled.  This 
scenario this option prevents is one such as a DCM with a 
newer version of standard software being installed in a 
tunnel with custom software (based on an older standard).  
Without this option, the tunnel would upgrade itself 
automatically to the 'newer' standard software, which would 
be undesirable. 
 
MAC Address – Cameras unique MAC address 
Unit Type – Identifies whether the unit is a RangeFinder or 
camera 
IP Address – IP address provided by the DHCP AV6010 
Position (drop-down list) – Use to identify the camera 
position in a tunnel system 
Software ID; Version 

AV6010 
Components 
Detected 

Blink (button) – Use to blink the illumination of a camera to 
confirm location and operation 

Additional AV6010 
Components 
Detected 

New components to be added to the AV6010 system appear 
here. For example: During initial setup, all cameras and the 
RangeFinder are listed. If the RangeFinder or a camera 
DCM is ever replaced, they will also appear here. 
 
The Configure column offers button options:  
New or Replace. 
 

Update After making changes to either the System Name or camera 
Positions, click to Update. 

Reset After making changes to either the System Name or camera 
Positions, click to Reset to previously saved information. 
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Tachometer 

 
 
Setup > Tachometer Descriptions 

Selection Definition 
Source (drop-down list)  
 
External – Uses an external hardware tachometer, typically 
mounted under the conveyor belt. 
 

Tachometer 

Internal – Uses an internal software calculated tachometer. 
 
Resolution – Set the tachometer pulses per inch (from # to #) 
 

External 
Tachometer 

Scale Factor – Do not change.  
(Only used in dimensioning systems.) 

Internal 
Tachometer 

Belt Speed (feet/minute) 
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Focus and Detection 

 
Trigger by RangeFinder only 

 

RangeFinder Focus Options shown (when Trigger by RangeFinder) 

 

 
RangeFinder Focus Options shown (when Trigger by Photoeye) 

 

 
Trigger by RangeFinder using Photoeye, additional Photoeye settings shown 
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Setup > Focus and Detection Descriptions  
Selection Definition 

Minimum Package Size – Set the length, width and height of the 
minimum package size. Packages smaller than these dimensions will 
not be processed by the system 
 
Minimum Package Size – Set the length, width and height of the 
maximum package size. Packages larger than these dimensions will not 
be processed by the system 
 

Package Size and 
Spacing 

Minimum Package Spacing – Set the minimum space allowed between 
packages. 
 

Belt Width Conveyor Width – Set the width of the conveyor belt in inches. 
  
After making a selection from this drop-down list, click Update.  
 
Fixed Focus – Sets the cameras focus to a fixed distance from the 
camera’s lens. Bottom-read cameras default to the fixed focus setting. If 
setting any other camera for fixed focus, there are other settings that 
must be made.  
(See Mounting > Camera.) 
 
RangeFinder – The RangeFinder provides the focus information to the 
camera(s).  
 
RangeFinder Focus Options available when the RangeFinder is 
performing the package detection:  
Offset Front Focus for Skewed Box - If a box is skewed, this option 
provides a front-read camera with an ‘offset’ in the front of the box, so 
the focus does not start at the front corner.   
Offset Back Focus for Skewed Box - If a box is skewed, this option 
provides a back-read camera with an ‘offset’ in the back of the box, so 
the focus does not start at the front corner.   
 
RangeFinder Focus Options when a photoeye is used for package 
detection: 
PE Indicates Package is Present – This option should not be checked 
for tilt-tray applications. 
 
 

Focus 
Data Source 
(drop-down list) 

Light Curtain – The light curtain provides the focus information to the 
camera 
 
Trigger Source – These options change depending on the focus source 
 
Trigger by RangeFinder – RangeFinder provides the start/end of 
packages signal.  
 
Trigger by Photoeye – Photoeye input is used to determine the start/end 
of packages. 
 
Trigger by Rangefinder using Photoeye – In this case, the RangeFinder 
uses the Photoeye data combined with the ranging information to 
provide a continuous trigger for the package. 
 

Package Detection 
(Trigger) 
(drop-down list) 

Trigger by Bottom Camera PE –  Special case of 'Trigger by Photoeye' 
where the photoeye is connected to a bottom-read camera that is 
upstream from the Rangefinder. 
 
The photoeye settings are only displayed when a photoeye is involved 
with package detection. They are not displayed when the RangeFinder 
is the only trigger source. 
 
Debounce set in inches  
 

Photoeye Settings 

Active Low (checkbox)  
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Mounting > RangeFinder 
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Setup > Mounting > RangeFinder Descriptions  
Selection Definition 

Roll –The offset for leveling the RangeFinder with the scanning 
surface 
 

Mounting 
Angles 

Yaw (0 or 180) – The offset for identifying the RangeFinder 
mount as Standard or Non-Standard. (The Yaw should either be 
0 or 180.  The RangeFinder mounting should be changed to 
position it to the scanning surface) 
 
Dist from Photoeye (X) –(Optional)  This is the distance from 
the read now trigger source to the RangeFinder or light curtain 
 
Left/Right Offset (Y) –Compensates for the RangeFinder not 
being centered to the scanning surface. 
 

Mounting 
Position 

Mounting Height (Z) –Height that the RangeFinder is mounted 
off the scanning surface 
 
Left (-) – Identifies the usable area on left side of the 
RangeFinder.  This is referenced from the center of the 
RangeFinder. Any codewords that are beyond the dimension 
set in this field will be ignored. 
 

RangeFinder 
Ignore Limits 

Right (+) –Identifies the usable area on left side of the 
RangeFinder.  This is referenced from the center of the 
RangeFinder. Any codewords that are beyond the dimension 
set in this field will be ignored. 
 

 
RangeFinder 
Settings 

Minimum Separation for Side by Side Detect (in inches) - 
Identifies the separation between boxes that must be 
maintained in order to correctly identify a side by side condition. 
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Mounting > (Camera Orientation) 
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Setup > Mounting > (Camera Orientation) Descriptions  
Selection Definition 

Camera Pitch Angle – This is the angle of the camera mirror in 
relation to the product to be scanned. 
 

Mounting 
Angles 

Camera Yaw (0 to 180) – This is the position of the camera in 
relations to the direction of product flow.  The camera yaw 
affects the decoding of certain types of bar codes.  It also 
affects the orientation of the image in the image viewer.   
 
Dist. From Trigger (X) –This is the distance from the 
RangeFinder or light curtain to the AV6010 read area. 
 
Camera Offset (Y) – This option aligns the package to the 
software cropping area. Used with image cropping.  
(See Communications > (Camera) > Image Network.)   
 

Mounting 
Position 

Mounting Height (Z) – Defines the farthest distance a package 
will be seen by the AV6010.  
 
Front – Extends the trigger signal on the front of the box 
 

Tracking Box 
Extensions 

Back – Extends the trigger signal on the Back of the box 
 

 
A camera mounting screen is available for every camera connected to the 
system (e.g., front, top, back, sides, and bottom) as shown on the System 
Configuration screen. These parameters must be set individually for each 
camera in the system. 
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 Symbologies 

 
Example with three codes enabled (including filters). 

 

 
Example: ASI_Diagnostics and Dimensions should appear as enabled symbologies 
on dimensioning systems. These are enabled from the Code Type drop-down list. 
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Setup > Symbologies Descriptions  
Selection Definition 
Enabled Symbologies 
Selectable 
option 

When selected, use the Remove button to delete the symbology 
from the active list. 
 

Name User-defined identifier for the code type. 
 

Symbology  Identifies the type of bar code to be read by the camera 
 

Min. Length Minimum number of characters in the bar code 
 

Max. Length Maximum number of characters in the bar code 
 

Filter Used for bar code character recognition.  Only the bar code with 
the defined character will be considered a valid read. 
 

Min. Quantity Minimum number of bar codes to be read from the selected 
symbology 
 

Max. Quantity Maximum number of bar codes to be read from the selected 
symbology 
 

Remove 
(button) 

Use in combination with the selectable option to remove a code 
type from the active list of selected symbologies. 
 

Add Symbology 
Name  Define a specific name for the symbology. 

 
Select the symbology from the drop-list.  
All commonly used 1-D and 2-D symbologies are available.  
 
Other selections appear in this drop-down list:  
 
ASI Diagnostic – 
 
Aux Result 1 through Aux Result 4 –  
 

Code Type 

Dimensions – Select so that dimensioning data can be included 
in messages.  (Requires a dimensioning-enabled top read 
camera.) 
 

 
Min. Length thru Max. Quantity - See above 
 
Add  
(button) 

Use to add a new symbology to the Enabled Symbologies list. 

 
Set the symbologies once. The enabled symbologies list is used by all 
cameras in a system. 
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Communications > (Camera) > Transmit Point 

 
 

 
 
 

Selection Definition 
Select a mode from the drop-down list. 
 
Trailing Edge – Use the trailing edge of packages to start a 
counter when it leaves the trigger source. When the counter 
reaches zero, the host message is transmitted.  
 

Tracking Mode 
(drop-down list) 

Leading Edge – Use the leading edge of packages to start a 
counter when it ‘hits’ the trigger source. When the counter 
reaches zero, the host message is transmitted. 
 

Distance to 
Transmit Point  
 

Distance from the trigger source to when the host message is 
transmitted.  This distance is set in inches. 

 
Available for every camera connected to the system (e.g., front, top, back, 
sides, and bottom). The transmit point must be set individually for each 
camera in the system. 
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Communications > (Camera) > Serial Com 

 
  
 
Serial Com Descriptions 

Selection Definition 
Serial Port Settings 
Baud Rate Set from 1200 to 115,200. 
Stop Bits Set for 1 or 2. 

None 
Even 

Parity 

Odd 
Data Bits Set for 7 or 8. 

None 
Hardware 

Flow Control 

Software 
Serial Messaging 

None 
Standard Message – STX data LF 
(qty of data fields are determined on the number of bar codes 
enabled) 
Long Message – STX00000,XXXX,DATA,QQ,YYYLF 
STX – Header 
00000 – Sequence number 
XXXX – Box Length (in tach pulses) 
Data – Bar code data.   
       (qty of data fields are determined on the number of bar codes enabled) 
QQ – quality of reads 
YYY – camera head identifier 
LF – Trailer 
 
User Configured – This option provides a configurable menu for the 
customer to construct the host message format 
 

Transmit 
Message 
Type 

Custom Message –This message is hardcoded by software.  
 

Keep Alive 
Time (sec) 

This defines how often the AV6010 will transmit the heartbeat 
message  
 

Keep Alive 
Message 

This defines the content of the heartbeat message 

 
Available for every camera connected to the system (e.g., front, top, back, 
sides, bottom). 

 

 

 

 



AccuVision® AV6010 Long-Range Camera System Manual Appendix B 167 
  

A2-AV6010_User Interface_R10.doc Accu-Sort Systems, Inc. 

Communications > (Camera) > Host Network 

 
  
Host Network Descriptions 

Selection Definition 
Host Network Interface 
IP Address 
Assignment 
(drop-down list) 

Set as a Dynamic or Static IP. 

Host Network Connection (Functionality is identical for Host Network Ports 1 through 4.)  
TCP/IP Server – The AV6010 will function as the Ethernet server 
TCP/IP Client – The AV6010 will function as the Ethernet client 
UDP Messaging – The AV6010 message will be in the UDP format 
(User Datagram Protocol) 
Fast Monitor –The AV6010 will sent a message in the Fast Monitor 
format.  This is a diagnostic message. 

Connection Type 
(drop-down list) 
 

None 
Standard Message – STX data LF 
(qty of data fields are determined on the number of bar codes enabled) 
Long Message – STX00000,XXXX,DATA,QQ,YYYLF 
STX - Header 
00000 – Sequence number 
XXXX – Box Length (in tach pulses) 
Data – Bar code data   
 (qty of data fields are determined on the number of bar codes enabled) 
QQ – quality of reads 
YYY – camera head identifier 
LF – Trailer 
User Configured – This option provides a configurable menu for the 
customer to construct the host message format 

Message Format 
(drop-down list) 
 

Custom Message – This message is hardcoded by software. 
Port Number Set the port number. 
Keep Alive This is the heartbeat message timer.  It defines the timing in 

milliseconds on how often the keep alive message should be 
transmitted to the host. 

Keep Alive 
Message 

This is the heartbeat message.  The AV6010 will send this message to 
the host to identify that it is functioning even if product is not moving on 
the conveyor. 

 



168 AV6010 User Interface AccuVision® AV6010 Long-Range Camera System Manual 
 

Accu-Sort Systems, Inc. A2-AV6010_User Interface_R10.doc 

Communications > (Camera) > Host Network > Network Messaging 

 
 

Functionality is identical for Serial Ports and Host Network Ports 1 through 4. 

 
Host Network > Network Messaging Descriptions 

Selection Definition 
Message Settings 
Header Set the message header. 
Trailer Set the message trailer. 
Sequence Number Transmits a sequential number with each message 

transmitted when checked. 
CheckSum Transmits a calculated checksum providing a level of 

security for the message. 
One Message per Code Only includes one message per code when checked. 
Number of Fields This option defines the number of fields in the transmit 

message.  
Bar Code Separator Define the separator to appear between bar codes. 
Include QQ Includes the QQ which is the quality or number of times 

the AV6010 decoded the bar code during the trigger 
cycle. 
Provides the QQ Delimiter field when checked. 

Message Field 1 
No Read Message Customer selectable character that will be transmitted 

when no bar code was read 
Multi-Read Message Customer selectable character that will be transmitted 

when the AV6010 decodes bar codes with the same 
symbology and the same number of characters  

Bar Code Settings Select a Bar Code Name from the drop-list. (These are 
the codes that appear in the Active Symbologies list.) 
The padding, fixed length and stripping are shown in the 
fields. Use the option buttons to Add or Remove the 
code from Message Field 1. 

Message Field 2 
Note: Same functionality as Message Field 1. 
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Communications > (Camera) > Image Network 
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Image Network Descriptions 
Selection Definition 
Image Network Interface 

Static IP – The IP address is manually entered in the IP 
address field 

IP Address 
Assignment 
(drop-down list) Dynamic IP-The AV6010 will receive an IP address from a 

DHCP server 
Static Network Settings 
IP Address Enter an IP address within the range of the IDS.  

Typically the address is 10.0.40.xx.  XX ranges from 21 to 25. 
Net Mask Enter an appropriate NetMask address.   

Typically the address is 255.255.255.0 
Image Transfer (Global to all Cameras) 

No Transfer –The AV6010 will not transmit any images 
 
All Packages –Transmit an image with every trigger cycle 
 
No Code Read – Transmit the image if no bar codes were read 
 
No Dimensions Read – Transmit the image if no dimensions 
were read 
Verifiy Bar Code Failed – Transmit the image if the verification 
bar code failed 
 

Image Transfer 
Criteria  
(drop-down list) 

Custom – Custom defined condition for transmitting images 
 

Image 
Destination IP 

Destination of PC where images will be sent.  Typically this is 
the IDS server.  10.0.40.19 

Transmit Point 
(NOT USED) 

Set in inches.  This is the point where the images are sent out 
of the camera.  This number must be less then  the HOST 
transmit point. 

Image Cropping When enabled only the cropped part of the image will be 
transmitted. 

Downsampling  
Raw Image 
Export (RIE) 
Settings 

Use to enable or disable the raw image export capabilities of an 
RIE-capable camera. For details on the RIE Settings, see 
Appendix H. 
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Advanced > Imaging > (Camera) 

 
 
Setup > Advanced > Imaging Descriptions 

Selection Definition 
LPI The Wizard will automatically fill this field. The LPI is set to equal 

the DPI at the far scanning point. This matching of the DPI to the 
LPI assures the pixels are not over squared, which can cause a 
no read. 
Gain Mode (drop-down list) – Normal.  This is the run mode.  It 
allows the AV6010 to dynamically adjust it gain depending on the 
package height and conveyor speed. 
 
Fixed Gain Value – This option is only used for testing.  It should 
be set to Normal for regular operation 
 

Gain 

Global Gain Offset –This is adjusted when the overall image is too 
dark or light.  It will enhance the gain in the AV6010 to provide a 
greater contrast between the black and white elements in the bar 
code 
 

Digital Zoom Digital Zoom Mode (checkbox) – When digital zoom is selected the 
camera will maintain the target DPI through the depth of field 
 
HW Correction (checkbox)   
 
Digital Gain – This option will digital increase image gain. 
 
Binarization – (Not available at this time.) 
 

Image Mod 

Background Smoothing 
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 Advanced > Decoder Options 

 
  
 

Use to set special parameters for the different bar code symbologies. 
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Advanced Decoder Options Descriptions 
Selection Definition 
Aztec Decoder Limits 
Codabar Checksum 
Code 11 Checksum 
Code 128 Small Quiet Zone 

Checksum 
Full ASCII 

Code 39 

Small Quiet Zone 
Code 93 Small Quiet Zone 

Minimum Module Count 
Maximum Module Count 
Minimum Module Size 
Maximum Module Size 
Orientation 

Data Matrix 

Rectangular 
Checksum I2 of 5 
Small Lengths 

MSI Plessey  
Minimum Module Count 
Maximum Module Count 
Minimum Bar Size 
Maximum Bar Size 
Orientation 

Pharmacode 

Reverse 
Minimum Bar Count 
Maximum Bar Count 

Postal 

Orientation  
Straight 2 of 5 2SS Small Lengths 
Straight 2 of 5 3SS Small Lengths 
UPC EAN JAN Small Quiet Zone 

Supplemental Codes – Use to enable extensions. 
Min 1D Height Sets the minimum height for 1D bar codes. 
Max 1D Height Sets the maximum height for 1D bar codes. 
Low Aspect Ratio  
Low Contrast 
Improvements 

 

Misc Improvements  
Report Identical 
Symbols 
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Options > Dimensioning 
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Options > Dimensioning Descriptions 

Selection Definition 
Dimensioning Options 
Dimensioning Enabled (checkbox) – Dimensioning is enabled when box is checked. 

CERT Off – The certification mode of the system is turned off. Changes 
can only be made on this screen when the CERT Off is selected. 
 
CERT On - English – The certification mode is enabled and reports 
dimensioning data in inches. 
 
CERT On - Metric – The certification mode is enabled and reports 
dimensioning data in millimeters (12D). 
 

Certification Mode 
(drop-down list) 

CERT On - OIML Metric – The certification mode is enabled and reports 
dimensioning data in millimeters (10D). 
 

Package Height Options 
Variation 
Threshold 

Set this to be double the height accuracy.  
Example: An 0.1 accuracy should have a variation threshold of 0.2. 
 

Accuracy  
(drop-down list) 

Set for 0.1, 0.2 or 0.5 (5, 10, 20 mm) based on the calibrated accuracy 
of the system’s RangeFinder. 
 

Package Length/Width Options 
Confidence 
Threshold 

Enter as a percentage (0-100%) 

Accuracy  
(drop-down list) 

Set for 0.1, 0.2 or 0.5 (5, 10, 20 mm) 

Certified Package Size Options 
Length – Can be set to the certified minimum or greater. 
Width 

Minimum 
Package Size 

Height 
Length (up to 72”) 
Width (up to 36”) 

Maximum 
Package Size 

Height (up to 36”) 
Ranger Left 
Extend Offset 

 

Ranger Right 
Extend Offset 

 

Advanced Options 
Direction of Travel Length 

Determined by Longest Side 
 
 
See Chapter 5 for details on Dimensioning Setup and Calibration. 
Additional reference information on dimensioning is provided in Appendix G. 
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Options > Side-by-Side > Settings 
 

 
 

IMPORTANT: The Side-by-Side Settings are done during setup with the Camera 
Image Viewer. Registration of a SBS-enabled camera system must be performed by a 
trained and authorized Accu-Sort technician before the system can perform SBS 
detection during normal operations. 

 
See Chapter 5 for details on side-by-side product detection setup and 
calibration. 
 
 



AccuVision® AV6010 Long-Range Camera System Manual Appendix B 177 
  

A2-AV6010_User Interface_R10.doc Accu-Sort Systems, Inc. 

Options > Side-by-Side > Ignore Codes 
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Diagnostics > System Status 

 
Example for single camera system 

 
Example for multi-camera system 

  
 
Diagnostics > System Status Descriptions 

Selection Definition 
 
Device  
Status 

OK, NOT OK, NOT PRESENT 
Clickable links open the status screen for the device. 

Status OK or NOT OK 
 

Belt Speed Identifies the conveyors current speed. 
Package Count The number of packages that have traveled through the system since 

the last reset of the diagnostics screen. 
Read Count Number of reads. 
Mult Count  
Reset (button) Use to reset the diagnostics counters on this screen. 
 
Sequence 
Number 

Shows the packages numbers in descending order. 

Bar Code Indicates the valid code data or if a no read condition occurred.  
Type Identifies the code type. 
Camera Identifies which camera in the system detected the bar code read. 
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Diagnostics > Images 

 

 

[ Useful image not available at time of publication. ] 

 

Diagnostics > Images Screen 

 

 
Diagnostics > Images Descriptions 
 
[ Not available at time of publication. ]  
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Diagnostics > RangeFinder Status 

 
 

 
Diagnostics > RangeFinder Status Descriptions 

Selection Definition 
Error Code See Appendix F for a list of error codes and their descriptions. 

All RangeFinder error codes are in the 6000 series. 
 

Error 
Description 

See Appendix F for a list of error codes and their descriptions. 

Status The RangeFinder status is either shown as:  
 
OK – Functioning normally 
 
NOT OK – Check error codes for possible problem indicators. 
 

Belt Speed The speed of the package conveyance in feet per minute. 
 

Seq Number The sequence number assigned to packages that have passed 
through the RangeFinder’s scanline. 
 

Box Length The length of the box as detected by the RangeFinder where 
length is measured with the direction of travel. 
 

Box Height The height of the box as detected by the RangeFinder. 
 

Left/Right  
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Diagnostics > (Camera) > Status 

 
 

 
Diagnostics > Camera Status Descriptions 

Selection Definition 
Error Code See Appendix F for a list of error codes and their descriptions. 
Error 
Description 

See Appendix F for a list of error codes and their descriptions. 

Status  
Belt Speed The speed of the package conveyance in feet per minute. 
Package 
Counts 

The total number of packages that ran through the system since 
the last reset. 

Read Count The number of packages with decoded bar codes since the last 
reset. 

Reset (button) Use to reset the diagnostics counters on this screen. 
Seq Number The sequence number of the package scanned by the camera. 
Bar Code or 
Dimensions 
(LxWxH) 

Displays the bar code data decoded from the package or the 
dimensioning data (length x width x height) for a TOP reading 
camera that is equipped with the Dimensioning COM-e module. 

Result Type Identifies the type of bar code that was decoded. 
Camera Identifies the camera that decoded the bar code. 
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Diagnostics > (Camera) > Logging 

 
 
 
Diagnostics > Camera Log Descriptions 

Selection Definition 
Logging Options 
Error Log Displays the Error Log in the Log File when selected. 
Debug Log Displays the Debug Log in the Log File when selected. 
Audit Trail Log Only available on the top-read camera of a dimensioning 

system. 
See Appendix G for more information. 

Alibi Storage 
Log 

Only available on the top-read camera of a dimensioning 
system. 
See Appendix G for more information. 

Get Updated 
Log File (button) 

After selecting a log from the option buttons, click this button to 
update the data being displayed in the Log File. 

Log File 
 Scrollable log based on the selection made under Logging 

Options. 
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Diagnostics > (Camera) > Image 

 
 
 

The top half of this diagnostics screen displays a thumbnail of the image. 

 
Diagnostics > Image (Camera) Descriptions 

Selection Definition 
Seq Number The sequence number of the package scanned by the camera. 
Bar Code or 
Dimensions 
(LxWxH) 

Displays the bar code data decoded from the package or the 
dimensioning data (length x width x height) for a TOP reading 
camera that is equipped with the Dimensioning COM-e module. 

Result Type Identifies the type of bar code that was decoded. 
Camera Identifies the camera that decoded the bar code. 
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Diagnostics > (Camera) > Versions 
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Diagnostics > Tools 
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Diagnostics > Tools Descriptions 
Selection Definition 
View/Load Parameter File 
View Parameter 
File 

Use to view and/or save the camera system’s XML file. In a 
multiple-camera system, this XML file contains the parameters 
for all cameras in the system. 
 

Load Parameter 
File 

Use to browse for an XML parameters file saved on your 
computer and load it to the AV6010 camera system. In a multi-
camera system, the XML file contains all the parameters for 
the entire system. 
 

Downloads (on Utilities and Documentation) 
InstallWizard.zip Use to download the AV6010 Install Wizard used to calibrate / 

recalibrate the AV6010 RangeFinder and camera(s). 
 

CameraScanLine
Target.pdf 
 

Use to download the Camera Scan Line Target PDF. This 
target is used with the Install Wizard to determine the distance 
from the trigger source to camera scan line. 
 

Static 
FocusTarget.pdf 

Use to download the Static Focus Target PDF. This target is 
used with the Install Wizard during calibration / recalibration. 
 

ImageViewer.zip Use to download the Image Wizard tool. 
 

Dynamic 
FocusTarget.pdf 

Use to download the Dynamic Focus Target PDF. This target 
is used with the Image Viewer during calibration / recalibration. 
 

DiagTools.zip Use to download the Diagnostics Tools (i.e., Camera Image 
Viewer, Codeword Viewer and Ranger OScope) 
 

 
 
 

<Need to add the Dimensioning barcodes PDF for ASIDIM and 
ASICAL.> 

Set Passwords 
Setup Password Assign a new password for users that will have access to the 

setup features of the system.  
Monitor 
Password 

Assign a new password for users that will have access to the 
monitoring capabilities of the system. 

Set Passwords Click to set the new Setup and Monitor passwords. 
 

Update Software 
Load Image 
 

 

Load Patch 
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 Camera Image Viewer 

 
Camera Image Viewer Screen 
 
The Camera Image Viewer is an installation and diagnostics tool. It is used 
by trained and authorized Accu-Sort technicians for the initial setup and 
calibration of camera systems. It is also used for side-by-side package 
detection setup and calibration. 
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Camera Image Viewer and SBS Package Detection Tabs 
 
When SBS is enabled, the following tabs are provided:  
 

 
 
The Setup tab is used to retrieve parameters from the camera and set the transport 
type used with the SBS-enabled system.  
 

 
 
The Calibration tab changes based on the transport type selected (belt or tilt-tray). 
 

 
 
The Detection tab is used to optimize the SBS conditions that the system uses for 
side-by-side package detection. The image evaluation does not include SBS 
conditions detected by the RangeFinder or identified by the ignore codes. 
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Understanding the SBS Rate  
 

 
 
 
• SBS Rate – The confidence of the SBS software identifying the parcel 

correctly 
  

• SBS Mis-Rate – Likelihood that the SBS software could mis-label an 
object  
 

• SBS Not Detected – Percentage of images evaluated that the SBS 
software did not detect as a SBS condition 
 

• SBS No Dec Rate – Percentage of images that the SBS software was 
unable to determine a SBS condition 
 

 
SBS Optimization Folders  
 
During image evaluation and optimization, the viewer processes captured 
images and determines whether those images identify a side-by-side (SBS) 
condition. It automatically creates these folders: 
 
 SBS_DetectedImages – Correct SBS evaluation.  

 
 SBS_NotDectectedImages (False negatives) – Images manually 

determined to be SBS but considered to be NOT SBS with the optimized 
parameter settings.  

 
 SBS_MisDetectImages (False positives) – Images manually determined 

to be NOT SBS but considered to be SBS with the optimized parameter 
settings. 

 
 SBS_NoDecisionImages – Images where a decision could not be 

made.  
 
NOTE: A folder is not created in cases where NONE of that type of 
condition occurred.  
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RangeFinder Codeword Viewer 

 
RangeFinder Codeword Viewer Screen 
 
[ Details not available at time of publication. ] 
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RangeFinder O-Scope Viewer 

 
RangeFinder O-Scope Viewer Screen 
 
[ Details not available at time of publication. ] 
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AV6010 Install Wizard 

 

Use the AV6010 Install Wizard to: 

 Auto-calibrate the following system components: 

 RangeFinder 

 Optional package induction (e.g., photoeye, light curtain) 

 Camera(s) 

 Dynamically test system calibration 

 Verify with actual product  

 

This appendix provides screens and useful reference information related to 
the AV6010 Install Wizard. 

 
 
 

 

IMPORTANT: Step-by-step procedures are provided in Chapter 5. 
 

 



AccuVision® AV6010 Long-Range Camera System Manual Appendix B 193 
  

A2-AV6010_User Interface_R10.doc Accu-Sort Systems, Inc. 

AV6010 Installation Wizards 

Icon Wizard Description 

 

RangeFinder Use to calibrate the RangeFinder’s height above conveyor 
surface and region of interest.  

 

Photoeye In fixed focus applications, use the wizard to enter the distance 
from the photoeye to where the camera’s scanline meets the 
conveyor. If the photoeye is used in conjunction with a light 
curtain or RangeFinder, use the wizard to enter the distance from 
the photoeye to the light curtain or RangeFinder.  
 

 

Light Curtain Use to set the offset from the surface of the conveyor to the 
bottom of the light curtain’s LED array. 

 

Front Camera Use with cameras that will only be reading codes on the front of 
products as the pass through the scanning area. Calibrates key 
dimensions/angle used to control camera focusing. 

 

Top  
Camera 

Use with cameras that will only be reading codes on the top of 
products as the pass through the scanning area. Calibrates key 
dimensions/angle used to control camera focusing. 

 

Back  
Camera 

Use with cameras that will only be reading codes on the back of 
products as the pass through the scanning area. Calibrates key 
dimensions/angle used to control camera focusing. 

 

Left  
Camera 

Use with cameras reading codes on the left side of products. 
Calibrates near, far and focus distance. 

 

Right Camera Use with cameras reading codes on the right side of products. 
Calibrates near, far and focus distance. 

 

Bottom 
Camera 

Use to calibrate a camera installed to read the bottoms of 
packages. 

 

Tunnel Use to confirm proper calibration of all devices in the system by 
running the conveyor and sending the calibration boxes through 
the scanning area.  (Future functionality.) 

 

Verify 

 

Use after all system calibration is complete, including the Tunnel 
wizard, to verify proper operation with actual product to be 
scanned by the system.  (Future functionality.) 
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AV6010 Install Wizards (Quadrant Scanning) 

 

Front-Left 
Camera 

Use to setup camera that is reading codes on the front and left 
side of packages in a quadrant application. 

 

Front-Right 
Camera 

Use to setup camera that is reading codes on the front and right 
side of packages in a quadrant application. 

 

Back-Left 
Camera 

Use to setup camera that is reading codes on the back and left 
side of packages in a quadrant application. 

 

Back-Right 
Camera 

Use to setup camera that is reading codes on the back and right 
side of packages in a quadrant application. 
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Notes: 
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C AV6010 and VisionCapture™ 
 

The AccuVision® VisionCapture™ Image Capture System uses a Linux-
based AV40002.0 Image Depot Server (IDS) to capture images from up to six 
AV6010 cameras. Captured images are stored on the IDS for offline review, 
analysis, storage and retrieval. 

Use the images to optimize an AV6010 camera systems by: 

 Identifying root causes that contribute to no-reads 

 Store and manage images, image directories, and subfolders 

 Access images offline for review and analysis – locally or remotely 

 Quickly diagnose potential revenue recovery opportunities 

The VisionCapture system connects to the AV6010’s IMAGE network as 
outlined in Chapter 3 and Appendix I (drawing 112753, sheet 3). 

 

VisionCapture™ Interface 

 
VisionCapture Icon 

VisionCapture, a browser-based user interface, lets you easily setup or 
modify image file compression and storage management parameters. 

 
 With the VisionCapture Interface, you can: 

 Monitor IDS connections by unique camera name / IP address 

 View image information for each captured image 

 Define storage management parameters  

 Check percentage of hard drive filled, at-a-glance 

 Select image save-as mode  
(compressed JPG or PNG, uncompressed BMP) 

 View and/or save Event Logs 



198 AV6010 and VisionCapture / IDS AccuVision® AV6010 Long-Range Camera System Manual 
 

Accu-Sort Systems, Inc. A3-AV6010_and_VisionCapture_R10.doc 

MultiViewer™ Software  

 
MultiViewer Icon 

MultiViewer™ is a flexible tool you will use to work with saved images 
stored on the Image Depot Server or archived to DVD. The MultiViewer 
application resides on the IDS. Users can also Remote Desktop into 
MultiViewer on the IDS from a Windows-based computer.  

 

 
 
MultiViewer is available on the Image Depot Server and can be accessed 
using the monitor/keyboard option. It can also be run on any Windows-based 
PC connected to your network. Use MultiViewer to perform the following: 

 view and analyze images 

 sort images 

 backup/archive images 

MultiViewer supports compressed JPG and Portable Network Graphic (PNG)  
as well as uncompressed Bitmap (BMP)  image formats. Unlike regular BMP 
or PNG files, image files saved in IDS contain additional information related 
to the captured images including an image ID number and start / stop scan 
line time stamp. 

The extra data is embedded in the BMP or PNG files without destroying the 
file format. When using regular Windows-based image viewers to look at 
image files saved by VisionCapture (e.g., Image Edit, Internet Explorer), the 
extra information is ignored. The MultiViewer application is designed to 
display the useful embedded information in the image window. 

 

 

IMPORTANT: Step-by-step procedures are provided in the AccuVision 
VisionCapture Image Capture System Manual. 
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D AV6010 and FAST Monitor 
 

FAST Monitor is a browser-based application that gives facility managers 
and maintenance personnel the ability to monitor multiple Accu-Sort products 
within their facility or across multiple facilities from anywhere an internet 
connection is available. FAST Monitor provides real-time and historical 
performance data in an easy-to-use interface as well as automatic status and 
error condition reporting of all Accu-Sort products and systems to which it is 
connected.  

The AV6010 Camera System is fully compatible with the FAST Monitor 
Server and application.  

 

Prerequisites: 

 FAST Monitor Server and software (version 1.2.12.3 or later) 

 Internet connection  

 RJ45 Ethernet cable 

 

To connect an AV6010 camera or tunnel to a FAST Monitor Server: 

1. Run an RJ45 Ethernet cable connection via a network switch from the 
HOST RJ45 port of the AV6010 Camera to the FAST Monitor Server 
Ethernet port.  
 

 

NOTE:  In multiple-camera systems, this connection can be made to any 
camera in the same SYNC network. It does not need to be made to the 
‘controller camera’. 

 

 
 

2. Login to the AV6010 User Interface as a Setup user. 

3. Select Setup > Communications (camera) > Host Network > Network 
from the menu tree. The ‘camera’ you choose should be the camera that 
is connected to the FAST Monitor server. The Network window opens. 
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NOTE: Jot down the camera’s IP address as shown in the Static Network 
Settings section of the Network window. This IP is required when setting up 
the connection to the AV6010 camera in the FAST Monitor User Interface.  
 
4. Add the FAST Monitor server to the next available Host Port in the Host 

Network Connection section of the Network window.  

5. Select Fast Monitor from the Host Port(n) drop-down list.  

6. Type the IP address of the FAST Monitor server in the IP input field. 

 

NOTE:  The default IP for the FAST Monitor server is 192.168.250.1.  
If this IP does not work, contact Accu-Sort support at 1-800-BAR-CODE. 

7. Type 9899 in the Port # input field. 

8. Click Update. 

For additional information on setting up the FAST Monitor Server to connect 
to an AV6010 Tunnel, see the FAST Monitor User Guide. 
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E Image Quality Analysis (IQA) 
 
 

IQA Overview 
 
The Image Quality Analysis (IQA) tool is an optional component of a 
camera’s software package (a shared library or DLL). It resides in each 
camera and is executed on-demand when a camera detects the presence of 
a “special” Accu-Sort IQA trigger bar code. The IQA trigger bar code is 
applied to, or is part of, an Accu-Sort IQA test target. An IQA test target is 
attached to all sides of a calibration box.  

 
Example of an IQA Test Target with IQA Trigger Bar Code 

 

 

WARNING: Do not mark, damage or otherwise obstruct the IQA target or 
0.5-inch “keep out” zone surrounding the IQA target bar codes. 

 
During initial system commissioning and as part of a periodic maintenance 
event (pre or post sort) a calibration box is conveyed through a tunnel (scan 
point) and each camera’s quality metrics are measured. The metrics include 
focus, brightness, contrast, and noise. The results of these measurements 
are sent to a FAST Monitor (FM) server where they are formatted for display.  

IQA results can be used to determine if a tunnel’s or camera’s performance 
has degraded to the point where it may affect bar code decoding or RIE/OCR 
results.  

If available under your software license, IQA statistic information can be 
enabled in FAST Monitor by selecting the IQA checkbox in Global 
Administration / Security / Privilege Mgmt. IQA statistics will then be 
displayed with other camera statistics.  

 

For more information, see the FAST Monitor User Guide.  
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CAUTION: It is recommended that this procedure be performed by an 
Accu-Sort Trained and Authorized Technician. On-site service, training, and 
technical support is available from Accu-Sort. For more information, contact 
Customer Service at 1-800-BAR-CODE.  

 
Prerequisites: 
 
 Calibration box (12-inch cubic box, plywood recommended) 

 IQA test targets 

 Camera system connected to FAST Monitor 

 

IMPORTANT: The IQA target bar codes supplied by Accu-Sort have 
unique serialization and should not be reproduced. Plywood calibration 
boxes are also available from Accu-Sort. For additional targets or plywood 
calibration boxes, contact your Accu-Sort sales or service representative at 
1-800-BAR-CODE. 

 

 

To test a camera's image quality with IQA:  
1. Affix the 8-inch square targets (supplied by Accu-Sort) to a 12-inch cubic 

box (plywood recommended). The targets should be: 

a.  Centered in the box faces.  

b. One IQA target per box face. 

2. During a non-sort period, manually induct the IQA calibration box into the 
tunnel keeping the box skew to less than 10 degrees.  

3. The camera(s) will read the IQA target(s) and return performance data to 
FAST Monitor.  
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Notes: 
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F Error Codes 

 

Overview 

You can view the AV6010 error codes in one of the following ways: 

 Diagnostics > RangeFinder Status 
 Diagnostics > Camera Status (by camera location) 

 Optional FAST Monitor System 
 

The error codes are identified by 4-digit series numbers and are provided in 
the following tables: 

 1000: Software Critical Errors 

 2000: Software Serious Errors 

 3000: System Errors 

 4000: COMe Errors  

 5000: Focus and Illumination Errors 

 6000: RangeFinder Errors 

 

The error code severity is identified as one of the following:  

 Info 

 Warning (Status LED blinking) 

 Error  (Status LED solid ‘ON’) 

 

 

 

 

NOTE: This appendix includes all error codes for version 8.x of the 
AV6010 software including dimensioning. Older versions of AV6010 
software will not include all the error codes provided in this appendix. 
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Software Error Codes 

Error Code Description 

Software Critical Errors 

1001-1034 SW Init Failure: xxxxxxxx 

Note: Because the system did not boot, these errors are not displayed on the user 
interface nor do they appear in the debug log. Normal course of action is rebooting 
the system. 

 

Software Serious Errors 

2001 Info: Unable to set 'Send Socket' buffer size 

2002 Info: Unable to set 'Receive Socket' buffer size 

2003 Info: Unable to write to socket 

2004 Info: Unable to read from socket 

2005 Info: Unable to write to message queue 

2006 Info: Unable to read from message queue 

2007 Info: Unable to stop FTP Server 

2008 Info: Unable to stop TFTP Server 

2009 Info: Unable to stop DHCP Server 

2010 Info: Unable to disable port of network switch 

2011 Info: Unable to create VLAN in network switch 

2012 Info: Unable to assign static IP to SYNC network 

2013 Info: Unable to assign static IP to IMAGE network 

2014 Info: Unable to assign static IP to HOST network 

2015 Info: Unable to start DHCP client on SYNC network 

2016 Info: Unable to start DHCP client on IMAGE network 

2017 Info: Unable to start DHCP client on HOST network 

2018 Info: Unable to assign netmask to SYNC network 

2019 Info: Unable to assign netmask to IMAGE network 

2020 Info: Unable to assign netmask to HOST network 

2021 Info: Unable to assign gateway to SYNC network 

2022 Info: Unable to assign gateway to IMAGE network 
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2023 Info: Unable to assign gateway to HOST network 

2024 Info: Unlinking message queue failed 

2025 Info: Closing shared memory failed 

2026 Info: Closing semaphore failed 

2027 Info: Unmapping shared memory failed 

2028 Info: Unlinking semaphore failed 

2029 Info: Invalid argument to mq Read/Write 

2030 Info: Invalid argument to mq Read/Write 

2031 Info: Read on FPGA device failed 

2032 Info: Write to FPGA device failed 

2033 Info: Could not TFTP file 

2034 Info:: Error In validating config file 

2035 Info: Socket address cannot be reused 

2036 Info: Listen on socket failed 

2037 Info: Accept connection on socket failed 

2038 Info: Socket connection failure 

2039 Info: SYNC network not connected to loop 

2040 Info: Unable to connect to FastMonitor 
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AV6010 Camera System 

Error 
Code 

Description Status LED Severity 

System Errors 

3001 Warning: No response (TFTP ack) from COMe #1. Blink Red Warning 

3002 Warning: No response (TFTP ack) from COMe #2. Blink Red Warning 

3003 Warning: No response (TFTP ack) from COMe #3. Blink Red Warning 

3004 Warning: No response (Release IP ack) from Decoder (COMe) #1. Blink Red Warning 

3005 Warning: No response (Release IP ack) from Decoder (COMe) #2. Blink Red Warning 

3006 Warning: No response (Release IP ack) from Decoder (COMe) #3. Blink Red Warning 

3007 Communication with COMe #1 lost. Solid Red Error 

3008 Communication with COMe #2 lost. Solid Red Error 

3009 Communication with COMe #3 lost. Solid Red Error 

3010 More than maximum allowed COMe modules detected. Solid Red Error 

3011 Camera Control Processor (iMX31) failed to boot. Solid Red Error 

3012 Communication with Camera Control Processor (iMX31) lost. Solid Red Error 

3013 Invalid packet received over serial/Ethernet link. -- Info 

3014 Failure in configuration internal network switch. Solid Red Error 

3015 Unable to load and start the FPGA. Solid Red Error 

3016 Info: Maximum bar codes for a package exceeded. -- Info 

3017 Transmit point interrupt error. Solid Red Error 

3018 Info: Bar code data received too late. -- Info 

3019 Invalid bar code data received from decoder. -- Info 

3020 Package database was empty. -- Info 

3021 Bar code data received for 'missing package'. -- Info 

3022 Bar code data does not match any enabled type. -- Info 

3023 Package less than min package size detected. -- Info 

3024 Warning: Belt speed detected by all cameras does not match. Blink Red Warning 

3025 Warning: More than maximum allowed cameras detected. Blink Red Warning 

3026 Warning: Camera with the same name detected. Blink Red Warning 
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3027 Warning: Communication with Left-Front Camera lost Blink Red Error 

3028 Warning: Communication with Right-Front Camera lost Blink Red Error 

3029 Warning: Communication with Left-Back Camera lost Blink Red Error 

3030 Warning: Communication with Right-Back Camera lost Blink Red Error 

3031 Warning: Communication with Top Camera lost Blink Red Error 

3032 Warning: Communication with Left Camera lost Blink Red Error 

3033 Warning: Communication with Right Camera lost Blink Red Error 

3034 Warning: Communication with Back Camera lost Blink Red Error 

3035 Warning: Communication with Front Camera lost Blink Red Error 

3036 Warning: Communication with Bottom Camera lost Blink Red Error 

3037 Warning: Communication with RangeFinder lost Blink Red Error 

3038 Info: Start Trigger from RangeFinder missed -- Info 

3039 Info: Start/End Trigger from RangeFinder missed -- Info 

3040 Info: Start Trigger from Camera missed -- Info 

3041 Warning: No response (Config param ack) from RangeFinder Blink Red Warning 

3042 Warning: Failure in merging configuration files Blink Red Warning 

3043 Warning: Failure when TFTPing configuration file Blink Red Warning 

3044 No free 'CAM Entry' In config file Solid Red Error 

3045 Warning: Current Tach greater than transmit point tach Blink Red Warning 

3046 Failure when deleting all nodes in config file Blink Red Warning 

3047 Right side fan disconnected or failed Solid Red Error 

3048 Left side fan disconnected or failed Solid Red Error 

3049 Warning: Right side fan at reduced speed Blink Red Warning 

3050 Warning: Left side fan at reduced speed Blink Red Warning 

3051 Error: FPGA PCIe link is at less than 8x Solid Red Error 
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COMe #1 Errors 

4000 Error: COMe unable to multicast decode results Solid Red Error 

4001 Error: COMe unable to create multicast socket Solid Red Error 

4002 Error: COMe unable to create host message queue Solid Red Error 

4003 Error: COMe unable to create decode message queue Solid Red Error 

4004 Error: COMe unable to create decode message queue Solid Red Error 

4005 Error: COMe unable to verify decode engine version Solid Red Error 

4006 Error: COMe detected a problem while decoding Solid Red Error 

4007 Error: COMe detected an error with the image buffer Solid Red Error 

4008 Error: COMe unable to open the PCIe driver Solid Red Error 

4009 Error: COMe unable to attached to mapped memory Solid Red Error 

4010 [ Unassigned ]   

4011 Info: COMe started dimensioning -- Info 

4012 Info: COMe restarted dimensioning software -- Info 

4013 Info: COMe received parameter update -- Info 

4014 Info: COMe started decoding software -- Info 

4015 Info: COMe restarted decoding software -- Info 

4016 Error: COMe Rangefinder Ver/CRC Failure Solid Red Error 

4017 Error: COMe status monitor AATM failure Solid Red Error 

4018 Error: COMe Dimensioner AATM failure Solid Red Error 

4019 Error: COMe AATM Ver/CRC mismatch Solid Red Error 

4020 Error: COMe Parameter CRC failure Solid Red Error 

4021 Error: COMe unable to retrieve parameters Solid Red Error 

4022 Error: COMe dimensioning token mismatch Solid Red Warning 

4023 Error: COMe unable to allocate buffer for image Solid Red Error 

4024 Error: COMe failed during app initialization Solid Red Error 

4025 Info: Dimensioning NOT Ready -- Info 

4026 Info: Dimensioning Ready -- Info 

4027 Info: Rangefinder Not Ready for Dimensioning -- Info 

4028 Warning: Dim Verification Failure Blink Red Warning 
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4029 Error: ImgBuffHandler Ver/CRC Failure Solid Red Error 

4030 Error: Dimension Lib Ver/CRC Failure Solid Red Error 

4031 Info: CERT Mode Off -- Info 

4032 Info: RFU 1 -- Info 

4033 Info: RFU 2 -- Info 

4034 Info: RFU 3 -- Info 

4035 Info: RFU 4 -- Info 

4036 Info: RFU 5 -- Info 

4037 Info: COMe started Raw Image Export -- Info 

4038 Info: COMe restarted Raw Image Export -- Info 

 
 
COMe #2 Errors 

4300 Error: COMe unable to multicast decode results Solid Red Error 

4301 Error: COMe unable to create multicast socket Solid Red Error 

4302 Error: COMe unable to create host message queue Solid Red Error 

4303 Error: COMe unable to create decode message queue Solid Red Error 

4304 Error: COMe unable to create decode message queue Solid Red Error 

4305 Error: COMe unable to verify decode engine version Solid Red Error 

4306 Error: COMe detected a problem while decoding Solid Red Error 

4307 Error: COMe detected an error with the image buffer Solid Red Error 

4308 Error: COMe unable to open the PCIe driver Solid Red Error 

4309 Error: COMe unable to attached to mapped memory Solid Red Error 

4310 [ Unassigned ]   

4311 Info: COMe started dimensioning -- Info 

4312 Info: COMe restarted dimensioning software -- Info 

4313 Info: COMe received parameter update -- Info 

4314 Info: COMe started decoding software -- Info 

4315 Info: COMe restarted decoding software -- Info 

4316 Error: COMe Rangefinder Ver/CRC Failure Solid Red Error 

4317 Error: COMe status monitor AATM failure Solid Red Error 
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4318 Error: COMe Dimensioner AATM failure Solid Red Error 

4319 Error: COMe AATM Ver/CRC mismatch Solid Red Error 

4320 Error: COMe Parameter CRC failure Solid Red Error 

4321 Error: COMe unable to retrieve parameters Solid Red Error 

4322 Error: COMe dimensioning token mismatch Solid Red Warning 

4323 Error: COMe unable to allocate buffer for image Solid Red Error 

4324 Error: COMe failed during app initialization Solid Red Error 

4325 Info: Dimensioning NOT Ready -- Info 

4326 Info: Dimensioning Ready -- Info 

4327 Info: Rangefinder Not Ready for Dimensioning -- Info 

4328 Warning: Dim Verification Failure Blink Red Warning 

4329 Error: ImgBuffHandler Ver/CRC Failure Solid Red Error 

4330 Error: Dimension Lib Ver/CRC Failure Solid Red Error 

4331 Info: CERT Mode Off -- Info 

4332 Info: RFU 1 -- Info 

4333 Info: RFU 2 -- Info 

4334 Info: RFU 3 -- Info 

4335 Info: RFU 4 -- Info 

4336 Info: RFU 5 -- Info 

4337 Info: COMe started Raw Image Export -- Info 

4338 Info: COMe restarted Raw Image Export -- Info 

 
COMe #3 Errors 

4600 Error: COMe unable to multicast decode results Solid Red Error 

4601 Error: COMe unable to create multicast socket Solid Red Error 

4602 Error: COMe unable to create host message queue Solid Red Error 

4603 Error: COMe unable to create decode message queue Solid Red Error 

4604 Error: COMe unable to create decode message queue Solid Red Error 

4605 Error: COMe unable to verify decode engine version Solid Red Error 

4606 Error: COMe detected a problem while decoding Solid Red Error 

4607 Error: COMe detected an error with the image buffer Solid Red Error 
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4608 Error: COMe unable to open the PCIe driver Solid Red Error 

4609 Error: COMe unable to attached to mapped memory Solid Red Error 

4610 [ Unassigned ]   

4611 Info: COMe started dimensioning -- Info 

4612 Info: COMe restarted dimensioning software -- Info 

4613 Info: COMe received parameter update -- Info 

4614 Info: COMe started decoding software -- Info 

4615 Info: COMe restarted decoding software -- Info 

4616 Error: COMe Rangefinder Ver/CRC Failure Solid Red Error 

4617 Error: COMe status monitor AATM failure Solid Red Error 

4618 Error: COMe Dimensioner AATM failure Solid Red Error 

4619 Error: COMe AATM Ver/CRC mismatch Solid Red Error 

4620 Error: COMe Parameter CRC failure Solid Red Error 

4621 Error: COMe unable to retrieve parameters Solid Red Error 

4622 Error: COMe dimensioning token mismatch Solid Red Warning 

4623 Error: COMe unable to allocate buffer for image Solid Red Error 

4624 Error: COMe failed during app initialization Solid Red Error 

4625 Info: Dimensioning NOT Ready -- Info 

4626 Info: Dimensioning Ready -- Info 

4627 Info: Rangefinder Not Ready for Dimensioning -- Info 

4628 Warning: Dim Verification Failure Blink Red Warning 

4629 Error: ImgBuffHandler Ver/CRC Failure Solid Red Error 

4630 Error: Dimension Lib Ver/CRC Failure Solid Red Error 

4631 Info: CERT Mode Off -- Info 

4632 Info: RFU 1 -- Info 

4633 Info: RFU 2 -- Info 

4634 Info: RFU 3 -- Info 

4635 Info: RFU 4 -- Info 

4636 Info: RFU 5 -- Info 

4637 Info: COMe started Raw Image Export -- Info 

4638 Info: COMe restarted Raw Image Export -- Info 
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Focus and Illumination Errors 

5000 Error: Focus Servo coil is locked Solid Red Error 

5001 Error: Focus Servo PWM over limit Solid Red Error 

5002 Error: Focus Servo PWM time-out Solid Red Error 

5003 Error: CRC Error on Focus Servo parameters Solid Red Error 

5004 Error: Focus Servo detected 'Bad Stops' Solid Red Error 

5005 Info: Unable to transmit Focus Servo -- Info 

5006 Error: Focus Servo not responding Solid Red Error 

5007 Info: Invalid packet received from Focus Servo -- Info 

5008 Info: Invalid command received from Focus Servo -- Info 

5009 Warning: LED Board 0 near end of life Blink Red Warning 

5010 Warning: LED Board 1 near end of life Blink Red Warning 

5011 Warning: LED Board 2 near end of life Blink Red Warning 

5012 Warning: LED Board 3 near end of life Blink Red Warning 

5013 Warning: LED Board 4 near end of life Blink Red Warning 

5014 Warning: LED Board 5 near end of life Blink Red Warning 

5015 Error: Failure of LED Board 0 Solid Red Error 

5016 Error: Failure of LED Board 1 Solid Red Error 

5017 Error: Failure of LED Board 2 Solid Red Error 

5018 Error: Failure of LED Board 3 Solid Red Error 

5019 Error: Failure of LED Board 4 Solid Red Error 

5020 Error: Failure of LED Board 5 Solid Red Error 

5021 Error: LED Board 0 CRC check failed Solid Red Error 

5022 Error: LED Board 1 CRC check failed Solid Red Error 

5023 Error: LED Board 2 CRC check failed Solid Red Error 

5024 Error: LED Board 3 CRC check failed Solid Red Error 

5025 Error: LED Board 4 CRC check failed Solid Red Error 

5026 Error: LED Board 5 CRC check failed Solid Red Error 

5027 Info: Unable to transmit to Illumination -- Info 

5028 Error: Illumination Controller not responding Solid Red Error 
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5029 Info: Invalid packet received from Illumination -- Info 

5030 Info: Invalid command received from Illumination -- Info 

5031 Info: Belt or Tachometer stopped -- Info 

5032 Error: Tach Sync ISR was "Out of Sync" Blink Red Warning 

5033 Error: Photoeye ISR failure Blink Red Warning 

5034 Error: Unable to read directory table Solid Red Error 

5035 Error: Unable to read header table Solid Red Error 

5036 Error: Unable to read gain table Solid Red Error 

5037 Error: Unable to read focus table Solid Red Error 

5038 Error: Unable to read gain correction table Solid Red Error 

5039 Error: Unable to read offset correction table Solid Red Error 

5040 Info: Invalid start of 'image valid' detected -- Info 

5041 Info: Invalid end of 'image valid' detected -- Info 

5042 Info: Invalid 'image valid' state detected -- Info 

5043 Error: Sensor Board I2C communication failure Solid Red Error 

5044 Info: Attempt to focus beyond maximum range -- Info 

5045 Info: Attempt to focus below minimum range -- Info 

5046 Error: Unable to load gain table (invalid table) Solid Red Error 

5047 Unable to load focus table (invalid table) Solid Red Error 

5048 Info: Invalid Height from RangeFinder -- Info 

5049 Info: Invalid Left Position from RangeFinder -- Info 

5050 Info: Invalid Right Position from RangeFinder -- Info 
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AV6010 RangeFinder 

Error 
Code 

Description Status LED 
(RangeFinder) 

Severity 

6000 Error: Image Sensor Read Failure Solid Red Error 

6001 Error: Sensor data always from DOE #1 Solid Red Error 

6002 Error: Sensor data always from DOE #2 Solid Red Error 

6003 Error: Laser #1 current exceeds limit Solid Red Error 

6004 Error: Laser #2 current exceeds limit Solid Red Error 

6005 Error: Laser #1 temperature exceeds limit Solid Red Error 

6006 Error: Laser #2 temperature exceeds limit Solid Red Error 

6007 Error: No valid temperature for laser #1 Solid Red Error 

6008 Error: No valid temperature for laser #2 Solid Red Error 

6009 Error: Tach or Tach Sync problem (invalid speed) Solid Red Error 

6010 Error: Sensor or laser problem (no codewords) Solid Red Error 

6011 Error: CERT accuracy exceeds calibration Solid Red Error 

6012 Error: Dimensioning not supported Solid Red Error 

    

6032 Warning: Laser 1 is off or blocked (no codewords) Blinking Red Warning 

6033 Warning: Laser 2 is off or blocked (no codewords) Blinking Red Warning 

6034 Warning: RangeFinder is not level Blinking Red Warning 

6035 Warning: Object stuck in rangefinder view Blinking Red Warning 

6036 Warning: Belt Speed is out of valid range Blinking Red Warning 

    

6064 Info: Belt or Tachometer stopped Blinking Green Info 

6065 Info: Waiting to Sync Tachometer Blinking Green Info 

6066 Info: Calibration for 0.1 inch height n/a Info 

6067 Info: Calibration for 0.2 inch height n/a Info 

6068 Info: Calibration for 0.5 inch height n/a Info 
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G Dimensioning 

 

Introducing AV6010 with In-camera Dimensioning  

Any bar code reading application using an AV6010 Top Read Camera can 
also be used for dimensioning non-touching (singulated) packages. If your 
system is dimensioning-enabled, the top-read camera will be equipped with 
a DCM that includes the optional dimensioning COM-e module.  

There is only a few special hardware or electrical installation requirements 
for an AV6010 dimensioning application. All of the dimensioning setup and 
monitoring is handled through the web-browser user interface. 

Certified dimensioning applications involve special requirements that are 
addressed throughout this appendix. 
 

 

CAUTION: Because of the complexity of the AV6010 Camera System, it is 
recommended that only authorized and trained service technicians perform 
set-up, parameter adjustments, changes or FRU part replacement. Special 
training is required for AV6010 dimensioning systems. Training is available 
from Accu-Sort. Contact your sales representative or customer service for 
additional information. Do not attempt to set-up a dimensioning system 
without proper training or the assistance of Accu-Sort technical support. 

 

Overview  

The minimum requirements for using in-camera dimensioning include: 

 AV6010 RangeFinder (calibrated for either 0.5, 0.2 or 0.1” accuracy) 

 AV6010 Top-Read Camera (with dimensioning-ready DCM) 

 Tachometer 
 

If the application is for certified dimensioning, it will also include: 

 Laptop computer for remote display and inspection (customer-supplied) 
(recommended for all certified dimensioning applications) 

 Remote Display (2 line x 20 character) 
(required by Measurement Canada, optional for others) 

 Certified Label on Top Camera and Mounting Structure 
(required for all certified dimensioning applications) 

 Top Camera DCM sealed  
(required for all certified dimensioning applications) 

 Calibration Seal on Tachometer  
(required in Europe, optional for all others) 
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Certified Dimensioning Installation Requirements  

 

Top-Read Camera 

Top-read cameras used in a certified dimensioning system must have the 
DCM and camera head compartments properly sealed with a wire 
certification seal running through the hole in the camera head back cover 
and DCM latch shown in Figure G-1. Additionally, the correct specifications 
label must be applied to the bottom of the DCM (Figure G-11 and G-13).  

 

Figure G-1: Top-Read Camera with DCM and Camera Head Seal Hole 
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Remote Display 

 

The recommended remote display is a laptop computer that can be moved 
between multiple dimensioning systems at one site. After making connection 
with the camera, the AV6010 user interface (Figure G-3) can be used to view 
system status, camera status and various logs related to dimensioning.   
 

 

Figure G-3: Remote Display for Certified Dimensioning 

 

Measurement Canada requires a dedicated remote display  be located at 
every dimensioning location within a site and should be mounted for easy 
visibility. Accu-Sort includes a 2 line by 20 character vacuum fluorescent 
display for this purpose. It is used to display the certification mode data (box 
length, width, height) in either inches or millimeters. 

 

Figure G-4: Dedicated Remote Display  
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AV6010 User Interface Screens related to Dimensioning 

When the top-read camera in a system is equipped with dimensioning 
capabilities, the Dimensioning screen is provided via the web-browser interface. 
After login, go to Setup > Advanced > Dimensioning to view the screen. 

 
Figure G-5: Dimensioning Screen 

 

Other screens that will require special setup for dimensioning include:  

 Tachometer 

 Symbologies 

 Top Camera Mounting 

 Top Camera Imaging 

Dimensioning Setup and Calibration procedures are provided in Chapter 5.  
For details on the rest of the user interface, reference Appendix B. 
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Viewing Dimensioning Data from Top Camera 

During normal operations, use the System Status screen to check the bar code 
and dimensioning information being reported by the top-red camera. After login 
as a Monitor user, go to Diagnostics > System Status. 

 

Figure G-6: System Status Screen showing Dimensioning Data 

 

See also: Audit Trail and Alibi Storage Logs (Figures G-8 and G-9). 

 

Viewing Certified Dimensioning Software Versions 

To view the software versions of all legally relevant dimensioning applications, 
along with their CRC values, login as a Monitor user and go to Diagnostics > 
Top > Versions.  

 
Figure G-7: Dimensioning Software Versions  
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Audit Trail and Alibi Storage Logs 

The Audit Trail and Alibi Storage Logs are only accessible from the top-read 
camera of an AV6010 system with dimensioning.  

 
Figure G-8: Audit Trail Log 
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Figure G-9: Alibi Storage Log   

 

Table G-1: Diagnostics > Top > Logging Descriptions 
Selection Definition 

Logging Options (Dimensioning-specific) 

Audit Trail Log Opens the Audit Trail Log for viewing in the Log File 
section of the screen. Results are scrollable. 
(Figure G-8.) 

 

Alibi Storage Log Opens the Alibi Storage Log for viewing in the Log File 
section of the screen. Results are scrollable. 
(Figure G-9.) 

 

AATM Options  (Alibi and Audit Trail Manager) 

Query First Record Displays the first record when selected. 

 

Query Last Record Displays the last record when selected. 

 

Query Storage Statistics Displays the storage spac e used and the remaining 
space available. 

 

Query Time Range Select a Start Time and End Time by defining the 
Year, Month, Day, Hour, Minutes and Seconds for 
each.  

 

NOTE: Camera times are always in GMT (Greenwich 
Mean Time).  

 

 

 

Get Updated Log File – After making the desired selection from the option 
buttons, click the Update button to view the log in the Log File area of the 
screen. 
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Certified Dimensioning for Legal-for-Trade Applications  

The AccuVision AV6010 Long-Range Camera System is certified to meet the 
following regulatory requirements: 
 

 The NCWM (National Conference on Weights and Measures)  
NTEP (National Type Evaluation Program) 

 Measurement Canada (MC) * 

 International Organization of Legal Metrology (OIML) R129, 
Measurement Instrument Directive (MID), and  
Western Europe Legal Metrology Cooperation (WELMEC) 

Remote Display 

In all legal-for-trade applications, the AV6010 certified dimensioning system 
is required to have at least one remote display per site for inspection 
purposes. This can either be a laptop computer or the optional Remote 
Display available from Accu-Sort (Figure G-4).  

The Remote Display is a 2 line by 20 character vacuum fluorescent display.  
The display shows the dimensions for the most recent two boxes (with the 
most recent box on the lower line).  The display will show: 

 

      B               L L . L            W W . W             H H . H         i n    or    mm  

Figure G-10: Dimensions on Remote Display              

where: 

 B is box number (0 to 9) 

 L is longest horizontal dimension (length) 

 W is shortest horizontal dimension (width) 

 H is height 

Dimensions are displayed in either inches or millimeters. 

 

*   Measurement Canada (MC) requires a dedicated Remote Display for every  
    dimensioning system on site. Most other certified dimensioning applications will  
    use a customer-supplied laptop computer as the remote display.  
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          Certification Inspection and Sealing 

 

The AccuVision AV6010 Long-Range Camera System with in-camera 
dimensioning is certified for singulated applications (i.e., for dimensioning 
non-touching packages). Any AV6010 top-read camera used in legal-for-
trade applications must be “sealed” to prevent unauthorized access to 
metrologically significant parameters and physical movement of the unit.  
(See Figure G-1.) 

The AV6010 RangeFinder and AV6010 with in-camera dimensioning are 
Category 3 devices with an “audit trail” and the ability to detect a non-zero 
condition (i.e., movement of the conveyor with respect to the AV6010).  As 
such, it does not require any type of sealing. Information about the audit trail 
is provided earlier in Appendix G (pg. G-6). 

The approval specifications for AV6010 with in-camera dimensioning are 
shown on labels attached to the underside of the top-read camera’s DCM 
and also on the mounting structure.  

The NCWM (NTEP) and Measurement Canada specifications are shown in 
Figure G-12.  

The OIML\MID\WELMEC specifications are shown in Figure G-13. 

The most current AV6010 certified dimensioning system certificates can be 
viewed at: 
 http://www.ncwm.net/ntep/certificate/08-067P.pdf  (NTEP) 

 http://www.ic.gc.ca/pics/lm/mass/am/5696t.pdf  (Measurement Canada) 

 http://www.oiml.org/certificates/CERTIFICATES.html (OIML) 
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Figure G-11: Location of Specification Label for  
Approved AV6010 Dimensioning System (NTEP/MC/OIML) 

  

Top-Read Camera 
is sealed here 

(See Figure G-1) 

Label applied to underside of 
the Top-Read Camera’s DCM 

(See Figure G-12 and G-13) 



AccuVision® AV6010 Long-Range Camera System Manual Appendix G 227 

  

A7-AV6010_Dimensioning_R13.doc Accu-Sort Systems, Inc. 

 
Figure G-12: Specifications Label for NCWM (NTEP) and  
Measurement Canada Approved AV6010 Dimensioning System  
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Figure G-13: Specifications Labels for OIML Approved  
AV6010 Dimensioning System  
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H Raw Image Export (RIE) 

 

Introducing AV6010 with Raw Image Export (RIE)  

Any bar code reading application using an AV6010 Camera can also be 
configured to provide raw image export (RIE) of high-resolution images at 
high speeds. Typically, this is used in optical character recognition (OCR) 
applications.  

If your system is RIE-enabled, the camera(s) will be equipped with a DCM 
that includes the optional Raw Image Export (RIE) COM-e module.  

There are only a few special hardware or electrical installation requirements 
for an AV6010 RIE application. The initial RIE setup is handled through the 
AV6010’s web-browser user interface. 
 

 

CAUTION: Because of the complexity of the AV6010 Camera System, it is 
recommended that only authorized and trained service technicians perform 
set-up, parameter adjustments, changes or FRU part replacement. Special 
training is required for AV6010 systems equipped with RIE. Training is 
available from Accu-Sort. Contact your sales representative or customer 
service for additional information. Do not attempt to set-up a system for RIE 
without proper training or the assistance of Accu-Sort technical support. 

 

Prerequisites:  

To utilize AV6010’s in-camera raw image export (RIE) capabilities, the 
following is required: 

 AV6010 Camera(s) with RIE-capable DCM  
(COM-e#3 populated for RIE and 1GB Copper board in PCI slot) 

 Review application specifications and define requirements with  
an Accu-Sort Applications Engineer 
 

The basic  requirements for interfacing with AV6010 RIE includes: 

 RIE Destination Server (Linux-based) 
(Hardware configuration is determined with the user by an Accu-Sort 
application engineer based upon the application requirements.) 

 Dual port network card (1GB throughput per RJ45 port) 
(Slower applications may only use one port) 

 C++ (or C) compatibility with the ASI RIE Library / Application 
Programming Interface 
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RIE Installation Requirements  
An RIE-compatible camera includes the following installed in the Distributed 
Computing Module (DCM):  
 
 Raw Image Export (RIE) software 
 a COM-e module properly installed in DCM position 3 
 1GB Copper board in PCI slot  

 

 
 

 
  
 

RIEchk Test Application 

The RIEchk application is available for download from the AV6010 User 
Interface’s downloads screen. This Windows-based application is useful in 
testing that the RIE module is at least minimally configured for the export of 
images.

RIE ports 

DCM
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AV6010 User Interface Screens related to RIE 

When a camera in a system is equipped with RIE capabilities, the Imaging 
Network screen for that camera will allow raw image export to be enabled. 
After login, go to Setup > Communications > (Camera Name) > Image 
Network to view the screen. 
 

 
Communications > (Camera) > Image Network (RIE Enabled) 

 

Raw Image Export Settings Descriptions 
Selection Definition 
Raw Image Export (RIE) Settings  
Enable/Disable Drop-list to select either enable or disable.  

(Currently, a camera reboot is also required.) 
 

RIE Camera Name Allows a unique name to be assigned to the RIE COM-
e module of the camera so it can be identified by the 
RIE Destination Server.  
(This field is blank by default.) 
 

RIE Local Network Settings   
IP Address Enter the IP address for the RIE-equipped camera 
Gateway Currently not used 
Net Mask Currently not used 
RIE Image Destination 
IP Address Enter the address for the RIE Destination Server (host) 

 
 

 

NOTE: For additional information, see the AccuVision AV6010 RIE API 
User Guide (1000069108). This document is provided to all users with 
RIE-equipped camera systems. If you did not receive this document, 
contact your Accu-Sort sales representative or application engineer. 

 



232 Raw Image Export (RIE) AccuVision® AV6010 Long-Range Camera System Manual 
 

Accu-Sort Systems, Inc. A8-AV6010_Raw_Image_Export_R10.doc 

Notes: 
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I Installation Drawings 

 
 

 

 

 
IMPORTANT: Due to the complex and application-specific nature of 
camera system / dimensioning installations, it is recommended that the 
AV6010 be setup by a trained and authorized Accu-Sort technician.  
 
For further information on training, contact us at 1-800-BAR-CODE. 
 
Any application-specific drawings shipped with the equipment may 
supersede the drawings provided in this appendix. 
             

 
 

AccuVision AV6010 Installation Drawings  

The drawings provided in this appendix are useful when mechanically and 
electrically installing the AV6010 Long-Range Camera System. 

 

Mechanical Installation Drawings 

 AV6010 Mechanical Specification Drawing (xxxxx) 

 Tachometer Anti-Static Brush (102974) 

 Photoeye/Tach Generator Mounting & Installation (112873) 

 

Electrical Installation Drawings 

 Single-Camera System Interconnect Diagram (112754) 

 Multiple-Camera System Interconnect Diagram (112753 –  4 sheets) 

 AC Power (sheet 1) 

 SYNC Network (sheet 2) 

 IMAGE Network (sheet 3) 

 FAST Monitor (sheet 4) 

 Power Distribution Box Wiring for Six Camera System (111062) 

 AV6010 Connector Pinouts Diagram (111515) 
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